## Revision history

<table>
<thead>
<tr>
<th>Month</th>
<th>Standard Release</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 2002</td>
<td>Standard 23.00</td>
<td>This document is up-issued to support Meridian 1 Release 25.40, and includes Call Processor Pentium (CP PII) and Fibre Network Fabric (FNF) for Option 81C.</td>
</tr>
<tr>
<td>April 2000</td>
<td>Standard 22.00</td>
<td>This is a global document and is up-issued for X11 Release 25.0x.</td>
</tr>
<tr>
<td>June 1999</td>
<td>Standard, release 21.0x</td>
<td>This document is reissued to include information on automatic inline conversion from Release 19.0x or later to Release 24.0x</td>
</tr>
<tr>
<td>March 1999</td>
<td>Standard, release 20.0x</td>
<td>This document is reissued to include information on the NT5D03 Call Processor card.</td>
</tr>
<tr>
<td>April 1998</td>
<td>Standard, Release 19.0x</td>
<td>Reissued for technical content.</td>
</tr>
<tr>
<td>October 1997</td>
<td>Standard, release 18.0x</td>
<td>This document is reissued for technical content and to include information on the NT5D10 Call Processor and NT5D61 Input Output Disk Unit with CD-ROM (IODU/C) cards.</td>
</tr>
<tr>
<td>August 1996</td>
<td>Standard, release 17.0x</td>
<td>This document is reissued for technical content.</td>
</tr>
<tr>
<td>August 1996</td>
<td>Standard, release 16.0x</td>
<td>This document is reissued to include information on the NT9D19 Call Processor Card for Options 51C and 61C and X11 Release 22.0x. Changes to technical content are noted by revision bars in the margins.</td>
</tr>
</tbody>
</table>
Revision History

December 1995
Standard, release 15.0x. This document is reissued to include information on the NT9D19 Call Processor Card and upgrade procedure. Changes to technical content are noted by revision bars in the margins.

July 1995
Standard, release 14.0x. This document is reissued to support Option 81C and X11 Release 21.0x. Updates are noted with revision bars in the margins.

December 1994
Standard, release 13.0x. This document is reissued for technical content.

December 1994
Standard, release 12.0x. This document is reissued to include information on the Small systems Multi-Disk Unit (SMDU). Changes to technical content are noted by revision bars in the margins.

April 1, 1994
Standard, release 11.0x. This document is issued to include changes for Option 61C, and to include information from Product Bulletin 93054 (May 1993). Revisions are noted with change bars in the margin.

October 31, 1993
Standard, release 10.0x. This document is updated to include information for Voice Mailbox Administration and the 12-Mbyte memory card. Changes are noted with revision bars in the margins.

August 1, 1993
Standard, release 9.0x. This document is updated to include information for X11 Release 19.0x. Changes are noted with revision bars in the margins.

April 1, 1993
Standard, release 8.0x. This document is reissued to include updates for X11 Release 18.0x, and Option 81 information. A new parallel reload procedure has been added for Option 81 systems. This version includes information from Product Bulletin 93007 (January 1993).

December 31, 1992
Standard, release 6.0x. This document was reissued to include updates for X11 Release 18.0x. This release includes information from Product Bulletins 90046 (September 1991) and 91060 (November 1991).

Release 7.0x was omitted.
December 1, 1991  
Standard, release 5.0x. This document was reissued for updates and changes for X11 Release 17.0x.

July 31, 1991  
This document is reissued for reorganization and updates to the conversion procedures.

December 20, 1990  
Standard, release 4.0x. This document was reissued for updates and changes for X11 Release 16.0x.

August 28, 1990  
Standard, release 2.0x. This document was reissued for updates and changes for X11 Release 15.

Release 3.0x. was omitted.

December 20, 1989  
Standard, Release 1.0x.
Contents

About this document .......................... 9
Conversion notes ............................. 11
Preconversion procedure ..................... 25
IODU/C software conversion ............... 31
IODU/C Software Installation Tool ........ 81
cPCI® MMDU software conversion ........ 107
Increasing NT9D19, NT5D10 CP and NT5D03 CP memory ................... 151
Using the Distributor Keycode Application .... 169
Using the Keycode Retrieval Utility ........ 189
Creating keycode diskettes ................. 199
Increasing A0810496, and NT4N64 CP PII memory ......................... 201
Postconversion procedure .................. 251
Upgrading to a new Call Processor card ...... 259
CD-ROM Software Installation Tool .......... 277
About this document

This document applies to Meridian 1 Internet Enabled systems.

This document is a global document. Contact your system supplier or your Nortel Networks representative to verify that the hardware and software described is supported in your area.

Who should use this document

This document is intended for individuals responsible for software conversion and memory upgrades.

How this document is organized


This document is for software conversion and memory upgrades only. The procedures in this document are not for any other purpose.

Specific machine types, as they are supported by software releases, are shown in Table 3 on page 22.

CAUTION
Loss of Data

Do not convert a system unless you are thoroughly familiar with it and with conversion procedures. You must read through the procedure before starting.
Note: Converting software on single CPU systems disrupts call processing and allows service only to those telephones connected to Power Failure Transfer Units (PFTUs). Established calls may not be affected.

CAUTION WITH ESDS DEVICES

To avoid damaging equipment from electrostatic discharge, wear a properly connected anti-static wrist strap when working on Meridian 1 equipment.

Follow Pre-conversion and Post-conversion procedures for every system conversion.

Throughout this document the term Media refers to tape, disk, or CD-ROM, whichever applies to your system.

The term Source refers to the software that you are currently running. Target refers to the new software that you are converting to.

CAUTION

Loss of Data

Read “Conversion notes” on page 11 before performing any operations.

It contains information crucial to the conversion process.
Conversion notes

Contents

The following are the topics in this section:

Conversion media .......................................................... 13
Software packaging ...................................................... 14
General conversion information ...................................... 14
DN Expansion ............................................................... 15
Upgrading from disk drives to CD-ROM ............................. 15
Integrated Services Digital Network (ISDN) ......................... 16
 ISDN Calling Line ID (CLID) enhancements .................... 16
 Converting ISDN systems ............................................. 17
 D-channel monitor ....................................................... 18
 Incremental Software Management ................................. 18
 Patches ................................................................. 18
 Software patches ...................................................... 18
 Loadware patches using DPSDL .................................. 19
 Release 25.0x ............................................................ 19
 Software release supported by machine type .................... 22

Reference list

The following are the references in this section:

• Capacity Engineering (553-3001-149)
• Features and Services (553-3001-306)
• ISDN Basic Rate Interface: Product Description (553-3901-100)
Conversion procedures vary with the system type and Source release of software.

Table 1 on page 12 shows the software releases supported by Automatic Inline Conversion.

**Table 1**
**Automatic Inline Conversion**

<table>
<thead>
<tr>
<th>From (minimum) Source release/issue</th>
<th>Directly to Target release</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.xx</td>
<td>14, 15</td>
</tr>
<tr>
<td>11.xx</td>
<td>12, 13, 14, 15</td>
</tr>
<tr>
<td>12.xx</td>
<td>13, 14, 15</td>
</tr>
<tr>
<td>13.xx</td>
<td>14, 15</td>
</tr>
<tr>
<td>14.xx</td>
<td>15</td>
</tr>
<tr>
<td>15.xx</td>
<td>16, 17, 18</td>
</tr>
<tr>
<td>16.xx</td>
<td>17, 18</td>
</tr>
<tr>
<td>17.xx</td>
<td>18, 19</td>
</tr>
<tr>
<td>18.xx</td>
<td>19</td>
</tr>
<tr>
<td>19.xx</td>
<td>20, 21, 22, 23, 24, 25</td>
</tr>
<tr>
<td>20.xx</td>
<td>20, 21, 22, 23, 24, 25</td>
</tr>
<tr>
<td>X81 Phase 7 A, B, or C</td>
<td>20, 21, 23, 24, 25</td>
</tr>
<tr>
<td>X81 Phase 8, A0, A1 &amp; A2</td>
<td>20, 21, 23, 24, 25</td>
</tr>
<tr>
<td>X81 Phase 8, B0, B1 &amp; B2</td>
<td>20, 21, 23, 24, 25</td>
</tr>
<tr>
<td>21.xx</td>
<td>22, 23, 24, 25</td>
</tr>
<tr>
<td>22.xx</td>
<td>23, 24, 25</td>
</tr>
<tr>
<td>23.xx</td>
<td>24, 25</td>
</tr>
<tr>
<td>24.xx</td>
<td>25</td>
</tr>
</tbody>
</table>
It may be more time- and cost-effective to simply load new software and reenter system data, rather than going through all the procedures that a conversion requires. To determine the best option and how to take advantage of Target software features and services, consult your Nortel Networks representative.

CAUTION
Loss of Data

Always load LD 43 from the Source (current) media. That is, the media containing the software currently running your system.

The media received contains the conversion program (LD 66) for converting your current data to the format required for the next release. Check the labels on the media for accuracy. The conversion label contains the following information:

X mmm Z nnn where
X = Machine type number (see Table 3 on page 22)
mmm = Source software release and minimum issue
Z = Conversion tape vintage
nnn = Target software release and minimum issue

Conversion media

For software Release 24 and later systems, the following media is required for new software installations:

- CD-ROM — A generic CD-ROM that contains all software generics.
- Security device — Provides a unique program for each system. The device does not contain feature or software release specific information.
- Install diskette — Activates the Software Installation Tool. The Software Installation Kit contains three Install diskettes to support each Call Processor card. Use the Install diskette that corresponds with your CP card type.
- Keycode diskette — Consists of “keycodes” that contain software feature data. The keycodes must validate against the security device.
• 2 MB customer database diskettes — A blank DOS formatted disk for archiving the customer database.

• Database transfer utility diskette — Supports the transfer of 4 MB databases to 2 MB.

The keycode contains the software Release information. For new features or Incremental Software Management (ISM) limits, a new keycode is required (a new CD-ROM, security device, or install diskette is not required).

Software packaging

Remember to check your system packages prior to conversion. Be sure Target software contains all the packages required to support system operation.

General conversion information

This document supports conversions for STE, NT, RT, XT, 21E, 51, 51C, 61, 61C, 71, 81, 81C, and 81C CP PII systems only.

Note: Conversion from X37 to the latest software release is not supported.

Be sure your system has enough memory to complete the conversion. If not, go to “Increasing NT9D19, NT5D10 CP and NT5D03 CP memory” on page 151 before you begin. Refer to Capacity Engineering (553-3001-149) for details concerning system capacity requirements.

To monitor the CPUs during parallel reload procedures, install a temporary Serial Data Interface (SDI) card, and connect a local TTY (or modem for remote TTY access). Refer to the parallel reload procedures for more information.

In systems equipped with superloops, calls will drop during initialization when Peripheral Software Download (PSDL) occurs. The Superloop Network (NT8D04) and Controller (NT8D01) cards download peripheral software prior to initialization completion. This may extend the duration of the system initialization when completing a conversion.

When a software upgrade is performed to add new feature packages, a sysload or parallel reload is required to enable the new software.
If a Force Download occurs during a parallel reload, initialization can take up to 15 minutes. Calls in process will be interrupted.

When QPC742D FDI Cards are used, install disks in both disk drives before powering up the system. This is not required with later vintages of the FDI card.

If you have Auxiliary Processors working with your system, be sure they are powered up after you complete your conversion.

**CAUTION**

**Loss of Data**

Do not attempt backward data dumping between software versions, upissues, or releases. It will corrupt your data.

**DN Expansion**

Software conversion is designed to convert data blocks with the smaller DN fields on the Source disk to data blocks with expanded DN fields, irrespective of the DN Expansion package on the Target disk/system.

CDR Expansion is not required to enable DN expansion. However, in order for Call Detail Records to accurately reflect system activity, CDR Expansion must be enabled as well as DN Expansion. If DN Expansion is equipped and CDR Expansion is not, system operation is not affected, but CDR records will be inaccurate.

**Upgrading from disk drives to CD-ROM**

Upgrading a drive unit to CD-ROM requires the existing 4 MB database to be converted to 2 MB. The database is converted to 2 MB is using one of the following methods:

- using the Database Transfer utility (for systems equipped with IOP/CMDU or separate IOP and CMDU cards only)
• sending the database to Nortel Networks for conversion
• using the “Copy Database from Redundant Disk” command in the Meridian 1 Software Installation Tool (for redundant systems equipped with IOP/CMDU or separate IOP and CMDU cards)

Integrated Services Digital Network (ISDN)

Any ISDN site upgrading to software Release 15 or higher must be configured with the QPC757 vintage C, D-channel Handler (DCHI) card.

When performing a parallel reload, ISDN Primary Rate Interface (PRI) calls are dropped during initialization of Target software.

Software Release 18 and later support the NT6D80 Multi-purpose Serial Data Link (MSDL) card for D-channel interfaces.

Software Release 18 and later do not support even numbered port assignments on the NT6D11 International ISDN D-channel card. The even port assignments must be updated to odd port assignments in LD 17 prior to converting. If not done, the D-channel will not be reestablished after service change. Only QPC757 D-channel mode is supported.

Options 51C, 61C, and 81 require clock controller QPC471 vintage H or later, or QPC775 vintage C or later.

Option 81C requires clock controller QPC471 vintage H or later, or QPC775 vintage E or later.

ISDN Calling Line ID (CLID) enhancements

The Calling Line ID Enhancements feature delivers enhanced functionality pertaining to the construction and generation of Calling Line ID, and allows more program flexibility for Meridian 1 sets pertaining to CLID.

Prior to software Release 22.0x, CLID supported a single Listed Directory Number (LDN), a single Home NXX, and single Home Location Code. The Calling Line ID was built from key 0 of a set, or the LDN.
The CLID enhancement parameters have been enhanced to include multiple NXXs, multiple Home Locations Codes (HLOCs), multiple Numbering Plan Areas (NPAs), multiple Local Steering Codes (LSCs), and multiple Listed Directory Numbers (LDNs). The calling Line ID enhancement now allows more flexible CLID generation than prior releases.

With the CLID Enhancement feature, the system now supports:

- A new table driven feature with up to 4000 entries.
- Any entry number can be programmed against any DN on a per DN basis.
- Existing LDN can be used on a per DN key, per set basis.
- The existing Individual Directory Number (IDN) key of an ACD set can be sent as the CLID.
- The active DN key determines the CLID that is sent for conference and transfer.
- Supports the flexibility of 2-3 or 5-7 digits DNs.

During conversion, two CLID entries (0 and 1) are created in the customer data block. The entries are configured with ISDN CLID information from the existing customer data block, such as HNPA, HNXX, HLOC, etc. Entry 0 is used for the keys/sets that have a DID number. Entry 1 is used for the keys/sets that do not have a DID number.

Refer to Features and Services (553-3001-306) for more information on the CLID Enhancement feature.

**Converting ISDN systems**

New software may contain changes to the ISDN D-channel parameters that are downloaded to the DCHI or MSDL card. The system software automatically downloads the new parameters upon SYSLOAD if a parallel reload is not performed.

Ensure that the Release ID in the D-channel parameters (LD 17) at the far end is changed to the lowest release in your site configuration.
When a DCHI port is configured as a TTY port, INI messages may be truncated when printed after sysload. System performance is not affected, but you should view your history file for the entire message.

**D-channel monitor**

When the D-channel monitor is software-enabled and deactivated with a maintenance telephone, a data dump and sysload reactivate the monitor. To avoid this situation, software-disable the D-channel monitor prior to datadump and sysload.

**Incremental Software Management**

Incremental Software Management (ISM) defines the maximum number of Terminal Numbers, Automatic Call Distribution (ACD) Directory Numbers, ACD positions (agents and supervisors), and AST sets allowed in a system. Before upgrading to software Release 15.55 or higher, read the ISM section in *Features and Services* (553-3001-306).

Software Release 19.0x and later include Meridian Packet Handlers (MPH) as part of ISM tracking.

*Note:* DSL, LTID, and MPH are part of ISDN Basic Rate Interface (BRI). Refer to *ISDN Basic Rate Interface: Product Description* (553-3901-100) for more details.

---

**CAUTION**

**Loss of Data**

With Incremental Software Management (ISM) in software Release 15.55 and higher, if SYS message 4327, 4328, 4329, or 4330 appears at sysload, Reload Source system disks. Order ISM disks with sufficient system parameters configured.

---

**Patches**

**Software patches**

For Options 51C, 61C, 81, 81C, and 81C CP PII systems. Software patches are deleted when converting to a new software release, or when performing a software upissue. Software patches are not deleted when the same software release is reinstalled in the system.
If a software patch is included in your software, a plus sign (+) will appear next to the software issue number in LD 22.

**Loadware patches using DPSDL**

For Options 51C, 61C, 81, 81C, and 81C CP PII systems. Loadware patches are deleted when converting to a new software release, or when performing a software upissue. Loadware patches are also deleted when the same software release is reinstalled in the system.

If there are one or more loadware patches fully installed in your software, a plus sign (+) will print next to the PSWV version and the modified loadware issue number in LD 22.

Loadware patches are only fully installed once the psdl.rec successfully rebuilds and the system initializes (INI) and reboots.

**Release 25.0x**

Release 25 supports Automatic Inline Conversion from Release 19, 20, 21, 22, 23, 24, X81 Phase 7 and X81 Phase 8 in system Options 51C, 61C, 81, 81C, and 81C CP PII. Software installation and conversion is supported on CD-ROM using an IODU/C or MMDU drive.

Release 25 introduces Fiber Network Fabric. Fiber Network allows the expansion of Meridian 1 Option 81C and 81C CP PII systems from five to eight Network groups. The Intergroup cards and module in current Meridian 1 systems are replaced by a Dual Ring fiber optic network. This Fiber Network provides complete non-blocking communication between the network groups, which eliminates the incidence of busy signals for calls switched between groups.

With release 25, Option 51C, 61C, 81, and 81C systems can use any of the following processors available:

- 68060E NT5D03 CP card
- 68060 NT5D10 CP card
- 68040 NT9D19 CP card
With release 25, Option 81C CP PII systems can use any of the following processors:

- A0810496 CP PII card
- NT4N64 CP PII card
**Important** - Release 25 introduces new Flash and DRAM memory requirements. Call Processor cards that meet the “total” memory requirement, may not meet the individual Flash and DRAM memory requirement. Refer to Table 2 on page 21 for the Release 25 flash and DRAM memory requirements.

### Table 2
**Release 25 memory requirements**

<table>
<thead>
<tr>
<th>System type</th>
<th>Flash memory requirement</th>
<th>DRAM memory requirement</th>
<th>Total memory requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option 51C/61C</td>
<td>32 Mbyte</td>
<td>48 Mbyte</td>
<td>80 Mbyte</td>
</tr>
<tr>
<td>Option 81/81C</td>
<td>32 Mbyte</td>
<td>64 Mbyte</td>
<td>96 Mbyte</td>
</tr>
</tbody>
</table>
| • Option 81/81c systems operating on Call Processor 68060 or 68060E with five or fewer network groups (including Fiber Network Fabric systems)  
• any Option 81/81C systems operating on Call Processor 68040 | | | |
| Option 81/81C | 32 Mbyte                  | 80 Mbyte                | 112 Mbyte                |
| • Option 81/81c systems operating on Call Processor 68060 or 68060E with six or more network groups | | | |
| Option 81C CP PII | 256 Mbyte                |                         |                          |
| • Option 81C CP PII systems with six or more network groups recommended using the NT4N64 processor. | | | |

**Note:** CP PII systems are shipped in a 128 Mbyte (A0810496) or 256 Mbyte (NT4N64) configuration. This memory cannot be upgraded in the field.
Software release supported by machine type

Table 3 on page 22 shows the software release associated with each system and its available release levels. The last two digits in the “software system number” column indicate the software generic; the first one or two digits indicate the system type. For example, the system number for system Option 81C is 1911.

Table 3
Software generic by machine type (Part 1 of 3)

<table>
<thead>
<tr>
<th>System type</th>
<th>Software system number</th>
<th>Lowest supported release</th>
<th>Highest supported release</th>
</tr>
</thead>
<tbody>
<tr>
<td>STE</td>
<td>1511</td>
<td>18</td>
<td>21</td>
</tr>
<tr>
<td>NT</td>
<td>1111</td>
<td>8</td>
<td>21</td>
</tr>
<tr>
<td>XT</td>
<td>1211</td>
<td>8</td>
<td>21</td>
</tr>
<tr>
<td>RT</td>
<td>1311</td>
<td>12</td>
<td>21</td>
</tr>
<tr>
<td>Option 21E</td>
<td>1511</td>
<td>18</td>
<td>21</td>
</tr>
<tr>
<td>Option 51</td>
<td>1111</td>
<td>15</td>
<td>21</td>
</tr>
<tr>
<td>Option 51C equipped with NT6D66 CP card</td>
<td>1711</td>
<td>20</td>
<td>23</td>
</tr>
<tr>
<td>Option 51C equipped with NT9D19 CP Card</td>
<td>2211</td>
<td>22</td>
<td>25</td>
</tr>
<tr>
<td>Option 51C equipped with NT5D10 CP card</td>
<td>2411</td>
<td>23</td>
<td>25</td>
</tr>
<tr>
<td>Option 51C equipped with NT5D03 CP card</td>
<td>2811</td>
<td>23.5X</td>
<td>25</td>
</tr>
<tr>
<td>Option 61</td>
<td>1111</td>
<td>15</td>
<td>21</td>
</tr>
<tr>
<td>Option 61C equipped with NT6D66 CP card</td>
<td>1811</td>
<td>19</td>
<td>24</td>
</tr>
<tr>
<td>Option 61C equipped with NT9D19 CP card</td>
<td>2311</td>
<td>22</td>
<td>25</td>
</tr>
<tr>
<td>System type</td>
<td>Software system number</td>
<td>Lowest supported release</td>
<td>Highest supported release</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>------------------------</td>
<td>--------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Option 61C equipped with NT5D10 CP card</td>
<td>2511</td>
<td>23</td>
<td>25</td>
</tr>
<tr>
<td>Option 61C equipped with NT5D03 CP card</td>
<td>2911</td>
<td>23.5X</td>
<td>25</td>
</tr>
<tr>
<td>Option 81 equipped with NT6D66 CP card*</td>
<td>1611</td>
<td>18</td>
<td>24</td>
</tr>
<tr>
<td>Option 81 equipped with NT9D19 CP card*</td>
<td>1911</td>
<td>21</td>
<td>25</td>
</tr>
</tbody>
</table>
### Table 3
Software generic by machine type (Part 3 of 3)

<table>
<thead>
<tr>
<th>System type</th>
<th>Software system number</th>
<th>Lowest supported release</th>
<th>Highest supported release</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option 71</td>
<td>1211</td>
<td>15</td>
<td>21</td>
</tr>
<tr>
<td>Option 81 equipped with NT5D10 CP card*</td>
<td>2611</td>
<td>23</td>
<td>25</td>
</tr>
<tr>
<td>Option 81 equipped with NT5D03 CP card*</td>
<td>3011</td>
<td>23.5X</td>
<td>25</td>
</tr>
<tr>
<td>Option 81C equipped NT6D66 CP card**</td>
<td>1611</td>
<td>21</td>
<td>24</td>
</tr>
<tr>
<td>Option 81C equipped with NT9D19 CP card**</td>
<td>1911</td>
<td>21</td>
<td>25</td>
</tr>
<tr>
<td>Option 81C equipped with NT5D10 CP card**</td>
<td>2611</td>
<td>23</td>
<td>25</td>
</tr>
<tr>
<td>Option 81C equipped with NT5D03 CP card**</td>
<td>3011</td>
<td>23.5X</td>
<td>25</td>
</tr>
<tr>
<td>Option 81C CP PII equipped with A0810496 CP PII card***</td>
<td>3311</td>
<td>25.xx</td>
<td>25.40</td>
</tr>
<tr>
<td>Option 81C CP PII equipped with NT4N64 CP PII card***</td>
<td>3311</td>
<td>25.xx</td>
<td>25.40</td>
</tr>
</tbody>
</table>

**Note 1:** *Option 81 systems require software option 298.

**Note 2:** **Option 81C systems require software option 299.

**Note 3:** ***Option 81C CP PII systems require software option 368.
Preconversion procedure

Contents

The following are the topics in this section:

Preconversion steps. .......................................................... 26

Reference list

The following are the references in this section:

• Maintenance (553-3001-511)

Read the Conversion notes section in this document before beginning your conversion procedures. The conversion procedure used depends on the release of the Source and Target software. Make sure you have all the necessary hardware and software. Save a copy of your data dumped Source software until you are sure that all site data converted successfully.

Use this procedure to begin all software conversions. When you complete this procedure, refer to “IODU/C software conversion” on page 31, or appropriate. After you have completed your conversion, perform the post-conversion steps in “Postconversion procedure” on page 251.

The following items should be available before proceeding:

• the Controlled Release Bulletin for the new software
• the appropriate software and conversion media
• the CD-ROM, and diskettes (as required)
• a temporary SDI card and a local TTY or remote TTY modem required to perform parallel reload in dual CPU systems
• new memory, if required
Preconversion steps

1. Perform an overall system check. Make sure the system is performing normal call processing.

2. Get software information from LD 22.

   LD 22
   REQ
   ISS
   **** to exit overlay

   Patches do not need to be removed prior to conversion. When data dumping (EDD), an EHM500 message is printed, rather than a list of patch numbers.

   If a patch is included in your software and you are running on Release 19 or higher, a plus sign (+) will appear next to the software issue number in LD 22.

3. Load the configuration record (LD 17) to find the storage currently available in the Protected and Unprotected Data Store (PDATA and UDATA). Check the General Release Bulletin to see if additional memory is required for the new software or for any option packages being added.

4. Print system data listed in Table 4 on page 29. Verify all information is correct. Make corrections if necessary.

5. If additional memory is required for the conversion, change the MSPT, MEM, or MTYP prompts in the configuration record (LD 17). See “Increasing NT9D19, NT5D10 CP and NT5D03 CP memory” on page 151.

6. Perform a template audit. The template audit reviews the templates in your system and cleans up any duplicate or corrupted templates. The following is an example of the information generated by the system during the audit. This may take an extended period of time on large systems. It is recommended that it be run during a low traffic period.

   **CAUTION**
   **Loss of Data**

   Do not abort this overlay until the audit is complete. If the overlay is interrupted, data will be corrupted.
To ensure backup, perform a data dump to the Source system media currently in the drive. If the data dump is not successful, do not proceed with the conversion. The data dump problem must be corrected. Contact your Nortel Networks technical support.

If parallel reload is to be used during the conversion, go to or "IODU/C software conversion" on page 31. Be sure to perform the correct parallel reload procedure for your system.

**Note:** To monitor the CPUs during parallel reload procedures, install a temporary Serial Data Interface (SDI) card, and connect a local TTY (or modem for remote TTY access). Refer to the parallel reload procedures for more information.
If parallel reload is not required (single CPU system) then perform one or more of the following conversion procedures. Remember to perform the post-conversion steps ("Postconversion procedure" on page 251) to complete the conversion.

- “cPCI® MMDU software conversion” on page 107
- “Increasing NT9D19, NT5D10 CP and NT5D03 CP memory” on page 151
Items marked with asterisks (*) are required printout for conversion. Other items are recommended for a total system status.

Table 4
Print site data (Part 1 of 2)

<table>
<thead>
<tr>
<th>Site data</th>
<th>Print command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal blocks for all TNs</td>
<td>LD 20</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE TNB</td>
</tr>
<tr>
<td></td>
<td>CUST &lt;cr&gt;</td>
</tr>
<tr>
<td>Directory Numbers</td>
<td>LD 20 (LD 22 prior to Release 16)</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE DNB</td>
</tr>
<tr>
<td></td>
<td>CUST &lt;cr&gt;</td>
</tr>
<tr>
<td>Attendant Console data block for all customers</td>
<td>LD 20</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE ATT, 2250</td>
</tr>
<tr>
<td></td>
<td>CUST &lt;cr&gt;</td>
</tr>
<tr>
<td>*Customer data block for all customers</td>
<td>LD 21</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE CDB</td>
</tr>
<tr>
<td></td>
<td>CUST &lt;cr&gt;</td>
</tr>
<tr>
<td>Route data block for all customers</td>
<td>LD 21</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE RDB</td>
</tr>
<tr>
<td></td>
<td>CUST Customer number</td>
</tr>
<tr>
<td></td>
<td>ROUT &lt;cr&gt;</td>
</tr>
<tr>
<td></td>
<td>ACOD &lt;cr&gt;</td>
</tr>
<tr>
<td>*Configuration Record</td>
<td>LD 22</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE CFN</td>
</tr>
</tbody>
</table>
### Table 4
Print site data (Part 2 of 2)

<table>
<thead>
<tr>
<th>Site data</th>
<th>Print command</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Software packages</td>
<td>LD 22</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE PKG</td>
</tr>
<tr>
<td>*Software issue, ROM and tape ID</td>
<td>LD 22</td>
</tr>
<tr>
<td></td>
<td>REQ ISS</td>
</tr>
<tr>
<td></td>
<td>REQ ROM</td>
</tr>
<tr>
<td></td>
<td>REQ TID</td>
</tr>
<tr>
<td>* Peripheral software versions</td>
<td>LD 22</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE PSWV</td>
</tr>
<tr>
<td>ACD data block for all customers</td>
<td>LD 23</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE ACD</td>
</tr>
<tr>
<td></td>
<td>CUST Customer Number</td>
</tr>
<tr>
<td></td>
<td>ACDN ACD DN (or &lt;CR&gt;)</td>
</tr>
<tr>
<td>Superloop card IDs and software version (peripheral controller, superloop network and controller cards)</td>
<td>LD 32</td>
</tr>
<tr>
<td></td>
<td>. IDC loop</td>
</tr>
<tr>
<td>Multi-purpose ISDN Signaling Processor (MISP) card</td>
<td>LD 27</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE MISP</td>
</tr>
<tr>
<td></td>
<td>LOOP loop number (0-158) &lt;cr&gt;</td>
</tr>
<tr>
<td></td>
<td>APPL &lt;cr&gt;</td>
</tr>
<tr>
<td></td>
<td>PH &lt;cr&gt;</td>
</tr>
<tr>
<td>DTI/PRI data block for all customers</td>
<td>LD 73</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE DDB</td>
</tr>
</tbody>
</table>

**Note:** Items marked with asterisks (*) are required printout for conversion. Other items are recommended for a total system status.
IODU/C software conversion

Contents

The following are the topics in this section:

- Parallel reload the 61C/81/81C .................................................. 32
  - Verify memory ................................................................. 33
  - Perform a data dump ..................................................... 34
  - STAT the hardware .......................................................... 34
  - Split the Cores .............................................................. 35
  - Install software on Core/Net 1 ........................................ 35
  - Check for peripheral software download ............................ 40
  - Switch call processing to Core/Net 1 ................................. 40
  - Test Core/Net 1 ............................................................. 41
  - Install software on Core/Net 0 ........................................ 41
  - Exiting split mode .......................................................... 43
  - Test Core/Net 1 and Core/Net 0 ........................................ 44
  - Synchronize the hard disks ............................................... 45
  - Backing out of the parallel reload on Options 61C, 81, 81C .... 46
- Option 51C software conversion ............................................. 48
  - Verify memory ................................................................. 48
  - Perform a data dump ..................................................... 49
  - STAT the hardware .......................................................... 49
  - Install software ............................................................. 49
  - Check for Peripheral Software Download ............................ 52
  - Test call processing ..................................................... 52
  - Complete the upgrade .................................................... 52
- Adding features and ISM limits ............................................. 53
  - Feature operation .......................................................... 53
Use the procedures in this section if your system is equipped with NT5D61 Input Output Disk Unit with CD-ROM (IODU/C) card(s). If your system is not equipped with the IODU/C card, do not use these procedures.

The procedures in this section describe how to:

- convert one software release to a later release
- perform a software upissue within in the same software release
- add new features
- modify Incremental Software Management (ISM) limits

To better understand the process, read through the entire procedure before you begin.

Parallel reload the 61C/81/81C

*Note:* This procedure does not include instructions for installing new IODU/C cards. To use this procedure, your system must already be equipped with IODU/C cards.

Use the parallel reload procedures to convert from one software release to a later release or to upissue software within the same software release. These parallel reload procedures are for software conversions only. Do not use this procedure for any other purpose. Parallel reloads can be done from either CPU. For the purposes of this document, we begin with CPU 0.
Table 5 on page 33 summarizes the required steps to perform this procedure.

**Table 5**
Options 61C, 81, 81C parallel reload summary

<table>
<thead>
<tr>
<th>Step</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Verify memory</td>
<td>page 33</td>
</tr>
<tr>
<td>2. Perform a data dump</td>
<td>page 34</td>
</tr>
<tr>
<td>3. STAT the hardware</td>
<td>page 34</td>
</tr>
<tr>
<td>4. Split the Cores</td>
<td>page 35</td>
</tr>
<tr>
<td>5. Install software on Core/Net 1</td>
<td>page 35</td>
</tr>
<tr>
<td>6. Check for peripheral software download</td>
<td>page 40</td>
</tr>
<tr>
<td>7. Switch call processing from Core/Net 0 to</td>
<td>page 40</td>
</tr>
<tr>
<td>Core/Net 1</td>
<td></td>
</tr>
<tr>
<td>8. Test Core/Net 1</td>
<td>page 41</td>
</tr>
<tr>
<td>9. Install software on Core/Net 0</td>
<td>page 41</td>
</tr>
<tr>
<td>10. Exit split mode</td>
<td>page 43</td>
</tr>
<tr>
<td>11. Test Core/Net 0 and 1</td>
<td>page 44</td>
</tr>
<tr>
<td>12. Synchronize the hard disks</td>
<td>page 45</td>
</tr>
<tr>
<td>13. Perform a data dump</td>
<td>page 46</td>
</tr>
</tbody>
</table>

**Verify memory**

Determine whether your system requires additional memory. Refer to “Increasing NT9D19, NT5D10 CP and NT5D03 CP memory” on page 151 for memory requirements and upgrade procedures.
Perform a data dump

1. Load the Equipment Data Dump Program (LD 43). At the prompt, enter LD 43 to load the program.

2. When “EDD000” appears on the terminal, enter EDD to begin the data dump.

3. When “DATABASE BACKUP COMPLETE” or “DATADUMP COMPLETE” appears on the terminal, enter

   ** CAUTION **
   Loss of Data

   If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.

** **** to exit the program

STAT the hardware

1. Load LD 137 and get status of the hard disks.

   Note: Be sure the hard disks are synchronized. If not, synchronize before proceeding.

   LD 137
   STAT Get the status of the hard disks
   SYNC Synchronize hard disks if necessary. Synchronization may take up to 50 minutes
   TEST CMDU Performs hard and floppy disk test.
   **** exit program

2. Load LD 135 and get status of the CPs, CNIs and memories.

   LD 135
   STAT CPU Get the status of both CPs and memory
   STAT CNI Get the status of all configured CNIs
3 Test the standby (inactive) CP. Then switch CPs, and test again.

TEST CPU Test standby (inactive) CP

Wait until the terminal returns a complete test message. The message “HW1533 or HW1534” does not mean the test has completed!

SCPU Switch CPs

TEST CPU Test the standby (inactive) CP

Note: Testing the CPs can take up to 20 minutes for each test. When the test is complete, the memories are automatically synchronized.

Split the Cores

1 Be sure CP 0 is active and CP1 is standby. You may need to switch CPs again:

STAT CPU

**** exit program

a. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.

LD 137

STAT Get the status of IODU/C

SWAP Switch IODU/Cs if necessary

**** exit program

2 Connect a terminal to the CPSI port in Core/Net 1 to J25 of the I/O panel at the back of the Core/Net. Be sure it is configured as follows. The recommended baud rate is 9600, to be the same as the CPSI port.

7 data bits, 1 stop bit, Space parity, Full duplex, XON protocol

3 Place CP 0 in Maintenance by setting the MAINT/NORM switch to MAINT.

4 In Core/Net 1, disable the CNI cards by setting the ENB/DIS faceplate switches to DIS.

Install software on Core/Net 1

1 Place the CP Install disk that corresponds with the installed CP card type into the IODU/C in Core/Net 1.

2 Install the CD-ROM into the CD drive:
a. press the button on the CD-ROM drive to open the CD-ROM disk holder
b. place the CD-ROM disk into the holder with the disk label showing
c. use the four tabs to secure the CD-ROM drive
d. press the button again to close the CD-ROM disk holder (don’t push the holder in by hand)

3 In Core/Net 1, perform the following three steps in uninterrupted sequence:
   a. press and hold the MAN RST button on the CP card
   b. set the MAINT/NORM switch on the CP card to MAINT
   c. release the MAN RST button

A sysload will begin (cold start). Wait for the Main Menu to appear on the terminal before proceeding.

**Note 1:** If the CD-ROM is not in the CD drive of the IODU/C, the installation procedure will not continue. Please insert the CD-ROM into the drive to continue.

**Note 2:** If a problem is detected during the system verification, Install stops, prints an error message, and aborts the installation. If the verification is not successful, do not continue; contact your technical support organization.

4 Press <CR> to continue.

5 Log into the system and enter the time and date, when prompted.

6 Initiate the database installation by selecting the following command from the menu:
   <u> to Install menu

7 Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.
   <a> to continue with keycode validation
   <y> to confirm that the keycode matches the CD-ROM release
8. When the Install Menu is displayed, select the following options:
   <b>to install software, database, CP-BOOT ROM, and IOP-ROM</b>
   <a>to verify that the CD-ROM is now in drive</a>
   The Installation Status Summary screen appears that lists the options to be installed.
   <y>Yes, start Installation</y>
   <a>Continue with Upgrade</a>

Pre-release 3 language groups

9. Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series sets.

Select one of the six PSDL files:
   <1> Global 10 Languages
   <2> Western Europe 10 Languages
   <3> Eastern Europe 10 Languages
   <4> North America 6 Languages
   <5> Spare Group A
   <6> North America 6 Languages (Duplicate of <4>)

The languages contained in each selection are outlined as follows:

- 1 - English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- * 2 - English, French, German, Spanish, Swedish, Norwegian, Danish, Finnish, Italian, Brazilian Portuguese.
- * 3 - English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- * 4 - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
- * 5 - English, French, German, Spanish, Swedish, Italian, Norwegian, Portuguese, Finnish, Japanese Katakana.
- * 6 - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
Release 3 language groups

10 Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series sets.

Select one of the six PSDL files

<1> Global 10 Languages
<2> Western Europe 10 Languages
<3> Eastern Europe 10 Languages
<4> North America 6 Languages
<5> Spare Group A
<6> North America 6 Languages (Duplicate of <4>)

The languages contained in each selection are outlined as follows:

- 1 – Global 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- 2 – Western Europe 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Danish.
- 3 – Eastern Europe 10 Languages (Release 3) English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- 4 – North America six Languages (Release 3) English, French, German, Spanish, Brazilian Portuguese, Japanese Katakana.
- 5 – Spare Group A.
- 6 – Spare Group B.

11 Continue with ROM and IOP-ROM upgrade when prompted.
12 Select a database to install.

When the installation is complete, the Installation Status Summary table appears. Press <CR> to continue.

When the Install Menu appears, select:

<d> To install Database only

When the database installation screen appears, insert the first 2 MB database diskettes in the IODU/C.

<a> to install the customer database

<y> to start installation

Follow the instructions to install the database and update the ROM.

The Installation Status Summary screen appears. Verify that CD to disk, disk to ROM, Database, CP-BOOTROM, and IOP-ROM were installed.

<cr> press return to continue

<q> to quit (remove any diskettes from the floppy drive)

<y> Yes, to confirm quit

<a> to reboot the system

The system will automatically perform a sysload during which several messages will appear on the system terminal. Wait for “DONE” and then “INI” messages to be displayed before continuing.

If the system fails to load, or system messages indicate data corruption, back out of the parallel reload process by performing the steps in “Backing out of the parallel reload on Options 61C, 81, 81C” on page 46.
Check for peripheral software download

1 Load LD 22 and print Target peripheral software version. The Source peripheral software version was printed during the pre-conversion procedure. If there is a difference between the Source and Target peripheral software version, a forced download will occur during initialization when coming out of parallel reload. System initialization will take longer and established calls on IPE will be dropped.

LD 22
REQ PRT
TYPE PSWV
**** exit program

Switch call processing to Core/Net 1

CAUTION
Service Interruption

Call Processing will be interrupted! Perform these next steps carefully. This is the point at which your service is interrupted. Calls in process will be interrupted, especially if Peripheral Software Download takes place. Some calls may be dropped.

Perform the next four steps in succession. Call processing will be switched from Core/Net 0 to Core/Net 1.

1 In Core/Net 0, set the DIS/ENB faceplate switch on the IODU/C card to DIS.
2 In Core/Net 0, disable the CNI cards by setting the ENB/DIS faceplate switches to DIS.
3 In Core/Net 1, enable the CNI cards by setting the ENB/DIS faceplate to ENB.
4 In Core/Net 1, press the MAN INT button.

Note: Call processing is now switched from Core/Net 0 to Core/Net 1.
Test Core/Net 1

1 Test Call Processing. This includes, but is not limited to the following:
   - Check for dial tone.
   - Make internal, external, and network calls.
   - Check attendant console activity.
   - Check DID trunks.
   - Check any auxiliary processors.

   Note: From this point forward you will be upgrading Core/Net 0 with new software.

Install software on Core/Net 0

1 Move the CPSI port cable from J25 on Core/Net 1 to J25 on Core/Net 0.
2 Set the IODU/C faceplate switch to ENB.
3 Insert the CP Install diskette into Core/Net 0.
4 Press the MAN RST button on the CP card in Core/Net 0 to reboot the system and start the Software Installation Tool. (The terminal displays SYSLOAD messages during file loading. When SYSLOAD is completed, the NT logo appears.)
5 When the NT logo appears, press <CR> to continue.
6 When the Main Menu appears, select the following options in sequence:
   - <u> to Install menu

7 Remove the CP Install Program diskette and insert the Keycode diskette. Select the following when prompted:
   - <a> to continue with keycode validation
   - <y> to confirm that the keycode matches the CD-ROM release
8 When the Install Menu appears, select the following options in sequence to copy the software from Core/Net 1 to Core/Net 0, install CP-software, ROMs, and transfer the database to the redundant disk:

- `<o>` to copy system software from the other core
- `<a>` to copy /p partition from Core 1 to Core 0
- `<a>` to continue with upgrade

When the software has copied successfully, you must install CP-software from the hard disk to Flash EEPROM, and install CP-BOOT ROM.

- `<CR>` press <CR> when you are ready to continue
- `<y>` to start installation
- `<a>` to continue with ROM upgrade
- `<y>` to start installation
- `<a>` to continue with ROM upgrade.

When the installation is complete, the Installation Status Summary screen appears.

- `<CR>` to return to the Install Menu

When the Install Menu appears, install IOP-ROM:

- `<f>` to install IOP-ROM only

When the Installation Status Summary screen appears:

- `<y>` to start installation
- `<y>` to continue installing IOP-ROM
- `<a>` to continue with ROM upgrade

When the installation is complete, the Installation Status Summary screen appears.

- `<CR>` to return to the Install Menu

When the Install Menu appears, install the database:

- `<d>` to install database only
- `<d>` to copy database from the redundant disk

When the Installation Status Summary screen appears:

- `<y>` to start installation
- `<a>` to continue transferring the database from the redundant disk

When the Installation Status Summary screen appears, press:

- `<CR>` to return to the Install Menu
Exiting split mode

1. Connect CPSI port or maintenance SDI port
2. Enable the CNI cards by setting the ENB/DIS faceplate switch to ENB in Core/Net 0.
3. Perform the following in uninterrupted sequence:
   - Press and release the MAN RST button in Core/Net 0.
   - When SYS700 messages appears on LCD display on Core/Net 0, set the MAINT/NORM switch to NORM in Core/Net 0.

In 60 seconds, the LCD will display and confirm your processes with:

   **RUNNING ROM OS**
   **ENTERING CP VOTE**

An HWI534 message indicates the start of memory synchronization. In 10 minutes, an HWI533 message on Core/Net 1 CSPI or SDI terminal indicates the memory synchronization is complete.

4. In Core/Net 1, set the MAINT/NORM switch on the CP card to NORM.
Test Core/Net 1 and Core/Net 0

1. Perform a redundancy sanity test using the following sequence:

   - LD 135
   - STAT CNI: Get status of CNI cards
   - STAT CPU: Get status of CPU and memory
   - TEST CPU: Test the inactive Core/Net
   - TEST CNI cs: Test each inactive CNI card

2. Switch Cores and test the other side (Core/Net 0)

   - SCPU: Switch cores
   - TEST CPU: Test the inactive Core/Net
   - TEST CNI cs: Test each inactive CNI card

   **Note:** Testing the CP and CNI cards and synchronizing memory can take up to 20 minutes for each test. When the CP test is complete, the CP memory is automatically synchronized.

3. Clear the display and minor alarms on both Cores.

   - CDSP: Clear the displays on the Cores
   - CMAJ: Clear major alarms
   - CMIN ALL: Clear minor alarms

4. Get the status of the Cores, CNIs, and memory.

   - STAT CPU: Get the status of both Cores
   - STAT CNI: Get the status of all configured CNIs and memory

   **Note:** You may need to execute the STAT CNI command twice before receiving a response from the system.

   **** exit program
Synchronize the hard disks

1. Load LD 137 and synchronize the hard disks. Synchronization may take up to 50 minutes. To be sure that the contents of IODU/C 1 are copied to IODU/C 0, verify that IODU/C 0 is disabled.

   **LD 137**
   - **STAT**: Get the status of the IODU/C and redundancy
   - **SYNC**: Enter "Yes" to synchronize disks. Wait until the memory synchronization successfully completes before continuing.

   **TEST CMDU**: Performs hard and floppy disk test.

2. Get the status of the CMDU's and be sure CMDU 0 is active. Switch if necessary.

   **STAT**: Get the status of IODU/C and redundancy
   - **SWAP**: Switch CMDU if necessary
   - **STAT CMDU**: Get the status of the IODU/Cs. Be sure the same IODU/C and CPU are active.

   ****: exit program
Perform a data dump

Load the Equipment Data Dump Program (LD 43). At the prompt, enter

**LD 43** to load the program

1 When “EDD000” appears on the terminal, enter
   **EDD** to begin the data dump

2 When “DATABASE BACKUP COMPLETE” or “DATADUMP COMPLETE” appears on the terminal, enter

   **CAUTION**

   **Loss of Data**
   If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.

   ******** to exit the program

Backing out of the parallel reload on Options 61C, 81, 81C

1 Place the original Install disk 1 into the IODU/C in Core/Net 1.
2 In Core/Net 1, press the MAN RST button.
3 Select <u> to initiate the Install Tool.
4 Remove the CP Install diskette and insert the source keycode diskette.
5 Select <a> to continue with keycode validation.
6 When the install screen appears, select the following options in sequence, and insert the source database diskette when you are prompted to do so.
   **<b>** to install software, database, CP-BOOT ROM, and IOP-ROM
   **<a>** to start installation
   **<a>** continue with upgrade
When the database installation screen appears, select the following:

- `<c>` to transfer the previous system database (DBMT) (choose this option if the database was converted on-site)
- `or`
- `<a>` to install customer database (choose this option if the database was sent to Nortel Networks for conversion)
- `<a>` to continue with the database install
- `<y>` to delete the hardware infrastructure database files from the hard disk

When the ROM installation screen appears, select the following:

- `<a>` to continue with the ROM upgrade

Following the database installation, upgrade the ROMs:

- `<a>` to continue with ROM upgrade (CP-BOOT)
- `<y>` to start installation
- `<a>` to continue with ROM upgrade (IOP-ROM)

Remove the disk from the IODU/C in Core/Net 1.

From the main menu, select the following options to quit and reload the system:

- `<q>` to quit
- `<y>` to confirm quit

Remove any diskettes from the floppy drive, and type

- `<a>` to reboot the system

In Core/Net 1, perform the following steps:

- enable the CNI cards by setting the ENB/DIS faceplate switches to ENB
- press and release the MAN RST button on the CP card
  - When SYS700 messages appear on the CP 1 LCD display
- set CP 1 MAINT/NORM switch to NORM.

Within 60 seconds, the LCD will display the following messages, confirming the process.
RUNNING ROM OS
ENTERING CP VOTE

An “HWI534” message from the CPSI or SDI port indicates the start of memory synchronization. Within 10 minutes, an “HWI533” message on Core/Net 0 CPSI or SDI TTY indicates the memory synchronization is complete. Wait until the memory synchronization is complete before continuing.

14 In Core/Net 0, set the MAINT/NORM switch on the CP card to NORM.

15 Perform a redundancy sanity test.

LD 135
TEST CPU Test the standby (inactive) Core/Net.
SCPU Switch the Cores.
CDSP Clear display.
TEST CPU Test the standby (inactive) Core/Net.
SCPU Switch the Cores.

Note: Testing the CPs can take up to 20 minutes for each test. When the test is complete, the memories are automatically synchronized.

16 Load LD 137 and synchronize hard disks. Synchronization may take up to 50 minutes. To be sure the contents of CMDU 0 are copied to CMDU 1, use the STAT command to verify that CMDU 1 is disabled.

LD 137
STAT CMDU Get the status of both CMDUs.
SYNC Synchronize disks.
TEST CMDU Performs hard and floppy disk test.

You are now out of the parallel reload process, and have returned to the Source software.

Option 51C software conversion

Use this procedure to convert from one software release to another on Option 51C systems only.

Verify memory

Determine whether your system requires additional memory. Refer to “Increasing NT9D19, NT5D10 CP and NT5D03 CP memory” on page 151 for memory requirements and upgrade procedures.
Perform a data dump

1. Load the Equipment Data Dump Program (LD 43). At the prompt, enter LD 43 to load the program.
2. When “EDD000” appears on the terminal, enter EDD to begin the data dump.
3. When “DATABASE BACKUP COMPLETE” or “DATADUMP COMPLETE” appears on the terminal, enter

**CAUTION**

Loss of Data
If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.

**** to exit the program

STAT the hardware

1. Load LD 137 and get status of the hard disk.
   LD 137 STAT Get the status of the hard disks
2. Load LD 135 and get status of the CP, CNI and memory.
   LD 135 STAT CPU Get the status of the CP and memory
   STAT CNI Get the status of the CNI

Install software

1. Select the CP Install diskette which matches the Call Processor (CP) type on your system.
2. Insert the CP Install diskette into the floppy drive of the IODU/C.
3. Press MAN RST on the CP card.
The system will be booted from the floppy and the Install tool will be automatically invoked. The following screen appears

4 Press <CR> to continue.

5 Log into the system and enter the time and date, when prompted.

6 Initiate the database installation by selecting the following command from the menu:
   <u> to Install menu

7 Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.
   <a> to continue with keycode validation
   <y> to confirm that the keycode matches the CD-ROM release

8 When the Install Menu is displayed, select the following options in sequence when you are prompted to do so
   <b> to install software, database, CP-BOOT ROM, and IOP-ROM
   <a> to verify that the CD-ROM is now in drive
   The Installation Status Summary screen appears that lists the options to be installed.
   <y> Yes, start Installation
   <a> Continue with Upgrade
   When the ROM installation screen appears, select the following prompts in sequence:
   <a> Continue with ROM Upgrade
   The following message appears:
   Software Release XXXX was installed successfully. All files were copied from CDROM to the hard disk.
   Please press <CR> to when ready...
   <a> Continue with ROM upgrade
   <a> Yes, start Installation
   <a> Continue with ROM upgrade
   When the Installation Status Summary screen appears, press <CR> when ready...
   When the INSTALL MENU appears:
   <d> To install Database only
When the database installation screen appears, insert the first 2 MB database diskettes in the IODU/C.

- `<a>` to install the customer database
- `<y>` to start installation
- `<a>` to continue the database installation
- `<y>` to load the database
- `<a>` to continue with ROM upgrade

Are you sure you want to continue with IOP ROM

- `<a>` to install the IOP-ROM from hard disk
- `<y>` Yes, start installation

- `<a>` to continue with ROM upgrade

The Installation Status Summary screen appears. Verify that CD to disk, disk to ROM, Database, CP-BOOTROM, and IOP-ROM were installed.

- `<cr>` press return to continue
- `<q>` to quit (remove any diskettes from the floppy drive)
- `<y>` Yes, to confirm quit
- `<a>` to reboot the system

The system will automatically perform a sysload during which several messages will appear on the system terminal. Wait for “DONE” and then “INI” messages to be displayed before continuing.
Check for Peripheral Software Download

1. Load LD 22 and print Target peripheral software version. The Source peripheral software version was printed during the pre-conversion procedure. If there is a difference between the Source and Target peripheral software version, a forced download will occur during initialization when coming out of parallel reload. System initialization will take longer and established calls on IPE will be dropped.

   LD 22
   REQ  PRT
   TYPE  PSWV

Test call processing

1. Test Call Processing. This includes, but is not limited to the following:
   - Check for dial tone.
   - Make internal, external, and network calls.
   - Check attendant console activity.
   - Check DID trunks.
   - Check any auxiliary processors.

Complete the upgrade

1. Perform a redundancy sanity test using the following sequence:

   LD 135
   STAT CNI  Get status of CNI card
   STAT CPU  Get status of CPU and memory

2. Clear the display and minor alarms.

   CDSP  Clear the displays on the Cores
   CMAJ  Clear major alarms
   CMIN ALL  Clear minor alarms
   ****  exit program

The software conversion is complete.
Adding features and ISM limits

Adding new features and/or modifying Incremental Software Management (ISM) limits requires the installation of a new keycode. Keycodes are delivered via diskette or electronic file transfer and installed using the keycode management commands in LD 143 or the Meridian 1 Software Installation Tool.

The procedures below outline the steps to install a new keycode that can be activated "instantly" or that requires a sysload (Cold Restart). More information on the "Instant ISM" feature can be found in the X11 Features and Services guide.

This section describes how to install a keycode using the commands listed below:

**LD 143 commands**

<table>
<thead>
<tr>
<th>Keycode delivery</th>
<th>Keycode Installation command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diskette</td>
<td>Use the KNEW F0 or KNEW F1 command in LD 143</td>
</tr>
<tr>
<td>Electronic file on a PC</td>
<td>Use the KUPL command in LD 143, followed by the KNEW HD command (see note)</td>
</tr>
<tr>
<td>Faxed to the customer site (paper-based keycode)</td>
<td>Use the KMAN command in LD 143, followed by the KNEW HD command</td>
</tr>
</tbody>
</table>

*Note: If the keycode is downloaded from the Keycode Distributor Server (KDS), use the KUPL command to install the keycode. Refer to the Distributor Keycode Application section in this document for more information about KDS.*

**Feature operation**

Feature operation is further broken down into four options:

- upgrade feature and ISM parameter using a keycode diskette
- upgrade feature and ISM parameter using HyperTerminal
• upgrade feature and ISM parameter entered manually
• Revert to the previous keycode with the KRVR command

For the following procedures, Core 0 is initially active and Core 1 is initially inactive.

**Feature and ISM parameter upgrade using a keycode diskette**

Leave the system in full redundant mode (hard-disk and CPU redundancy).

1. Log in on a system terminal and load overlay 143.
   ```
   >LD 143
   CCBR000.
   ```

2. Insert the new keycode diskette into the floppy drive on the active IODU/C card.

3. Print the pending keycode contents.
   ```
   KSHO F1 (or F0) print the contents of the candidate keycode in the floppy drive on the active Core. Where:
   F1 = Core 1
   F0 = Core 0
   ```
Enter the KDIF command and select keycode comparison options.

**Note:** Ensure that the new keycode does not lower ISM limits or reduce features compared with the existing keycode. If you have determined that the keycode lowers ISM limits or reduces features, do not continue with the KNEW command, but contact your Nortel Networks order management representative.

```
KDIF
Please use: KDIF <param1> <param2>
with the following parameters:

NEW accepted new keycode
REC currently used keycode
OLD previously used keycode
F0 candidate keycode on diskette in /f0 floppy drive
F1 candidate keycode on diskette in /f1 floppy drive
HD candidate keycode which was uploaded to hard disk
```
Enter the keycode comparison option. The new keycode option is shown in **bold**.

**Note:** In the following example, the (REC) currently used keycode will be compared with the new keycode disk in floppy drive F0. The limits shown are for example purposes only.

`.KDIF REC F0`
Validating Keycode File `/p/install/keycode.rec ... OK`
Validating Keycode File `/f0/keycode.kcd ... OK`

<table>
<thead>
<tr>
<th>System parameters</th>
<th>1st keycode:</th>
<th>2nd keycode:</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Serial Number</td>
<td>46XX</td>
<td>46XX</td>
</tr>
<tr>
<td>Software Version</td>
<td>3311</td>
<td>3311</td>
</tr>
<tr>
<td>System Type</td>
<td>Option 61C</td>
<td>Option 61C</td>
</tr>
<tr>
<td>Call Processor</td>
<td>CP68040</td>
<td>CP68040</td>
</tr>
<tr>
<td>Release</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>Issue</td>
<td>XX</td>
<td>XX</td>
</tr>
<tr>
<td>NTI Order Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NT SDID - 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NT SDID - 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date and Time of Manufacture</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** ( ) indicates that information is not available

<table>
<thead>
<tr>
<th>ISM Limits</th>
<th>1st keycode:</th>
<th>2nd keycode:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop Limit</td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td>Sys TNs Limit</td>
<td>0</td>
<td><strong>200</strong></td>
</tr>
<tr>
<td>ACD Agt Limit</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>ACD DNs Limit</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>AST Limit</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

......

Common packages for both keycodes:
0-2 4-5 7-25 28-29 32-55 58-65

......
Additional packages in the 2nd keycode:
< 30-31

5 Select the new keycode for activation using the KNEW command.
   KNEW F0
The uploaded keycode is validated against the security device.
If the following system message is given:
CCBR020 New Keycode accepted and activated successfully.
Sysload is NOT needed!
This implies that the new keycode is eligible for instant activation and no further user action is required, proceed to step 6 and 7.
Otherwise, if the keycode is not eligible for instant activation, a Sysload is needed to activate the new keycode and the following system message is given:
CCBR009 New Keycode accepted. New ISM limits and feature packages will be activated during the next sysload (Cold Restart).
Skip to step 8.

6 Load Overlay 22 and confirm that the new ISM parameters have been updated.
   >LD 22
   REQ SLT
   ....
If ISM limits are correct then the keycode installation is complete.
See "Reverting to the previous keycode with the KRVR command" on page...(NTP group to fill in) if ISM limits are not increased or problems exist.

7 Once you have confirmed that the keycode changes taken affect as expected, perform a data dump in LD 43.

8 Do these steps for keycodes that are not eligible for Instant ISM.
   a. Place the system in split mode. This puts a redundant (shadowed) system into single (non-shadowed) mode.
b. Be sure CP 0 is active and CP1 is standby. You may need to switch CPs:

LD 135
STAT CPU
SCPU to switch CPUs if necessary
**** exit program

c. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.

LD 137
STAT Get the status of IODU/C
SWAP Switch IODU/Cs if necessary
**** exit program

d. In Core 0, set the CP card MAINT/NORM switch to MAINT.

e. In Core 1, disable the CNI cards by setting the ENB/DIS faceplate switches to DIS.

f. In Core/Net 1, perform the following three steps in uninterrupted sequence:
   • press and hold the MAN RST button on the CP card
   • set the MAINT/NORM switch on the CP card to MAINT
   • release the MAN RST button

A sysload will begin (cold start).

9 In the inactive core (Core 1), load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REQ SLT
....
10. Switch call processing from the active core (Core 0) to the inactive core (Core 1).

**CAUTION**

**Service Interruption**

Call Processing will be interrupted! Perform these next steps carefully and quickly. This is the point at which your service is interrupted. Calls in process will be interrupted, especially if Peripheral Software Download takes place. Some calls may be dropped.

- a. In Core 0, access LD 137 to software disable the IODU/C card.
  
  >LD 137
  .DIS CMDU 0

- b. In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to DIS.

- c. In Core 0, disable the CNI cards by setting the ENB/DIS faceplate switches to DIS. Call Processing will be interrupted.

- d. In Core 1, enable the CNI cards by setting the ENB/DIS faceplate to ENB.

- e. In Core 1, press the MAN INT button. Call processing will be switched from Core 0 to Core 1 when the warm restart is completed.

The previously inactive core (Core 1) with the new keycode now becomes active.

11. In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to ENB.

12. In order to activate the new keycode on the new inactive core, a sysload (Cold Restart) is required.

Press the MAN RST button on Core/Net 0.

13. In Core 0, load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REQ SLT
....
14 Return the system to redundant mode, synchronizing the memory and hard drive of the inactive core with the active core.

a. Enable the CNI cards by setting the ENB/DIS faceplate switch to ENB in Core/Net 0.

b. Perform the following in uninterrupted sequence:
   - Press and release the MAN RST button in Core/Net 0.
   - When SYS700 messages appears on LCD display on Core/Net 0, set the MAINT/NORM switch to NORM in Core/Net 0.

In 60 seconds, the LCD will display and confirm your processes with:

RUNNING ROM OS
ENTERING CP VOTE

An HWI534 message indicates the start of memory synchronization. In 10 minutes, an HWI533 message on Core/Net 1 CSPI or SDI terminal indicates the memory synchronization is complete.

c. In Core/Net 1, set the MAINT/NORM switch on the CP card to NORM.

15 Test Core/Net 1 and Core/Net 0

a. Perform a redundancy sanity test using the following sequence:

LD 135
STAT CNI Get status of CNI cards
STAT CPU Get status of CPU and memory
TEST CPU Test the inactive Core/Net
TEST CNI c s Test each inactive CNI card
b. Switch Cores and test the other side (Core/Net 0)

SCPU Switch cores
TEST CPU Test the inactive Core/Net
TEST CNI c s Test each inactive CNI card

Note: Testing the CP and CNI cards and synchronizing memory can take up to 20 minutes for each test. When the CP test is complete, the CP the memory is automatically synchronized.

c. Clear the display and minor alarms on both Cores.

CDSP Clear the displays on the Cores
CMAJ Clear major alarms
CMIN ALL Clear minor alarms

d. Get the status of the Cores, CNIs, and memory.

STAT CPU Get the status of both Cores
STAT CNI Get the status of all configured CNIs and memory

Note: You may need to execute the STAT CNI command twice before receiving a response from the system.

exit program

16 Synchronize the hard disks.
a. Load LD 137 and synchronize the hard disks. Synchronization may take up to 50 minutes. To be sure that the contents of IODU/C 1 hard disk are copied to IODU/C 0 hard disk, verify that IODU/C 0 is disabled.

LD 137
STAT Get the status of the IODU/C and redundancy
SYNC Enter "Yes" to synchronize disks. Wait until the memory synchronization successfully completes before continuing
TEST CMDU Performs hard and floppy disk test.

b. Get the status of the CMDU's and be sure CMDU 0 is active. Switch if necessary.

STAT Get the status of the IODU/C and redundancy
SWAP Switch CMDU if necessary
STAT CMDU Get the status of the IODU/Cs. Be sure the same IODU/C and CPU are active.
**** exit program

17 Perform a data dump in LD 43.

**Feature and ISM parameter upgrade using HyperTerminal®**

Leave the system in full redundant mode (hard-disk and CPU redundancy).

1 On a PC, access the Meridian 1 system (via a modem) with HyperTerminal®:
   Click the Start button | Programs | Accessories | HyperTerminal.
2 Double-click the HyperTerminal client to the Meridian 1 system.
3 Log into the Meridian 1 system.
4 Load the Keycode Management Program (LD 143).

LD 143 to load program
KUPL to upload keycodes to the hard disk on the target system
5  Click the **Transfer** menu in HyperTerminal and select **Send Text File**.

6  From the **Files of type** pull-down menu, select **All Files (.*.*)**.

7  Locate and select the keycode file on the PC. Use the **Look in** pull-down menu to select the drive on which the keycode is located.

8  Click **Open**.

   The keycode will be displayed after the KUPL prompt.

Example:

KUPL 0001PBX 0101
9FPAMSRHNN17KRUQAFFSPREQVMTIDHRKDJHRKEJR56

9  Press the Enter key.

   The Keycode is checked for CRC errors and is uploaded to the hard disk.

   Enter the following command:

   **KDIF REC HD**

   to compare the existing keycode with the new keycode on the hard disk

   Ensure that the new keycode does not lower ISM limits or reduce features compared with the existing keycode. If you have determined that the keycode lowers ISM limits or reduces features, do not continue with the KNEW command, but contact your Nortel Networks order management representative.
Select the new keycode for activation using the KNEW command.

KNEW HD

The uploaded keycode is validated against the security device.

If the following system message is given:

**CCBR020 New Keycode accepted and activated successfully. Sysload is NOT needed!**

This implies that the new keycode is eligible for instant activation and no further user action is required, proceed to step 11 and 12.

Otherwise, if the keycode is not eligible for instant activation, a Sysload is needed to activate the new keycode and the following system message is given:

**CCBR009 New Keycode accepted. New ISM limits and feature packages will be activated during the next sysload (Cold Restart).**

Skip to step 13.

Load Overlay 22 and confirm that the new ISM parameters have been updated.

>`LD 22
REQ SLT
...`

If ISM limits are correct then the keycode installation is complete.

See “Reverting to the previous keycode with the KRVR command” on page...(NTP group to fill in) if ISM limits are not increased or problems exist.

Once you have confirmed that the keycode changes taken affect as expected, perform a data dump in LD 43.

Do these steps for keycodes that are not eligible for Instant ISM.

Place the system in split mode. This puts a redundant (shadowed) system into single (non-shadowed) mode.
a. Be sure CP 0 is active and CP1 is standby. You may need to switch CPs:

LD 135
STAT CPU
SCPU to switch CPUs if necessary
**** exit program

b. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.

LD 137
STAT Get the status of IODU/C
SWAP Switch IODU/Cs if necessary
**** exit program

c. In Core 0, set the CP card MAINT/NORM switch to MAINT.

d. In Core 1, disable the CNI cards by setting the ENB/DIS faceplate switches to DIS.

e. In Core/Net 1, perform the following three steps in uninterrupted sequence:
   • press and hold the MAN RST button on the CP card
   • set the MAINT/NORM switch on the CP card to MAINT
   • release the MAN RST button

A sysload will begin (cold start).

14 In the inactive core (Core 1), load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REQ SLT
....
Switch call processing from the active core (Core 0) to the inactive core (Core 1).

**CAUTION**

Service Interruption

Call Processing will be interrupted! Perform these next steps carefully and quickly. This is the point at which your service is interrupted. Calls in process will be interrupted, especially if Peripheral Software Download takes place. Some calls may be dropped.

a. In Core 0, access LD 137 to software disable the IODU/C card.

   >LD 137
   .DIS CMDU 0

b. In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to DIS.

c. In Core 0, disable the CNI cards by setting the ENB/DIS faceplate switches to DIS. Call Processing will be interrupted.

d. In Core 1, enable the CNI cards by setting the ENB/DIS faceplate to ENB.

e. In Core 1, press the MAN INT button. Call processing will be switched from Core 0 to Core 1 when the warm restart is completed.

The previously inactive core (Core 1) with the new keycode now becomes active.

16 In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to ENB.

17 In order to activate the new keycode on the new inactive core, a sysload (Cold Restart) is required.

   Press the MAN RST button on Core/Net 0.

18 In Core 0, load Overlay 22 and confirm that the new ISM parameters have been updated.

   >LD 22
   REQ SLT
   ....
19 Return the system to redundant mode, synchronizing the memory and hard drive of the inactive core with the active core.

a. Enable the CNI cards by setting the ENB/DIS faceplate switch to ENB in Core/Net 0.

b. Perform the following in uninterrupted sequence:
   • Press and release the MAN RST button in Core/Net 0.
   • When SYS700 messages appear on LCD display on Core/Net 0, set the MAINT/NORM switch to NORM in Core/Net 0.

In 60 seconds, the LCD will display and confirm your processes with:

RUNNING ROM OS
ENTERING CP VOTE

An HWI534 message indicates the start of memory synchronization. In 10 minutes, an HWI533 message on Core/Net 1 CSPI or SDI terminal indicates the memory synchronization is complete.

c. In Core/Net 1, set the MAINT/NORM switch on the CP card to NORM.

20 Test Core/Net 1 and Core/Net 0

a. Perform a redundancy sanity test using the following sequence:

LD 135
STAT CNI Get status of CNI cards
STAT CPU Get status of CPU and memory
TEST CPU Test the inactive Core/Net
TEST CNI c s Test each inactive CNI card
b. Switch Cores and test the other side (Core/Net 0)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCPU</td>
<td>Switch cores</td>
</tr>
<tr>
<td>TEST CPU</td>
<td>Test the inactive Core/Net</td>
</tr>
<tr>
<td>TEST CNI c s</td>
<td>Test each inactive CNI card</td>
</tr>
</tbody>
</table>

*Note:* Testing the CP and CNI cards and synchronizing memory can take up to 20 minutes for each test. When the CP test is complete, the CP memory is automatically synchronized.

c. Clear the display and minor alarms on both Cores.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDSP</td>
<td>Clear the displays on the Cores</td>
</tr>
<tr>
<td>CMAJ</td>
<td>Clear major alarms</td>
</tr>
<tr>
<td>CMIN ALL</td>
<td>Clear minor alarms</td>
</tr>
</tbody>
</table>

d. Get the status of the Cores, CNIs, and memory.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STAT CPU</td>
<td>Get the status of both Cores</td>
</tr>
<tr>
<td>STAT CNI</td>
<td>Get the status of all configured CNIs and memory</td>
</tr>
</tbody>
</table>

*Note:* You may need to execute the STAT CNI command twice before receiving a response from the system.

```
**** exit program
```

21 Synchronize the hard disks.
a. Load LD 137 and synchronize the hard disks. Synchronization may take up to 50 minutes. To be sure that the contents of IODU/C 1 hard disk are copied to IODU/C 0 hard disk, verify that IODU/C 0 is disabled.

**LD 137**
- `STAT` Get the status of the IODU/C and redundancy
- `SYNC` Enter "Yes" to synchronize disks. Wait until the memory synchronization successfully completes before continuing
- `TEST CMDU` Performs hard and floppy disk test.

b. Get the status of the CMDU’s and be sure CMDU 0 is active. Switch if necessary.

**LD 143**
- `STAT` Get the status of the IODU/C and redundancy
- `SWAP` Switch CMDU if necessary
- `STAT CMDU` Get the status of the IODU/Cs. Be sure the same IODU/C and CPU are active.

**** exit program

22 Perform a data dump in LD 43.

**Feature and ISM parameter upgrade enter manually**

Before beginning this procedure, you must have a copy of the keycode. The keycode can reside on paper or as an electronic file. To enter the keycode manually, you will type the keycode in LD 143 as 21 lines, 16 characters per line.

1 Log into the system.

2 Load the Keycode Management Program (LD 143).

**LD 143** to load program

**KMAN** manually enter the keycode to the target system
3 Type keycode file, 21 lines of 16 characters each. Press return to go to the next line.

   Note: When entering the keycode, do not enter the header information that proceeds the keycode.

4 Type "end" at line 22 to end the process.

5 Press enter. The new keycode file will be saved on the hard disk.

Enter the following command:

   KDIF REC HD   to compare the existing keycode with the new keycode on the hard disk

Ensure that the new keycode does not lower ISM limits or reduce features compared with the existing keycode. If you have determined that the keycode lowers ISM limits or reduces features, do not continue with the KNEW command, but contact your Nortel Networks order management representative.

6 Select the new keycode for activation using the KNEW command.

   KNEW HD

The uploaded keycode is validated against the security device.

If the following system message is given:

   CCBR020 New Keycode accepted and activated successfully.
   Sysload is NOT needed!

This implies that the new keycode is eligible for instant activation and no further user action is required, proceed to step 7 and 8.

Otherwise, if the keycode is not eligible for instant activation, a Sysload is needed to activate the new keycode and the following system message is given:

   CCBR009 New Keycode accepted. New ISM limits and feature packages will be activated during the next sysload (Cold Restart).

Skip to step 9.
7 Load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REQ SLT
....

If ISM limits are correct then the keycode installation is complete.

See "Reverting to the previous keycode with the KRVR command" on page...(NTP group to fill in) if ISM limits are not increased or problems exist.

8 Once you have confirmed that the keycode changes taken affect as expected, perform a data dump in LD 43.

9 Do these steps for keycodes that are not eligible for Instant ISM.

Place the system in split mode. This puts a redundant (shadowed) system into single (non-shadowed) mode.

a. Be sure CP 0 is active and CP1 is standby. You may need to switch CPs:

LD 135
STAT CPU
SCPU to switch CPUs if necessary
**** exit program

b. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.

LD 137
STAT Get the status of IODU/C
SWAP Switch IODU/Cs if necessary
**** exit program

c. In Core 0, set the CP card MAINT/NORM switch to MAINT.

d. In Core 1, disable the CNI cards by setting the ENB/DIS faceplate switches to DIS.
e. In Core/Net 1, perform the following three steps in uninterrupted sequence:
   - press and hold the MAN RST button on the CP card
   - set the MAINT/NORM switch on the CP card to MAINT
   - release the MAN RST button

A sysload will begin (cold start).

10 In the inactive core (Core 1), load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REQ SLT
....

11 Switch call processing from the active core (Core 0) to the inactive core (Core 1).

---

**CAUTION**

**Service Interruption**

Call Processing will be interrupted! Perform these next steps carefully and quickly. This is the point at which your service is interrupted. Calls in process will be interrupted, especially if Peripheral Software Download takes place. Some calls may be dropped.

---

a. In Core 0, access LD 137 to software disable the IODU/C card.

>LD 137
.DIS CMDU 0

b. In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to DIS.

c. In Core 0, disable the CNI cards by setting the ENB/DIS faceplate switches to DIS. Call Processing will be interrupted.

d. In Core 1, enable the CNI cards by setting the ENB/DIS faceplate to ENB.

e. In Core 1, press the MAN INT button. Call processing will be switched from Core 0 to Core 1 when the warm restart is completed.
The previously inactive core (Core 1) with the new keycode now becomes active.

12 In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to ENB.

13 In order to activate the new keycode on the new inactive core, a sysload (Cold Restart) is required.
Press the MAN RST button on Core/Net 0.

14 In Core 0, load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REQ SLT
....

15 Return the system to redundant mode, synchronizing the memory and hard drive of the inactive core with the active core.

a. Enable the CNI cards by setting the ENB/DIS faceplate switch to ENB in Core/Net 0.

b. Perform the following in uninterrupted sequence:
   - Press and release the MAN RST button in Core/Net 0.
   - When SYS700 messages appears on LCD display on Core/Net 0, set the MAINT/NORM switch to NORM in Core/Net 0.

In 60 seconds, the LCD will display and confirm your processes with:

RUNNING ROM OS
ENTERING CP VOTE

An HWI534 message indicates the start of memory synchronization. In 10 minutes, an HWI533 message on Core/Net 1 CSP1 or SDI terminal indicates the memory synchronization is complete.

15c. In Core/Net 1, set the MAINT/NORM switch on the CP card to NORM.

16 Test Core/Net 1 and Core/Net 0
a. Perform a redundancy sanity test using the following sequence:

LD 135
STAT CNI Get status of CNI cards
STAT CPU Get status of CPU and memory
TEST CPU Test the inactive Core/Net
TEST CNI c s Test each inactive CNI card

b. Switch Cores and test the other side (Core/Net 0)

SCPU Switch cores
TEST CPU Test the inactive Core/Net
TEST CNI c s Test each inactive CNI card

Note: Testing the CP and CNI cards and synchronizing memory can take up to 20 minutes for each test. When the CP test is complete, the CP the memory is automatically synchronized.

c. Clear the display and minor alarms on both Cores.

CDSP Clear the displays on the Cores
CMAJ Clear major alarms
CMIN ALL Clear minor alarms

d. Get the status of the Cores, CNIs, and memory.

STAT CPU Get the status of both Cores
STAT CNI Get the status of all configured CNIs and memory

Note: Note: You may need to execute the STAT CNI command twice before receiving a response from the system.

**** exit program

17 Synchronize the hard disks.
a. Load LD 137 and synchronize the hard disks. Synchronization may take up to 50 minutes. To be sure that the contents of IODU/C 1 hard disk are copied to IODU/C 0 hard disk, verify that IODU/C 0 is disabled.

**LD 137**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STAT</td>
<td>Get the status of the IODU/C and redundancy</td>
</tr>
<tr>
<td>SYNC</td>
<td>Enter &quot;Yes&quot; to synchronize disks. Wait until the memory synchronization successfully completes before continuing</td>
</tr>
<tr>
<td>TEST CMDU</td>
<td>Performs hard and floppy disk test.</td>
</tr>
</tbody>
</table>

b. Get the status of the CMDU’s and be sure CMDU 0 is active. Switch if necessary.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STAT</td>
<td>Get the status of the IODU/C and redundancy</td>
</tr>
<tr>
<td>SWAP</td>
<td>Switch CMDU if necessary</td>
</tr>
<tr>
<td>STAT CMDU</td>
<td>Get the status of the IODU/Cs. Be sure the same IODU/C and CPU are active.</td>
</tr>
</tbody>
</table>

18 Perform a data dump in LD 43.

**Reverting to the previous keycode with the KRVR command**

*Note:* The terms “old” and “new” keycode as discussed here refer to the most recent previous KNEW command. The “old” keycode is the former keycode, prior to the KNEW command. The “new” keycode is the keycode that was activated by the KNEW command.
To revert to the old keycode:

- In overlay 143, enter the **KRVR** command.

The old keycode is eligible for instant activation with the KRVR command if the only difference between the old keycode and the new keycode is that some or all of the ISM parameters in the old keycode are higher.

If the keycode is eligible for instant activation, it will be activated without further user action, and the following system message is given:

**CCBR020 New Keycode accepted and activated successfully. Sysload is NOT needed!**

Otherwise, if the keycode is not eligible for instant activation, a Sysload is needed to activate the new keycode and the following system message is given:

**CCBR009 New Keycode accepted. New ISM limits and feature packages will be activated during the next sysload (Cold Restart).**

Follow below procedures to sysload the system if the keycodes are not eligible for Instant ISM and CCR009 message is displayed:

1. Place the system in split mode. This puts a redundant (shadowed) system into single (non-shadowed) mode.
   a. Be sure CP 0 is active and CP1 is standby. You may need to switch CPs:

   ```
   LD 135
   STAT CPU
   SCPU to switch CPUs if necessary
   **** exit program
   ```
   
   b. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.

   ```
   LD 137
   STAT Get the status of IODU/C
   SWAP Switch IODU/Cs if necessary
   **** exit program
   ```
c. In Core 0, set the CP card MAINT/NORM switch to MAINT.

d. In Core 1, disable the CNI cards by setting the ENB/DIS faceplate switches to DIS.

e. In Core/Net 1, perform the following three steps in uninterrupted sequence:
   - press and hold the MAN RST button on the CP card
   - set the MAINT/NORM switch on the CP card to MAINT
   - release the MAN RST button A sysload will begin (cold start).

2 In the inactive core (Core 1), load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REQ SLT
....

3 Switch call processing from the active core (Core 0) to the inactive core (Core 1).

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Interruption</td>
</tr>
</tbody>
</table>

Call Processing will be interrupted! Perform these next steps carefully and quickly. This is the point at which your service is interrupted. Calls in process will be interrupted, especially if Peripheral Software Download takes place. Some calls may be dropped.

a. In Core 0, access LD 137 to software disable the IODU/C card.

>LD 137
.DIS CMDU 0

b. In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to DIS.

c. In Core 0, disable the CNI cards by setting the ENB/DIS faceplate switches to DIS. Call Processing will be interrupted.

d. In Core 1, enable the CNI cards by setting the ENB/DIS faceplate to ENB.
e. In Core 1, press the MAN INT button. Call processing will be switched from Core 0 to Core 1 when the warm restart is completed.

The previously inactive core (Core 1) with the new keycode now becomes active.

4. In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to ENB.

5. In order to activate the new keycode on the new inactive core, a syscall (Cold Restart) is required.

6. Press the MAN RST button on Core/Net 0.

7. In Core 0, load Overlay 22 and confirm that the new ISM parameters have been updated.

   >LD 22
   REQ SLT
   ....

8. Return the system to redundant mode, synchronizing the memory and hard drive of the inactive core with the active core.
   a. Enable the CNI cards by setting the ENB/DIS faceplate switch to ENB in Core/Net 0.
   b. Perform the following in uninterrupted sequence:
      • Press and release the MAN RST button in Core/Net 0.
      • When SYS700 messages appears on LCD display on Core/Net 0, set the MAINT/NORM switch to NORM in Core/Net 0.

   In 60 seconds, the LCD will display and confirm your processes with:

   RUNNING ROM OS
   ENTERING CP VOTE

   An HWI534 message indicates the start of memory synchronization. In 10 minutes, an HWI533 message on Core/Net 1 CSPI or SDI terminal indicates the memory synchronization is complete.

   c. In Core/Net 1, set the MAINT/NORM switch on the CP card to NORM.

9. Test Core/Net 1 and Core/Net 0
a. Perform a redundancy sanity test using the following sequence:

LD 135
STAT CNI Get status of CNI cards
STAT CPU Get status of CPU and memory
TEST CPU Test the inactive Core/Net
TEST CNI c s Test each inactive CNI card

b. Switch Cores and test the other side (Core/Net 0)

SCPU Switch cores
TEST CPU Test the inactive Core/Net
TEST CNI c s Test each inactive CNI card

Note: Testing the CP and CNI cards and synchronizing memory can take up to 20 minutes for each test. When the CP test is complete, the CP memory is automatically synchronized.

c. Clear the display and minor alarms on both Cores.

CDSP Clear the displays on the Cores
CMAJ Clear major alarms
CMIN ALL Clear minor alarms

d. Get the status of the Cores, CNIs, and memory.

STAT CPU Get the status of both Cores
STAT CNI Get the status of all configured CNIs and memory

Note: You may need to execute the STAT CNI command twice before receiving a response from the system.

**** exit program
10 Synchronize the hard disks.
a. Load LD 137 and synchronize the hard disks. Synchronization may take up to 50 minutes. To be sure that the contents of IODU/C 1 hard disk are copied to IODU/C 0 hard disk, verify that IODU/C 0 is disabled.

LD 137
STAT Get the status of the IODU/C and redundancy
SYNC Enter "Yes" to synchronize disks. Wait until the memory synchronization successfully completes before continuing
TEST CMDU Performs hard and floppy disk test.

b. Get the status of the CMDU's and be sure CMDU 0 is active. Switch if necessary.

STAT Get the status of the IODU/C and redundancy
SWAP Switch CMDU if necessary
STAT CMDU Get the status of the IODU/Cs. Be sure the same IODU/C and CPU are active.
**** exit program
# IODU/C Software Installation Tool

## Contents

The following are the topics in this section:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Summary Charts</td>
<td>84</td>
</tr>
<tr>
<td>Messages</td>
<td>86</td>
</tr>
<tr>
<td>Introductory Screen</td>
<td>87</td>
</tr>
<tr>
<td>Install Menu</td>
<td>89</td>
</tr>
<tr>
<td>Installing Software, CP-BOOTROM, and IOP-ROM</td>
<td>91</td>
</tr>
<tr>
<td>Installing Software, Database, CP-BOOT ROM, and IOP-ROM</td>
<td>91</td>
</tr>
<tr>
<td>Installing Software only</td>
<td>91</td>
</tr>
<tr>
<td>Installing Database only</td>
<td>92</td>
</tr>
<tr>
<td>Installing CP-BOOT ROM</td>
<td>93</td>
</tr>
<tr>
<td>Installing CP-ROM</td>
<td>93</td>
</tr>
<tr>
<td>Installing IOP-ROM</td>
<td>94</td>
</tr>
<tr>
<td>Reinstalling CP-Software</td>
<td>95</td>
</tr>
<tr>
<td>To copy system software from the other Core</td>
<td>95</td>
</tr>
<tr>
<td>To go to the Tools Menu</td>
<td>95</td>
</tr>
<tr>
<td>To Install Keycode only</td>
<td>95</td>
</tr>
<tr>
<td>To quit</td>
<td>95</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>97</td>
</tr>
<tr>
<td>Setting the system date and time</td>
<td>100</td>
</tr>
<tr>
<td>Partitioning the hard disk</td>
<td>101</td>
</tr>
<tr>
<td>Displaying the hard disk partition size</td>
<td>101</td>
</tr>
<tr>
<td>Regenerate the PDT password</td>
<td>101</td>
</tr>
<tr>
<td>To print the CD-ROM content</td>
<td>101</td>
</tr>
<tr>
<td>To print the Keycode content</td>
<td>103</td>
</tr>
<tr>
<td>To print the Security Device content</td>
<td>104</td>
</tr>
</tbody>
</table>
To check the customer-specific part of the CD-ROM. .......... 104
To manually create a Keycode diskette. ...................... 104
To install Keycode only. ................................ 104
To archive the existing database. .......................... 105
To check MDU connection. ................................ 105
To return to the Main Menu. ................................. 105

Reference list

The following are the references in this section:

- "Software Conversion Procedures" (553-2001-320)
- "Administration" (553-3001-311)
- "Hardware Replacement" (553-3001-520)

This chapter details the screen displays and options of the CD-ROM Software Installation Tool (hereafter referred to as “Software Installation Tool”) that is compatible on Options 51C, 61C, 81, and 81C systems equipped with the NT5D61 Input/Output Disk Unit with CD-ROM (IODU/C).

This tool is based on the existing Software Installation Tool, but has notable differences in menus as well as new functionality to support installation of software from CD-ROM, copying of system software from Core to Core, copying of database from Core to Core, and Keycode installation.

The IODU/C card no longer uses a Security Cartridge, but instead uses both a Security Device and an electronic keycode file. This keycode file is stored on a 2MB diskette and must be inserted into the IODU/C floppy drive and authenticated each time the Software Installation Tool is loaded and the Install Menu is accessed.

On systems equipped with an IODU/C, the database is stored on 2MB diskettes, not 4MB diskettes. A Database Transfer Utility diskette, specific to Call Processor type, is available to convert a 4MB database to a 2MB database. Refer to "Software Conversion Procedures" (553-2001-320) and "Hardware Replacement" (553-3001-520) for procedures on upgrading from systems equipped with IOP and CMDU or IOP/CMDU cards to IODU/C.
The Tools Menu has new options for finding the CD-ROM status (option <g>), printing the Keycode (option <h>), printing information about the Security Device (option <i>), checking the customer-specific CD-ROM data (<j>), manually creating a Keycode diskette (<k>), and archiving the database (<s>).

Do not turn off the system during the installation process. If you need to quit the installation process, do so from within the Software Installation Tool before powering off the system.

Read the entire procedure before attempting to perform an installation.

Before the Software Installation Tool is activated, verify that the system is in split mode (not applicable for Option 51C) and that a terminal is connected to CPSI port J25 on the I/O panel (in the inactive Core for dual CPU systems). Option 51C systems will be taken out of service.

To activate the Software Installation Tool, insert the Install diskette specific to your Call Processor type and the CD-ROM containing system software (if you will be installing that component). Press the MAN RST button on the CP card in the same Core.

The IODU/C Software Installation Tool requires the following items:

- 2MB diskettes (used to store, backup, and restore the database)
- an Install diskette specific to the system’s Call Processor card
- a Keycode diskette
- a CD-ROM containing system software
Note: If you will be installing system software from CD-ROM (options a, b, or c from the Install Menu), then insert the CD into the CD-ROM drive before loading the Software Installation Tool.

CAUTION
Loss of Data

The screens shown in this procedure are examples. They are not intended to exactly represent the displays that will appear for your system, nor do the choices entered represent those you should necessarily choose. Be sure to watch the terminal display, and follow the on-screen instructions.

Pay close attention to the menus when they appear; they display the options available at any given stage.

Status Summary Charts

Status Summary Charts are displayed for the purpose of informing the user about what items will be installed or have been installed. This example is shown when option b (all components) is chosen from the Install Menu.
**Note:** Your screen may differ from this example.

### INSTALLATION STATUS SUMMARY

<table>
<thead>
<tr>
<th>Option</th>
<th>Choice</th>
<th>Status</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW: CD to disk</td>
<td>yes</td>
<td></td>
<td>from xxxx to xxxx</td>
</tr>
<tr>
<td>SW: disk to ROM</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Database</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CP-BOOTROM</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IOP-ROM</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Please enter:

<CR> - Yes, start Installation.
<y> - Yes, start Installation. Return to the Main Menu.
<n> - No, stop Installation. Return to the Main Menu.

Enter Choice> **y**

The possible values and meanings for each column are defined below.

---

**Choice**

- **yes** indicates the item will be installed
- **no** indicates the item was not selected, and will not be updated.

---

**Status**

- **quit** indicates the quit option was used, and the process was exited.
- **ok** indicates the choice was installed successfully.
- **error** indicates the installation was not successful. A system message is given when the Software Installation Tool encounters a problem. Follow the actions required by the message.
ignore applies to the CP ROM and IOP-ROM upgrade only. This appears when the process was exited when asked to replace a release and issue with the same release and issue.

- blank indicates the status is not yet determined if Choice = Yes. If Choice = No, the field remains blank.

- Comment

- from rel <number> to rel <number> gives the Source and Target release and issue numbers.

Messages

When the Software Installation Tool encounters a problem, a system message appears on the terminal display. These messages fall into two categories: warning and non-warning.

Warning messages are not critical errors. The Software Installation Tool proceeds with the installation following the appearance of this message. Refer to Administration (553-3001-311) for details regarding these messages.

Non-warning messages appear when a critical problem is encountered. The Software Installation Tool stops the process, and an action is recommended. When the action is complete, the Software Installation Tool can be restarted. In some cases, the tool allows you to restart by pressing the carriage return <CR>.
Introduction Screen

The first screen that appears after loading the NT5D61 Software Installation Tool is the Nortel Networks Logo Screen shown below.

---

Copyright 1992 - 1997 Nortel, Inc.

Please press <CR> when ready . . .
The Main menu screen is displayed after the user presses <CR> from the NT Logo Screen. From this screen, the user may select option <u> to go to the Install Menu, or <t> to go to the Tools Menu. Alternately, option <q> to quit is available at this screen.

Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)

M A I N   M E N U

The Software Installation Tool will install or upgrade Meridian-1 System Software, Database and the PE-ROM (both CP and IOP ROM). You will be prompted throughout the installation and given the opportunity to quit at any time.

Please enter:
<CR>---> <u> - To Install menu.
<t> - To Tools menu.
<q> - Quit.

Enter choice > u
Install Menu

*Note:* A Keycode diskette is required before accessing the Install Menu.

Before the Install Menu screen is displayed, two intermediary screens shown below prompts the user to insert their Keycode diskette for validation against the Security Device.

```
Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

Please insert the diskette with the keycode file into the floppy drive.

Please enter:
<CR>---> <a> - Continue with the keycode validation
     (the keycode diskette is in the floppy drive).
<q> - Quit.

Enter Choice > a
```

```
Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

Please confirm that this keycode matches the CDROM Release

Please enter:
<CR>---> <y> - Yes, the keycode matches. Go on to Install Menu.
<n> - No, the keycode does not match. Try another keycode diskette.

Enter Choice > y
```
Following successful Keycode validation, the Install Menu screen is displayed, as shown below.

**Note:** If the Software Installation Tool is loaded on a Core equipped with an NT5D61BA IODU/C (which lacks a CD-ROM drive), options <a>, <b>, and <c> will not appear.

```
Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)

INSTALL MENU
The Software Installation Tool will install or upgrade Meridian-1 System Software, Database and the PE-ROM (both CP and IOP ROM). You will be prompted throughout the installation and given the opportunity to quit at any time.

Please enter:

<CR>--->

<a> - To install Software, CP-BOOTROM, IOP-ROM.
<b> - To install Software, Database, CP-BOOTROM, IOP-ROM.
<cc> - To install Software only.
<cd> - To install Database only.
<ce> - To install CP-BOOTROM only.
<cf> - To install IOP-ROM only.
<cg> - To reinstall CP-Software.
<co> - To copy System Software from the other Core.
<ct> - To go to the Tools menu.
<ck> - To install Keycode only.
   For Feature Expansion, use OVL143.
<cq> - Quit.

Enter Choice >
```

Each option from the Install Menu is described in the following pages.
Installing Software, CP-BOOTROM, and IOP-ROM

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is selected for the sequential installation of software, CP-BOOTROM, and IOP-ROM. This option differs from option <b> in that the database is not installed. Use option <a> when going to a later software release or for a software update.

Installing Software, Database, CP-BOOT ROM, and IOP-ROM

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is selected when you wish to sequentially install all components - software, database, CP-BOOTROM, and IOP-ROM.

Option <b> is used during the upgrade procedures from NT5D20 IOP/CMDU, NT6D63 IOP and NT6D64 CMDU, NT9D33 SMDU, NTND16 FDU, NT8D69 MDU, and NTND16 MDU cards to NT5D61 IODU/C cards.

Installing Software only

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is selected when you wish to install system software from the CD-ROM to the hard drive. When selecting option <c>, IOP-ROM and CP-BOOTROM are not installed.
Installing Database only

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

The Database Menu of the Software Installation Tool is accessed by the <d> option on the Install Menu. The following options are available for installing a database:

- Option <a> is to install the backup customer database from one or more 2MB diskettes.
- Option <b> allows installation from the CD-ROM containing the default database. This option is used on new systems which have no existing database.
- Option <d> copies the existing database from the redundant Core. This option is used when the database has already been installed on one Core. This option is used when upgrading from IOP/CMDU to IODU/C cards.
Option <e> displays the version and issue of the current database residing on the Core. If database files are missing, error messages will be printed.

**CAUTION**

**Loss of Data**

Before upgrading the system database, be sure a backup of the previous (source) database is on hand. Should any problems arise, it may be necessary to return to the previous database.

### Installing CP-BOOT ROM

**Note:** Installation of CP-BOOTROM is available on systems with NT9D19, NT5D10, and NT5D03 Call Processor cards only. For systems with the NT6D66 Call Processor card, CP-ROM is installed instead of CP-BOOTROM. See page 93 for installing CP-ROM on a system equipped with an NT6D66.

**Note:** For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option <e> is for installing new CP-BOOTROM. This option is used to install CP-BOOTROM while on Core 0 in a software upgrade, when software has already been installed using options <a> or <b> on Core 1, and software has already been copied onto Core 0 using option <o>.

The next screen displayed after selecting option <e> will show the version of CP-BOOTROM being replaced and version being installed, and the card slot where the CP-BOOTROM is being installed. The user is prompted to select <a> to continue with the CP-BOOTROM upgrade.

### Installing CP-ROM

**Note:** Installation of CP-ROM is available on systems with NT6D66 Call Processor cards only. For systems with the NT9D19, NT5D10, or NT5D03 Call Processor cards, CP-BOOTROM is installed instead of CP-BOOTROM. See page 93 for installing CP-ROM on a system equipped with an NT6D66.
**Note:** For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option \(<e>\) is for installing new CP-ROM. This option is used to install CP-ROM while on Core 0 in a software upgrade, when software has already been installed using options \(<a>\) or \(<b>\) on Core 1, and software has already been copied onto Core 0 using option \(<o>\).

The next screen displayed after selecting option \(<e>\) will prompt the user to choose whether to install the CP-ROM from the hard disk (option \(<a>\)), or from CD-ROM (option \(<b>\)). If software has just been installed successfully, then option \(<a>\) should be used. However, if software was not installed, select option \(<b>\) to install from CD-ROM.

**Installing IOP-ROM**

**Note:** For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option \(<f>\) is for installing new IOP-ROM. This option is used to install IOP-ROM while on Core 0 in a software upgrade, when software has already been installed using options \(<a>\) or \(<b>\) on Core 1, and software has already been copied onto Core 0 using option \(<o>\), and CP-BOOTROM has been installed using option \(<e>\).

The next screen displayed after selecting option \(<f>\) will prompt the user to choose whether to install the IOP-ROM from the hard disk (option \(<a>\)), or from CD-ROM (option \(<b>\)). If software has just been installed successfully, then option \(<a>\) should be used. However, if software was not installed, select option \(<b>\) to install from CD-ROM.

The next screen displayed after selecting option \(<f>\) will show the version of IOP-ROM being replaced and version being installed, and the card slot where the IOP-ROM is being installed. The user is prompted to select \(<a>\) to continue with the IOP-ROM upgrade.
Reinstalling CP-Software

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is used if a flash programming error occurs during software installation through options <a>, <b>, or <c>. Option <g>, which assumes that software files have already been installed on the hard disk, copies these files from the hard disk to the Flash EEPROM.

To copy system software from the other Core

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option <o> is used during a software upgrade when software has already been installed on Core 1, and the Software Installation Tool has been loaded on Core 0.

Note: This option does not perform the installation of CP-BOOTROM (option <e>) or IOP-ROM (option <f>).

To go to the Tools Menu

Option <t> displays the Tools Menu and its options, which are described beginning on page 97.

To Install Keycode only

Option <k> is used when you wish to replace an existing Keycode.

To quit

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Throughout the installation process, the option to quit is always available. Quitting with the Software Installation Tool quit commands is preferable to pressing the MAN RST button on the CP card, since quitting from the tool will erase unneeded temporary files.
When you are done using the NT5D61 Software Install Tool remove the diskette from the IODU/C and select option <q> to quit from the Installation menu. The terminal displays a confirmation to quit. Pressing <y> confirms the quit.

The final screen displayed before quitting reminds the user that the Install diskette should be removed from the IODU/C floppy drive before pressing <a> to reboot the system.

You selected to Quit. Please confirm.

Please enter:

- <y> - Yes, Quit.
- <n> - No, DO NOT Quit.

Enter choice > y

The final screen displayed before quitting reminds the user that the Install diskette should be removed from the IODU/C floppy drive before pressing <a> to reboot the system.

You have selected to Quit the Software Installation Tool
You may reboot the system or return to the Main Menu.
Before rebooting the system, remove Install diskette from the floppy drive.

DO NOT REBOOT USING BUTTON!!

Please enter:

- <a> - Reboot the system.
- <m> - Return to the Main menu.

Enter Choice > a
Tools Menu

To load the Software Installation Tool which contains the Tools Menu, insert the Install diskette which is compatible with your Call Processor card. Press the MAN RST button on the CP card to load the tool.

The first screen that appears after loading the NT5D61 Software Installation Tool is the Nortel Networks Logo Screen shown below.
This screen is displayed after the user presses <CR> from the Nortel Networks Logo Screen. From this screen, selecting option <t> brings the user to the Tools Menu.

Note: Insertion of the Keycode diskette is not required for accessing the Tools Menu.
The Tools Menu has new options for finding the CD-ROM status (option `<g>`), printing the Keycode (option `<h>`), printing information about the Security Device (option `<i>`), checking the customer-specific CD-ROM data ( `<j>`), manually creating a Keycode diskette ( `<k>`), and archiving the database ( `<s>`).

The Tools Menu is displayed below.

<table>
<thead>
<tr>
<th>Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TOOLS MENU</strong></td>
</tr>
<tr>
<td>This is the Tools Menu for Install. You can select the tool that</td>
</tr>
<tr>
<td>is appropriate. Please select one of the options below.</td>
</tr>
</tbody>
</table>

Please enter:

- `<a>` - To set the system date and time.
- `<b>` - To partition the hard disk.
- `<c>` - To display the partition size of hard disk.
- `<d>` - To regenerate PDT Password.
- `<g>` - To print CDROM content.
- `<h>` - To print Keycode content.
- `<i>` - To print Security Device content.
- `<j>` - To Check the customer specific part of CDROM.
- `<k>` - To manually create Keycode floppy diskette.
- `<r>` - To install Keycode only.
- `<s>` - To archive existing database.
- `<z>` - To check MDU connection.
- `<m>` - To return to the Main Menu

Enter choice >

Each option from the Tools Menu is described in the following pages.
Setting the system date and time

This option is used to change the system date and time for the system’s internal clock. The correct date and time will ensure that files are time-stamped accurately.

You have selected the option to set the system date and time. This will change the internal clock of your system to a new date and time.

The system date and time are also used by Install to time-stamp the new files created.

Pressing the carriage return at the prompt below will leave the system date or time unchanged.

Please enter the new date or time.

Current date is: Tuesday 04-29-1997
Enter new date (dd mm yyyy) ? 30 4 1997
Date is set to: Wednesday 04-30-1997

Current time is: 15:52:00
Enter new time (hh mm ss) ? 15 05 45
Time is set to: 15 05 45

System Date and Time now is: Wednesday 04-30-1997, 15:05:46
Partitioning the hard disk

Note: Option <b> requires a password, and should only be performed by Nortel Networks support personnel.

CAUTION
Loss of Data
Partitioning a disk erases all files from it.

Displaying the hard disk partition size

Option <c> displays the partition sizes of the hard disk. The manufacturer and model number of the hard disk are also displayed.

<table>
<thead>
<tr>
<th>IODU 0</th>
<th>Hard Disk from: MAXTOR:7120SCS, Size:124MB, Sectors:248502</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Unprotected Part Size:30MB, Sectors: 60000</td>
</tr>
<tr>
<td></td>
<td>Spare Part Size:30MB, Sectors: 60000</td>
</tr>
<tr>
<td></td>
<td>CardId Part Size:1MB, Sectors: 2000</td>
</tr>
<tr>
<td></td>
<td>Protected Part Size:60MB, Sectors: 120000</td>
</tr>
</tbody>
</table>

Regenerate the PDT password

Note: Option <d> requires a password, and should only be performed by Nortel Networks support personnel.

To print the CD-ROM content

Option <g> is used to find whether a CD-ROM exists on each IODU/C, and whether its sectors are readable. After selecting <g>, three options are available:

- Fast readability test, which takes about 17 seconds for each CD-ROM and reads 1/30th of the CD-ROM sectors.
- Extensive readability test, which takes about 3 minutes for each CD-ROM and reads 1/4th of the CD-ROM sectors.
- Total readability test, which takes about 6 minutes for each CD-ROM and reads all sectors of the CD-ROMs.
Note: The failure of a CD-ROM drive to read a known good CD-ROM may indicate a problem with the CD-ROM drive.
To print the Keycode content

Option \texttt{<h>} is used when you wish to display the information contained in the current Keycode. The information displayed includes machine type, software version, ISM limits, and which feature packages are enabled.

<table>
<thead>
<tr>
<th>System Serial Number</th>
<th>Software Version</th>
<th>System Type</th>
<th>Call Processor</th>
<th>Release</th>
<th>Issue</th>
<th>NTI Order Number</th>
<th>NT SDID - 1</th>
<th>NT SDID - 2</th>
<th>Date and Time of Manufacture</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>46379</td>
<td>Option 61C</td>
<td>CP68030</td>
<td>23</td>
<td>30G</td>
<td>000000000000</td>
<td>00000000</td>
<td>00000000</td>
<td>06/03/1998 - 14:53:38</td>
</tr>
</tbody>
</table>

Note: ( ) indicates that information is not available

ISM Limits:
- Loop Limit : 32
- Sys TNs Limit : 32767
- ACD Agt Limit : 32767
- ACD DNs Limit : 24000
- AST Limit : 32767
- DSL Limit : 100
- LTID Limit : 100
- DCH Limit : 64
- AML Limit : 16
- MPH DSL Limit : 100
- RAN CON Limit : 32767
- RAN RTE Limit : 512
- MUS CON Limit : 1000
- Brand Index : 1

Options Packages:
- 0-2 4-5 7-25 28-29 232-55 57-65
- 67 70-77 79-81 84 86 88-93
- 95 98-105 107-109 111 113-121 125
- 127 129 132-134 136 139-140 145-151
- 153 155 157-160 162 164 170 172-175
- 178-181 186 191-192 196 202-212 214-216
- 218-219 222-225 227-229 231 233 235 240
- 242-243 245-248 250-251 253-256 258-259 262-263
- 286 290-293 296-297 301-303 305-310 313-316
- 321 323-324 327-335

553-7745
To print the Security Device content

Option <i> shows specific information about the Security Device, such as Serial Number. This enables the user to find information about the Security Device without removing the NT5D61 IODU/C card.

<table>
<thead>
<tr>
<th>Engineering Code (Side x)</th>
<th>NT5D61Aa</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Serial Number</td>
<td>06NNTM1831RRC3 IOP</td>
</tr>
<tr>
<td>NT SDID</td>
<td>20000080</td>
</tr>
<tr>
<td>Security Device Type</td>
<td>NT_TCH</td>
</tr>
<tr>
<td>System Serial Number</td>
<td>46379</td>
</tr>
</tbody>
</table>

To check the customer-specific part of the CD-ROM

Option <j> is used to check the readability of the Keycode-specified system software on the CD-ROM drive. Once all files have been checked successfully, the message “Checking directory /cdx/xxxx_DMR.Nxx ended successfully” is displayed to indicate completion.

To manually create a Keycode diskette

Option <k> is used to manually type in a keycode and save it to a 2MB diskette. Upon selecting this option, you may enter the characters into 21 Keycode entry lines of 16 characters each, which will compose the Keycode file to be saved on a 2MB diskette in the floppy drive.

Characters may be entered on the Keycode entry lines in one of two ways:

- manually entering each 16-character line followed by a <CR> or
- “pasting” each individual 16-character line, then pressing <CR>

(available on a PC running Windows 95 ©, using the Copy command (Control-C) to copy a line of characters from a keycode file, positioning the cursor on the current Keycode entry line, and using the Paste command (Control-V) to paste the line).

If a line is entered which does not have 16 characters, a message will be displayed informing the user to reenter the line correctly.

To install Keycode only

Option <r> is used when you wish to replace an existing Keycode.
To archive the existing database

Option <s> is one of the methods (the ABKO and BKO commands from overlay 143 are other methods) that is available to backup the customer database to 2MB diskettes. The size of the backup files and the estimated number of 2MB diskettes required to store the database will be displayed.

To check MDU connection

Option <z> tests the connection between a connected MDU and IODU/C.

To return to the Main Menu

Option <m> is selected to return the user from the Tools Menu to the Main Menu, where the user may select to quit (<q>) or go to the Install Menu (<u>).
cPCI® MMDU software conversion

Contents

The following are the topics in this section:

- Perform a parallel reload. .............................................. 108
- Back up current data. .................................................. 108
- Check the status of the hardware. ............................... 109
- Check that Core 0 is active. ........................................ 109
- Split the Cores. ....................................................... 109
- Install the software on Core/Net 1. ............................ 109
- Transfer call processing from Core/Net 0 to Core/Net 1. .... 114
- Test Core/Net 1. ...................................................... 115
- Install software on Core/Net 0. ................................. 115
- Enable system redundancy. ....................................... 121
- Test Core/Net 1 and Core/Net 0. ............................... 121
- Perform a data dump. .............................................. 122
- Back out of a system software upgrade. ......................... 123
- Split the Cores. ....................................................... 123
- Install the software on Core/Net 1. ............................ 123
- Transfer call processing from Core/Net 0 to Core/Net 1. .... 128
- Test Core/Net 1. ...................................................... 128
- Install software on Core/Net 0. ................................. 129
- Enable system redundancy. ....................................... 135
- Test Core/Net 1 and Core/Net 0. ............................... 135
- Perform a data dump. .............................................. 136
The NT4N43AA cPCI Multi-Media Disk Unit (cPCI MMDU) is located in the extreme right hand slot next to the CP PII card. The cPCI MMDU contains the Hard drive, floppy drive and CD-ROM drive.

**Perform a parallel reload**

You must install software on both Core hard drives. Follow the tasks below in order to complete the installation.

*Note:* To complete these procedures, the system must be working and connected to a terminal.

**Back up current data**

1. Load the Equipment Data Dump Program (LD 43). At the prompt, enter LD 43 Load the program.
2. When “EDD000” appears on the terminal, enter EDD Begin the data dump.
3. When “DATABASE BACKUP COMPLETE” or “DATADUMP COMPLETE” appears on the terminal, enter

   **CAUTION**
   
   **Loss of Data**

   If the data dump is not successful, do not continue; contact your technical support organization. Correct any data dump problem before you continue.

   **** Exit the program.
Check the status of the hardware

1. Load LD 137 to check the status of the hard disks.
   
   LD 137
   STAT
   Get the status of the hard disks.
   TEST CMDU
   Perform hard and floppy disk test.

2. Load LD 135 and check the status of the CPs, CNIs and memories.
   
   LD 135
   STAT CPU
   Get the status of both CPUs and memory.
   STAT CNI
   Get the status of all configured CNIs.

Check that Core 0 is active

Check that Core 0 is active.
If Core 1 is active, make Core 0 active:

LD 135
STAT CPU
Get the status of the CPUs.
SCPU
Switch to Core 0 (if necessary).

Split the Cores

From the active side, split the cores:

LD 135
SPLIT
Enter Split on the active core.
****
Exit program.

The system is now in split mode.

Install the software on Core/Net 1

1. Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:

   a. Press the button on the CD-ROM drive to open the CD-ROM disk holder.

   b. Place the CD-ROM disk into the holder with the disk label facing up. Use the four tabs to secure the CD-ROM drive.

   c. Press the button to close the CD-ROM disk holder. Do not push the holder in by hand.
Note: If the CD-ROM is not in the CD-ROM drive, the installation will not continue. Insert the CD-ROM to continue.

2 Place the CP PII Install floppy disk into the cPCI MMDU floppy drive.

Note: If a problem is detected during the system verification, Install stops, prints an error message, and aborts the installation. If the verification is not successful, do not continue; contact your technical support organization.

3 Press the RESET button on CP PII. Before the install menu runs, the system validates hard disk partitioning which takes about five minutes. The screen displays:

Testing partition 0
0 percent done...1 percent done......99 percent done....100 percent done
Testing partition 1
0 percent done...1 percent done......99 percent done....100 percent done
Testing partition 2
0 percent done...1 percent done......99 percent done....100 percent done completed!

Disk physical checking is completed!
There are 3 partitions in disk 0:
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB
Disk partitions and sectors checking is competed!

4 From the terminal, press <cr> to start the software installation.

5 When prompted, remove the CP PII Install Program diskette and insert the Keycode diskette.

<a> Continue with keycode validation.
<y> Confirm that the keycode matches the CD-ROM release.
6 When the screen displays the Install Menu, select the following options in sequence when you are prompted to do so:

- **Install software.**
- **Verify that the CD-ROM is now in drive.**

The Installation Status Summary screen appears that lists the options to be installed.

- **Start Installation.**
- **Continue with Upgrade.**

### Pre-release 3 language groups

7 Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series sets.

**Select one of the six PSDL files**

- **1** Global 10 Languages
- **2** Western Europe 10 Languages
- **3** Eastern Europe 10 Languages
- **4** North America 6 Languages
- **5** Spare Group A
- **6** North America 6 Languages (Duplicate of **4**)

The languages contained in each selection are outlined as follows:

- **1** - English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- **2** - English, French, German, Spanish, Swedish, Norwegian, Danish, Finnish, Italian, Brazilian Portuguese.
- **3** - English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- **4** - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
- **5** - English, French, German, Spanish, Swedish, Italian, Norwegian, Portuguese, Finnish, Japanese Katakana.
- **6** - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series sets.

Select one of the six PSDL files

- **<1>** Global 10 Languages
- **<2>** Western Europe 10 Languages
- **<3>** Eastern Europe 10 Languages
- **<4>** North America 6 Languages
- **<5>** Spare Group A
- **<6>** North America 6 Languages (Duplicate of <4>)

The languages contained in each selection are outlined as follows:

1. 1 – Global 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
2. 2 – Western Europe 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Danish.
3. 3 – Eastern Europe 10 Languages (Release 3) English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
4. 4 – North America six Languages (Release 3) English, French, German, Spanish, Brazilian Portuguese, Japanese Katakana.
5. 5 – Spare Group A.
6. 6 – Spare Group B.
9  Continue with ROM upgrade when prompted.
   Select a database to install.
   <cr> Enter carriage return to continue.
   <a> Continue with CP BOOTROM installation.
   <a> Install the CP BOOTROM from hard disk.
   <a> Start installation.
   <a> Continue with ROM upgrade.
   
   The system automatically performs a sysload: several messages appear on the system terminal. Wait for “DONE” and then “INI” message to display before you continue.

   The sysload is being performed, database conversion occurs. Verify that the following message appears on the system terminal:

   DATA CONVERSION
   RELEASE 25.XX TO RELEASE 25.XX

10  The system automatically performs a sysload: several messages appear on the system terminal. Wait for “DONE” and then “INI” message to display before you continue.

   While the sysload is being performed, database conversion occurs. Verify that the following message appears on the system terminal:

   DATA CONVERSION
   RELEASE 25.XX TO RELEASE 25.XX

11  Confirm that Release 25 software is installed and is working on Core/Net 1:

   LD 135    Load the program.
   STAT CPU  Display the CPU status.
   STAT CNI  Display the cCNI status.
Check for peripheral software download

Use LD 22 and print the Target peripheral software version. (You printed the Source peripheral software version during the pre-conversion procedure.)

If there is a difference between the Source and Target peripheral software version, a forced download occurs during initialization when coming out of parallel reload. System initialization will take longer and established calls on IPE will be dropped.

LD 22
REQ Print.
TYPE PSWV.
ISSP Print issue and release.
TID Print Tape ID.
SLLP Print System and patch information.
    Print auxiliary ID.
**** Exit program.

Transfer call processing from Core/Net 0 to Core/Net 1

CAUTION
Service Interruption
The following procedure to transfer call processing can cause service interruptions.
Time your procedure to minimize the effect of any breaks in service.

1 From Core/Net 0, the active side, transfer call processing to Core/Net 1:
   LD 135 Load the program.
   CUTOVR The inactive CP become active.

Call processing is now switched from Core/Net 0 to Core/Net 1.
Test Core/Net 1

Test Call Processing. This includes, but is not limited to the following:

1. Check for dial tone.
2. Make internal, external, and network calls.
3. Check attendant console activity.
4. Check DID trunks.
5. Check any auxiliary processors.

**Note:** From this point forward you are upgrading Core/Net 0 with new software.

Install software on Core/Net 0

1. Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:
   a. Press the button on the CD-ROM drive to open the CD-ROM disk holder.
   b. Place the CD-ROM disk into the holder with the disk label facing up.
   c. Press the button again to close the CD-ROM disk holder.

   **Note:** If the CD-ROM is not in the CD-ROM drive, the installation will not continue. Insert the CD-ROM to continue.

2. Place the CP PII Install floppy disk into the cPCI MMDU floppy drive.

   **Note:** If a problem is detected during the system verification, Install stops, prints an error message, and aborts the installation. If the verification is not successful, do not continue; contact your technical support organization.

3. Press the manual RESET button on the CP PII card faceplate.

Before the install menu runs, the system validates hard disk partitioning which takes about five minutes. The screen displays:

Testing partition 0
0 percent done...1 percent done ...99 percent done....100 percent done

Testing partition 1
At the terminal, press <cr> to start the software installation.

When prompted, remove the CP PII Install Program diskette and insert the Keycode diskette.

- Continue with keycode validation
- Confirm that the keycode matches the CD-ROM release

When the screen displays the Install Menu, select the following options in sequence when you are prompted to do so:

- Install software.
- Verify that the CD-ROM is now in drive.

The Installation Status Summary screen appears that lists the options to be installed.

- Start Installation.
- Continue with Upgrade.
Pre-release 3 language groups

7 Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series sets.

Select one of the six PSDL files

<1> Global 10 Languages
<2> Western Europe 10 Languages
<3> Eastern Europe 10 Languages
<4> North America 6 Languages
<5> Spare Group A
<6> North America 6 Languages (Duplicate of <4>)

The languages contained in each selection are outlined as follows:

- 1 - English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- 2 - English, French, German, Spanish, Swedish, Norwegian, Danish, Finnish, Italian, Brazilian Portuguese.
- 3 - English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- 4 - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
- 5 - English, French, German, Spanish, Swedish, Italian, Norwegian, Portuguese, Finnish, Japanese Katakana.
- 6 - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
Release 3 language groups

8 Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series sets.

Select one of the six PSDL files

<1> Global 10 Languages
<2> Western Europe 10 Languages
<3> Eastern Europe 10 Languages
<4> North America 6 Languages
<5> Spare Group A
<6> North America 6 Languages (Duplicate of <4> )

The languages contained in each selection are outlined as follows:

- 1 – Global 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- 2 – Western Europe 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Danish.
- 3 – Eastern Europe 10 Languages (Release 3) English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- 4 – North America six Languages (Release 3) English, French, German, Spanish, Brazilian Portuguese, Japanese Katakana.
- 5 – Spare Group A.
- 6 – Spare Group B.
9 Continue with ROM upgrade when prompted.
Select a database to install.

<cr> Enter carriage return to continue.
<a> Continue with CP BOOTROM installation.
<a> Install the CP BOOTROM from hard disk.
<a> Start installation.
<a> Continue with ROM upgrade.

The Installation Status Summary screen appears. Verify that CD to disk, disk to ROM, and CP-BOOTROM were installed.

<cr> Continue.
<q> Quit (remove any diskettes and the CD-ROM from the cPCI MMDU drives).
<y> Confirm quit.
<a> Reboot the system.

10 The system automatically performs a sysload: several message appear on the system terminal. Wait for “DONE” and then “INI” message to display before you continue.

While the sysload is being performed, database conversion occurs.

Verify that the following message appears on the system terminal:

DATA CONVERSION
RELEASE 25.XX TO RELEASE 25.XX

11 Confirm that Release 25 software is installed and is working on Core/Net 1:

LD 135 Load the program.
STAT CPU Display the CPU status.
STAT CNI Display the cCNI status.
Check for peripheral software download

Use LD 22 to print the Target peripheral software version. (You printed the Source peripheral software version during the pre-conversion procedure.)

If there is a difference between the Source and Target peripheral software version, a forced download occurs during initialization when coming out of parallel reload. System initialization will take longer and established calls on IPE will be dropped.

**LD 22**

**REQ** | PRT
---|---
**TYPE** | PSWV
**ISSP** | Print issue and release.
**TID** | Print Tape ID.
**SLLP** | Print System and patch information.
| Print auxiliary ID.
**** | Exit program.
Enable system redundancy

1. From the active CPU, Core/Net 1, enable redundancy:
   LD 135
   JOIN
   Synchronize the memory and drives.

Test Core/Net 1 and Core/Net 0

1. Perform a redundancy sanity test using the following sequence:
   LD 135
   STAT CNI c s Get status of cCNI cards.
   STAT CPU Get status of CPU and memory.
   TEST CPU Test the CP PII card in both Core/Nets.
   TEST CNI c s Test each cCNI card (core, slot).
   STAT SUTL Get status of System Utility (main and Transition) cards.
   TEST SUTL Test the System Utility (main and Transition) cards.
   TEST IPB Test the Inter Processor Bus
   TEST LCD Test the LCDs.
   TEST LED Test the LEDs.

2. Test system redundancy:
   LD 137
   TEST RDUN Test redundancy.
   DATA RDUN
   TEST CMDU Test the cPCI MMDU card.
3. Switch Cores and test the other side (Core/Net 0)

   LD 135
   SCPU  Switch cores.
   TEST CPU  Test the inactive Core/Net.
   STAT CNI  Get status of cCNI (both main and Transition) cards.
   CNI cs  Test cCNI (both main and Transition) cards.
   STAT SUTL  Get status of System Utility card.
   TEST SUTL  Test System Util card.
   TEST IPB  Test Inter Processor Bus.
   TEST LCD  Test LCDs.
   TEST LED  Test LEDs

4. Clear the display and minor alarms on both Cores.

   CDSP  Clear the displays on the Cores.
   CMAJ  Clear major alarms.
   CMIN ALL  Clear minor alarms.

5. Get the status of the Cores, CNIs, and memory.

   STAT CPU  Get the status of both Cores and redundancy
   STAT CNI cs  Get the status of all configured cCNIs (both main and Transition) cards.
   ****  Exit program.

**Perform a data dump**

1. Load the LD 43. At the prompt, enter

   LD 43  Load the program

2. Insert a floppy disk into the cPCI MMDU to capture the backup.

3. When “EDD000” appears on the terminal, enter

   EDD  Begin the data dump
When “DATABASE BACKUP COMPLETE” or “DATADUMP COMPLETE” appears on the terminal, enter

**CAUTION**

**Loss of Data**

If the data dump is not successful, do not continue; contact your technical support organization. Correct any data dump problem before you continue.

****

Back out of a system software upgrade

To back out of a system software upgrade once it is in the redundant mode running CP PII, split the cores and install the old release of software. Perform the following procedures in order.

**Split the Cores**

From the active side, split the cores:

**LD 135**

Load the program.

**SPLIT**

Enter Split on the active core.

****

Allow the former active side to INIT before continuing.

****

Exit the program.

The system is now in split mode.

**Install the software on Core/Net 1**

Install the old release of software:

1. Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:
   a. Press the button on the CD-ROM drive to open the CD-ROM disk holder.
   b. Place the CD-ROM disk into the holder with the disk label facing up. Use the four tabs to secure the CD-ROM drive.
   c. Press the button again to close the CD-ROM disk holder. **Do not** push the holder in by hand.
Note: If the CD-ROM is not in the CD-ROM drive, the installation will not continue. Insert the CD-ROM to continue.

2 Place the Install floppy disk with the old software release into the cPCI MMDU floppy drive.

Note: If a problem is detected during the system verification, install stops, prints an error message, and aborts the installation. If the verification is not successful, do not continue; contact your technical support organization.

3 Press the manual RESET button on the CP PII card faceplate. Before the install menu runs, the system validates hard disk partitioning which takes about five minutes. The screen displays:

Testing partition 0
0 percent done ...1 percent done ...99 percent done...100 percent done
Testing partition 1
0 percent done ...1 percent done ...99 percent done...100 percent done
Testing partition 2
0 percent done ...1 percent done ...99 percent done...100 percent completed!

Disk physical checking is completed!
There are 3 partitions in disk 0:
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB
The size of partition 0 of disk 0 is XX MB
Disk partitions and sectors checking is competed!

4 At the terminal, press <cr> to start the software installation.

5 When prompted, remove the Install Program diskette and insert the Keycode diskette.

<α> Continue with keycode validation.
<y> Confirm that the keycode matches the CD-ROM release.
6 When the screen displays the Install Menu, select the following options in sequence when you are prompted to do so:

- Install software.
- Verify that the CD-ROM is now in drive.
- The Installation Status Summary screen appears that lists the options to be installed.
- Start Installation.
- Continue with Upgrade.

Pre-release 3 language groups

7 Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series sets.

Select one of the six PSDL files

- Global 10 Languages
- Western Europe 10 Languages
- Eastern Europe 10 Languages
- North America 6 Languages
- Spare Group A
- North America 6 Languages (Duplicate of 4)

The languages contained in each selection are outlined as follows:

- 1 - English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- 2 - English, French, German, Spanish, Swedish, Norwegian, Danish, Finnish, Italian, Brazilian Portuguese.
- 3 - English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- 4 - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
- 5 - English, French, German, Spanish, Swedish, Italian, Norwegian, Portuguese, Finnish, Japanese Katakana.
- 6 - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
Release 3 language groups

8  Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series sets.

Select one of the six PSDL files

<1> Global 10 Languages
<2> Western Europe 10 Languages
<3> Eastern Europe 10 Languages
<4> North America 6 Languages
<5> Spare Group A
<6> North America 6 Languages (Duplicate of <4>)

The languages contained in each selection are outlined as follows:

- 1 – Global 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- 2 – Western Europe 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Danish.
- 3 – Eastern Europe 10 Languages (Release 3) English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- 4 – North America six Languages (Release 3) English, French, German, Spanish, Brazilian Portuguese, Japanese Katakana.
- 5 – Spare Group A.
- 6 – Spare Group B.
9  Continue with ROM upgrade when prompted.
    Select a database to install.
    `<cr>`  Enter carriage return to continue.
    `<a>`  Continue with CP BOOTROM installation.
    `<a>`  Install the CP BOOTROM from hard disk.
    `<a>`  Start installation.
    `<a>`  Continue with ROM upgrade.
    The system automatically performs a sysload: several messages appear on the system terminal. Wait for "DONE" and then "INI" message to display before you continue.
    `<cr>`  Continue.
    `<q>`  Quit.
    Remove any diskettes and the CD-ROM from the cPCI MMDU drives.
    `<y>`  Confirm quit.
    `<a>`  Reboot the system.

10  The system automatically performs a sysload: several messages appear on the system terminal. Wait for "DONE" and then "INI" message to display before you continue.
    While the sysload is being performed, database conversion occurs.
    Verify that the following message appears on the system terminal:

    DATA CONVERSION
    RELEASE 25.XX TO RELEASE 25.XX

11  Confirm that Release XX software is installed and working on Core/Net 1:
    LD 135    Load the program.
    STAT CPU  Display the CPU status.
    STAT CNI  Display the cCNI status.
Check for peripheral software download

Use LD 22 to print the Target peripheral software version. (You printed the Source peripheral software version during the pre-conversion procedure.)

If there is a difference between the Source and Target peripheral software version, a forced download occurs during initialization when coming out of parallel reload. System initialization will take longer and established calls on IPE will be dropped.

LD 22

REQ Print.
TYPE PSWV.
ISSP Print issue and release.
TID Print Tape ID.
SLLP Print System and patch information.
**** Print auxiliary ID.
**** Exit program.

Transfer call processing from Core/Net 0 to Core/Net 1

CAUTION
Service Interruption
The following procedure to transfer call processing can cause service interruptions. Time your procedure to minimize the effect of any breaks in service.

From Core/Net 0, the active side, transfer call processing to Core/Net 1:
LD 135 Load the program.
CUTOVR The inactive CP become active.

Call processing is now switched from Core/Net 0 to Core/Net 1.

Test Core/Net 1

Test Call Processing. This includes, but is not limited to the following:

1 Check for dial tone.
2 Make internal, external, and network calls.
3 Check attendant console activity.
4 Check DID trunks.
5 Check any auxiliary processors.

*Note:* From this point forward you are upgrading Core/Net 0 with new software.

### Install software on Core/Net 0

1 Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:
   a. Press the button on the CD-ROM drive to open the CD-ROM disk holder.
   b. Place the CD-ROM disk into the holder with the disk label showing.
   c. Press the button again to close the CD-ROM disk holder.

   *Do not* push the holder in by hand.

   *Note:* If the CD-ROM is not in the CD-ROM drive, the installation will not continue. Insert the CD-ROM to continue.

2 Place the Install floppy disk for the old release of software into the cPCI MMDU floppy drive.

   *Note:* If a problem is detected during the system verification, install stops, prints an error message, and aborts the installation. If the verification is not successful, do not continue; contact your technical support organization.

3 Press the manual RESET button on the CP PII card faceplate.

   Before the Install menu runs, the system validates hard disk partitioning which takes about five minutes. The screen displays:

   **Testing partition 0**
   
   0 percent done...1 percent done...99 percent done....100 percent done

   **Testing partition 1**
   
   0 percent done...1 percent done...99 percent done....100 percent done

   **Testing partition 2**
   
   0 percent done...1 percent done...99 percent done....100 percent completed!
At the terminal, press <cr> to start the software installation.

When prompted, remove the Install Program diskette and insert the Keycode diskette.

- <a> Continue with keycode validation
- <y> Confirm that the keycode matches the CD-ROM release

When the screen displays the Install Menu, select the following options in sequence when you are prompted to do so:

- <a> Install software.
- <a> Verify that the CD-ROM is now in drive.

The Installation Status Summary screen appears that lists the options to be installed.

- <y> Start Installation.
- <a> Continue with Upgrade.
Pre-release 3 language groups

7 Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series sets.

Select one of the six PSDL files

<1> Global 10 Languages
<2> Western Europe 10 Languages
<3> Eastern Europe 10 Languages
<4> North America 6 Languages
<5> Spare Group A
<6> North America 6 Languages (Duplicate of <4>)

The languages contained in each selection are outlined as follows:

- 1 - English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- 2 - English, French, German, Spanish, Swedish, Norwegian, Danish, Finnish, Italian, Brazilian Portuguese.
- 3 - English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- 4 - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
- 5 - English, French, German, Spanish, Swedish, Italian, Norwegian, Portuguese, Finnish, Japanese Katakana.
- 6 - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series sets.

Select one of the six PSDL files

1. Global 10 Languages
2. Western Europe 10 Languages
3. Eastern Europe 10 Languages
4. North America 6 Languages
5. Spare Group A
6. North America 6 Languages (Duplicate of <4>)

The languages contained in each selection are outlined as follows:

- 1 – Global 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- 2 – Western Europe 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Danish.
- 3 – Eastern Europe 10 Languages (Release 3) English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- 4 – North America six Languages (Release 3) English, French, German, Spanish, Brazilian Portuguese, Japanese Katakana.
- 5 – Spare Group A.
- 6 – Spare Group B.
9  Continue with ROM upgrade when prompted.  
Select a database to install.  
<br>Enter carriage return to continue.  
<a> Continue with CP BOOTROM installation.  
<a> Install the CP BOOTROM from hard disk.  
<a> Start installation.  
<a> Continue with ROM upgrade.  
The Installation Status Summary screen appears. Verify that CD to  
disk, disk to ROM, and CP-BOOTROM were installed.  
<br>Continue.  
<q> Quit (remove any diskettes and the CD-ROM from the  
cPCI MMDU drives).  
<y> Confirm quit.  
<a> Reboot the system.  

10  The system automatically performs a sysload: several message  
appear on the system terminal. Wait for “DONE” and then “INI”  
message to display before you continue.  

While the sysload is being performed, database conversion occurs.  

Verify that the following message appears on the system terminal:  

**DATA CONVERSION**  
**RELEASE 25.XX TO RELEASE 25.XX**  

11  Confirm that Release 25.XX software is installed and working on  
Core/Net 1:  

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LD 135</td>
<td>Load the program.</td>
</tr>
<tr>
<td>STAT CPU</td>
<td>Display the CPU status.</td>
</tr>
<tr>
<td>STAT CNI</td>
<td>Display the cCNI status.</td>
</tr>
</tbody>
</table>

Software Conversion Procedures
Check for peripheral software download

Use LD 22 to print the Target peripheral software version. (You printed the Source peripheral software version during the pre-conversion procedure.)

If there is a difference between the Source and Target peripheral software version, a forced download occurs during initialization when coming out of parallel reload. System initialization will take longer and established calls on IPE will be dropped.

**LD 22**

<table>
<thead>
<tr>
<th>REQ</th>
<th>TYPE</th>
<th>PSWV</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>PRT</em></td>
<td><strong>PSWV</strong></td>
<td></td>
</tr>
<tr>
<td><em>ISSP</em></td>
<td>Print issue and release.</td>
<td></td>
</tr>
<tr>
<td><em>TID</em></td>
<td>Print Tape ID.</td>
<td></td>
</tr>
<tr>
<td><em>SLLP</em></td>
<td>Print System and patch information.</td>
<td></td>
</tr>
<tr>
<td><em>SLLP</em></td>
<td>Print auxiliary ID.</td>
<td></td>
</tr>
</tbody>
</table>

**** Exit program.
Enable system redundancy

1. From the active CPU, Core/Net 1, enable redundancy:
   - LD 135
   - JOIN
     Synchronize the memory and drives.

Test Core/Net 1 and Core/Net 0

From the active CPU, Core/Net 1, perform these tests:

1. Perform a redundancy sanity test using the following sequence:
   - LD 135
   - STAT CNI c s
     Get status of cCNI cards.
   - STAT CPU
     Get status of CPU and memory.
   - TEST CPU
     Test the CP PII card in both Core/Nets.
   - TEST CNI c s
     Test each cCNI card (core, slot).
   - STAT SUTL
     Get status of System Utility (main and Transition) cards.
   - TEST SUTL
     Test the System Utility (main and Transition) cards.
   - TEST IPB
     Test the Inter Processor Bus
   - TEST LCD
     Test the LCDs.
   - TEST LED
     Test the LEDs.

2. Test system redundancy:
   - LD 137
   - TEST RDUN
     Test redundancy.
   - DATA RDUN
   - TEST CMDU
     Test the MMDU card.

3. Switch Cores and test the other side (Core/Net 0)
   - LD 135
   - SCPU
     Switch cores.
   - TEST CPU
     Test the inactive Core/Net.
   - STAT CNI c s
     Get status of CNI (both main and Transition) cards.
   - TEST CNI c s
     Test CNI (both main and Transition) cards.
   - STAT SUTL
     Get status of System Utility card.
Clear the display and minor alarms on both Cores.
- CDSP: Clear the displays on the Cores.
- CMAJ: Clear major alarms.
- CMIN ALL: Clear minor alarms.

Get the status of the Cores, CNIs, and memory.
- STAT CPU: Get the status of both Cores and redundancy.
- STAT CNI c s: Get the status of all configured cCNIs (both main and Transition) cards.

Perform a data dump

1. Load the LD 43. At the prompt, enter
   - LD 43: Load the program
2. When “EDD000” appears on the terminal, enter
   - EDD: Begin the data dump
3. When “DATABASE BACKUP COMPLETE” or “DATADUMP COMPLETE” appears on the terminal, enter

   **CAUTION**

   Loss of Data
   If the data dump is not successful, do not continue; contact your technical support organization. Correct any data dump problem before you continue.

   ****

   The software backup procedure is complete.
Adding features and ISM limits to a CP PII system

Adding new features and/or modifying Incremental Software Management (ISM) limits requires the installation of a new keycode. Keycodes are delivered via diskette or electronic file transfer and installed using the keycode management commands in LD 143 or the Meridian 1 Software Installation Tool (see Procedure 8: CD-ROM Software Installation Tool on page 255).

The procedures below outline the steps to install a new keycode that can be activated "instantly" or that requires a sysload (Cold Restart). More information on the "Instant ISM" feature can be found in the X11 Features and Services guide.

This section describes how to install a keycode to activate features and/or modify ISM limits using the commands listed below:

**LD 143 commands**

<table>
<thead>
<tr>
<th>Keycode delivery</th>
<th>Keycode Installation command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diskette</td>
<td>Use the KNEW F0 command in LD 143</td>
</tr>
<tr>
<td>Electronic file on a PC</td>
<td>Use the KUPL command in LD 143, for keycode file in ASCII format followed by the KNEW HD command</td>
</tr>
<tr>
<td>Faxed to the customer site</td>
<td>Use the KMAN command in LD 143, to enter keycode manually followed by the KNEW HD command</td>
</tr>
<tr>
<td>(paper-based keycode)</td>
<td></td>
</tr>
</tbody>
</table>

**Feature operation**

Feature operation is further broken down into four options:

- Feature and ISM parameter upgrade using a keycode diskette
- Feature and ISM parameter upgrade using HyperTerminal
- Feature and ISM parameter upgrade entered manually
- Reverting to the previous keycode with the KRVR command
For the following procedures, Core 0 is initially active and Core 1 is initially inactive.

**Feature and ISM parameter upgrade using a keycode diskette**

Leave the system in full redundant mode (hard-disk and CPU redundancy).

1. Log in on a system terminal and load overlay 143.
   
   >LD 143
   
   CCBR000
   

2. Insert the new keycode diskette into the floppy drive on the active MMDU.
Enter the KDIF command and select keycode comparison options.

**Note:** Ensure that the new keycode does not lower ISM limits or reduce features compared with the existing keycode. If you have determined that the keycode lowers ISM limits or reduces features, do not continue with the KNEW command, but contact your Nortel Networks order management representative.

 KDIF

Please use: KDIF <param1> <param2>
with the following parameters:

- **NEW** accepted new keycode
- **REC** currently used keycode
- **OLD** previously used keycode
- **F0** candidate keycode on diskette in /f0 floppy drive
- **HD** candidate keycode which was uploaded to hard disk

Enter the keycode comparison option. The new keycode option is shown in **bold**.

**Note:** In the following example, the (REC) currently used keycode will be compared with the new keycode disk in floppy drive F0. The limits shown are for example purposes only.

**KDIF REC F0**

Validating Keycode File /p/install/keycode.rec ... OK
Validating Keycode File /f0/keycode.kcd ... OK

<table>
<thead>
<tr>
<th>System parameters</th>
<th>1st keycode</th>
<th>2nd keycode</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Serial Number</td>
<td>46XX</td>
<td>46XX</td>
</tr>
<tr>
<td>Software Version</td>
<td>3311</td>
<td>3311</td>
</tr>
<tr>
<td>System Type</td>
<td>Option 81C</td>
<td>Option 81C</td>
</tr>
<tr>
<td>Call Processor</td>
<td>CP PII</td>
<td>CP PII</td>
</tr>
<tr>
<td>Release</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>Issue</td>
<td>XX</td>
<td>XX</td>
</tr>
<tr>
<td>NTI Order Number</td>
<td>:</td>
<td>:</td>
</tr>
<tr>
<td>NT SDID - 1</td>
<td>:</td>
<td>:</td>
</tr>
</tbody>
</table>
Note: ( ) indicates that information is not available.

Common packages for both keycodes:
0-2 4-5 7-25 28-29 32-55 58-65

Additional packages in the 2nd keycode:
< 30-31

Select the new keycode for activation using the KNEW command.

. KNEW F0

The uploaded keycode is validated against the security device.

If the following system message is given:
CCBR020 New Keycode accepted and activated successfully.
Sysload is NOT needed!

This implies that the new keycode is eligible for instant activation and no further user action is required, proceed to step 5 and 6.

Otherwise, if the keycode is not eligible for instant activation, a Sysload is needed to activate the new keycode and the following system message is given:
CCBR009 New Keycode accepted. New ISM limits and feature packages will be activated during the next sysload (Cold Restart).

Skip to step 7.
5 Load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REQ SLT
....

If ISM limits are correct then the keycode installation is complete.

See "Reverting to the previous keycode with the KRVR command" on page...(NTP group to fill in) if ISM limits are not increased or problems exist.

6 Once you have confirmed that the keycode changes taken affect as expected, perform a data dump in LD 43.

7 For keycodes that are not eligible for Instant ISM.

In the active core (e.g. Core 0) access LD 135 and type the "SPLIT" command. This puts a redundant (shadowed) system into single (non-shadowed) mode.

>LD 135
.SPIT
.....

8 In the inactive core (Core 1), load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REQ SLT
....

9 In the active core, access LD 135 and type the "CUTOVR" command. This transfers call processing from the active core (e.g. Core 0) to the inactive core (Core 1).

>LD 135
.CUTOVR
.....

The previously inactive core (Core 1) with the new keycode now becomes active.

10 In order to activate the new keycode on the new inactive core, a sysload (Cold Restart) is required.

Press the RESET button on Core 0.
11 In Core 0, load Overlay 22 and confirm that the new ISM parameters have been updated.
   >LD 22
   REQ SLT
   ....

12 In the active core, access LD 135 and type the "JOIN" command. This puts the system back to redundant mode, synchronizing the memory and hard drive of the inactive core with the active core.
   >LD 135
   .JOIN
   ....

13 Perform a data dump in LD 43.

Feature and ISM parameter upgrade using HyperTerminal®

Leave the system in full redundant mode (hard-disk and CPU redundancy).

1 On a PC, access the Meridian 1 system (via a modem) with HyperTerminal®:
   • Click the Start button | Programs | Accessories | HyperTerminal.

2 Double-click the HyperTerminal client to the Meridian 1 system.

3 Log into the Meridian 1 system.

4 Load the Keycode Management Program (LD 143).
   LD 143 to load program
   KUPL to upload keycodes to the hard disk on the target system

5 Click the Transfer menu in HyperTerminal and select Send Text File.

6 From the Files of type pull-down menu, select All Files (*.*)

7 Locate and select the keycode file on the PC. Use the Look in pull-down menu to select the drive on which the keycode is located.
8 Click Open.  
The keycode will be displayed after the KUPL prompt.  
Example:  
KUPL 0001PBX 0101  
9FPAMSRHNN17KRUQAFFSPREQVMTHDHRKDHRKJEJR56  
9 Press the Enter key.  
The Keycode is checked for CRC errors and is uploaded to the hard disk.  
Enter the following command:  
KDIF REC HD to compare the existing keycode with the new keycode on the hard disk  
Ensure that the new keycode does not lower ISM limits or reduce features compared with the existing keycode. If you have determined that the keycode lowers ISM limits or reduces features, do not continue with the KNEW command, but contact your Nortel Networks order management representative.  
10 Select the new keycode for activation using the KNEW command.  
KNEW HD  
The uploaded keycode is validated against the security device.  
If the following system message is given:  
CCBR020 New Keycode accepted and activated successfully.  
Sysload is NOT needed!  
This implies that the new keycode is eligible for instant activation and no further user action is required, proceed to step 11 and 12.  
Otherwise, if the keycode is not eligible for instant activation, a Sysload is needed to activate the new keycode and the following system message is given:  
CCBR009 New Keycode accepted. New ISM limits and feature packages will be activated during the next sysload (Cold Restart).  
Skip to step 13.
11 Load Overlay 22 and confirm that the new ISM parameters have been updated.

> LD 22
  REQ SLT
  ....

If ISM limits are correct then the keycode installation is complete.

See “Reverting to the previous keycode with the KRVR command” on page...(NTP group to fill in) if ISM limits are not increased or problems exist.

12 Once you have confirmed that the keycode changes taken affect as expected, perform a data dump in LD 43.

13 For keycodes that are not eligible for Instant ISM.

In the active core (e.g. Core 0) access LD 135 and type the "SPLIT" command. This puts a redundant (shadowed) system into single (non-shadowed) mode.

> LD 135
  .SPLIT
  ....

14 In the inactive core (Core 1), load Overlay 22 and confirm that the new ISM parameters have been updated.

> LD 22
  REQ SLT
  ....

15 In the active core, access LD 135 and type the "CUTOVR" command. This transfers call processing from the active core (e.g. Core 0) to the inactive core (Core 1).

> LD 135
  .CUTOVR
  ....

The previously inactive core (Core 1) with the new keycode now becomes active.

16 In order to activate the new keycode on the new inactive core, a sysload (Cold Restart) is required.

Press the RESET button on Core 0.
17 In Core 0, load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REQ SLT
....

18 In the active core, access LD 135 and type the "JOIN" command. This puts the system back to redundant mode, synchronizing the memory and hard drive of the inactive core with the active core.

>LD 135
.Join
....

19 Perform a data dump in LD 43.

**Feature and ISM parameter upgrade entered manually**

Before beginning this procedure, you must have a copy of the keycode. The keycode can reside on paper or as an electronic file. To enter the keycode manually, you will type the keycode in LD 143 as 21 lines, 16 characters per line.

1 Log into the system.

2 Load the Keycode Management Program (LD 143).

LD 143     to load program
KMAN        manually enter the keycode to the target system

3 Type keycode file, 21 lines of 16 characters each. Press return to go to the next line.

   Note: When entering the keycode, do not enter the header information that proceeds the keycode.

4 Type "end" at line 22 to end the process.
Press enter. The new keycode file will be saved on the hard disk.

Enter the following command:

**KDIF REC HD** to compare the existing keycode with the new keycode on the hard disk

Ensure that the new keycode does not lower ISM limits or reduce features compared with the existing keycode. If you have determined that the keycode lowers ISM limits or reduces features, do not continue with the KNEW command, but contact your Nortel Networks order management representative.

Select the new keycode for activation using the KNEW command.

KNEW HD

The uploaded keycode is validated against the security device.

If the following system message is given:

CCBR020 New Keycode accepted and activated successfully.
Sysload is NOT needed!

This implies that the new keycode is eligible for instant activation and no further user action is required, proceed to step 7 and 8.

Otherwise, if the keycode is not eligible for instant activation, a Sysload is needed to activate the new keycode and the following system message is given:

CCBR009 New Keycode accepted. New ISM limits and feature packages will be activated during the next sysload (Cold Restart).

Skip to step 9.

Load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REQ SLT
....

If ISM limits are correct then the keycode installation is complete.

See "Reverting to the previous keycode with the KRVR command" on page...(NTP group to fill in) if ISM limits are not increased or problems exist.

Once you have confirmed that the keycode changes taken affect as expected, perform a data dump in LD 43.
For keycodes that are not eligible for Instant ISM.

In the active core (e.g. Core 0) access LD 135 and type the "SPLIT" command. This puts a redundant (shadowed) system into single (non-shadowed) mode.

>LD 135
  .SPLIT
  .....  

In the inactive core (Core 1), load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
  REQ SLT
  .....  

In the active core, access LD 135 and type the "CUTOVR" command. This transfers call processing from the active core (e.g. Core 0) to the inactive core (Core 1).

>LD 135
  .CUTOVR
  .....  

The previously inactive core (Core 1) with the new keycode now becomes active.

In order to activate the new keycode on the new inactive core, a sysload (Cold Restart) is required.

Press the RESET button on Core 0.

In Core 0, load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
  REQ SLT
  .....  

In the active core (Core 1), access LD 135 and type the "JOIN" command. This puts the system back to redundant mode, synchronizing the memory and hard drive of the inactive core with the active core.

>LD 135
  .JOIN
  .....  

Perform a data dump in LD 43.
Reverting to the previous keycode with the KRVR command

*Note:* The terms “old” and “new” keycode as discussed here refer to the most recent previous KNEW command. The “old” keycode is the former keycode, prior to the KNEW command. The “new” keycode is the keycode that was activated by the KNEW command.

To revert to the old keycode:

- In overlay 143, enter the **KRVR** command.

The old keycode is eligible for instant activation with the KRVR command if the only difference between the old keycode and the new keycode is that some or all of the ISM parameters in the old keycode are *higher*.

If the keycode is eligible for instant activation, it will be activated without further user action, and the following system message is given:

**CCBR020** New Keycode accepted and activated successfully. Sysload is NOT needed!

Otherwise, if the keycode is not eligible for instant activation, a Sysload is needed to activate the new keycode and the following system message is given:

**CCBR009** New Keycode accepted. New ISM limits and feature packages will be activated during the next sysload (Cold Restart).

Follow below procedures to sysload the system if the keycodes are not eligible for Instant ISM and CCR009 message is displayed:

1. In the active core (e.g. Core 0) access LD 135 and type the "SPLIT" command. This puts a redundant (shadowed) system into single (non-shadowed) mode.

   ```
   >LD 135
   .SPLIT
   .....  
   ```

2. In the inactive core (Core 1), load Overlay 22 and confirm that the new ISM parameters have been updated.

   ```
   >LD 22
   REQ SLT
   .....  
   ```
3 In the active core, access LD 135 and type the "CUTOVR" command. This transfers call processing from the active core (Core 0) to the inactive core (Core 1).

>LD 135
.CUTOVR
.....

The previously inactive core (Core 1) with the new keycode now becomes active.

4 In order to activate the new keycode on the new inactive core, a sysload (Cold Restart) is required.

Press the RESET button on Core 0.

5 In Core 0, load Overlay 22 and confirm that the new ISM parameters have been updated.

>LD 22
REq SLT
....

6 In the active core (Core 1), access LD 135 and type the "JOIN" command. This puts the system back to redundant mode, synchronizing the memory and hard drive of the inactive core with the active core.

>LD 135
.JOIN
Increasing NT9D19, NT5D10 CP and NT5D03 CP memory

Contents

The following are the topics in this section:

Software Release 25 ......................................................... 151
Increasing memory on NT9D19, NT5D10 CP and NT5D03 CP cards ....................................................... 153
  Determine your Call Processor memory configuration ................. 154
  NT5D03, NT5D10, NT9D19 CP cards ........................................ 155
  Install the DRAM SIMMs ................................................. 159
  Install the Flash memory ............................................... 162
  Installing new NT9D19, NT5D10 or NT5D03 CP cards on systems ....................................................... 163

Reference list

The following are the references in this section:

• Hardware Upgrade Procedures (553-3001-258)

Software Release 25

To install Release 25, your system must be operating with the required CP Flash and DRAM memory. If your system is not operating with the minimum memory requirement, the CP card(s) memory must be upgraded before installing Release 25 software.
Release 25 supports a078611, NT9D19 (68040), NT5D10 (68060), and NT5D03 (68060E) Call Processor cards. The minimum memory requirement for each system option is listed in Table 6 on page 152.

**Note:** Memory upgrades are not supported on A078611 CP PII Call Processor cards.

### Table 6
Release 25.0x memory requirements

<table>
<thead>
<tr>
<th>System type</th>
<th>Flash memory requirement</th>
<th>DRAM memory requirement</th>
<th>Total memory requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options 51C,61C</td>
<td>32 MB</td>
<td>48 MB</td>
<td>80 MB</td>
</tr>
<tr>
<td>Options 81,81C</td>
<td>32 MB</td>
<td>64 MB</td>
<td>96 MB</td>
</tr>
<tr>
<td>Options 81,81C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Options 81/81C systems</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>operating on Call Processor 68060 or 68060E with 5 or fewer network groups (including Fiber Network Fabric systems)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• any Option 81/81C system</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>operating on Call Processor 68040</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Options 81,81C</td>
<td>32 MB</td>
<td>80 MB</td>
<td>112 MB</td>
</tr>
<tr>
<td>Options 81,81C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Options 81/81C systems</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>operating on Call Processor 68060 or 68060E with 6 or more network groups</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Increasing memory on NT9D19, NT5D10 CP and NT5D03 CP cards

DRAM SIMM memory upgrades are supported on NT5D03, NT5D10, and NT9D19 CP cards. Flash Memory upgrades are supported on NT5D03 and NT5D10 CP cards.

Memory upgrades consist of installing memory SIMMs on your existing NT9D19 or NT5D10 or NT5D03 CP card, or installing new, complete CP card(s) depending on memory requirements. Flash memory upgrades consist of installation new Flash modules on your existing NT5D10 or NT5D03 CP card.

Several system upgrades to Option 51C, 61C, 81, and 81C include procedures to upgrade CP card memory. If you are upgrading to one of these systems, do not use the procedures in this document; instead, locate the upgrade procedure that applies to your system (see Hardware Upgrade Procedures (553-3001-258) and use the memory upgrade procedure contained therein.

CAUTION
Damage to Equipment
Nortel Networks recommends that only properly trained distributor personnel perform this memory SIMM upgrade. Upgrade memory on NT9D19, NT5D10, or NT5D03 CP cards involves some risk of damage to SIMMs and CP cards; personnel performing this upgrade do so at their own risk.

CAUTION
Service Interruption
Personnel should have spare CP cards on hand or risk installation delay or system down time. Nortel Networks assumes no responsibility for any damage incurred, installation delays due to board damage, or loss due to damage or system down time.
Determine your Call Processor memory configuration

Before upgrading the Call Processor memory, determine the existing flash and DRAM SIMM configuration. This is accomplished through visual inspection (product labeling) or through Overlay 22.

Use the following procedure to determine your Call Processor memory configuration.

1. Log into your Meridian 1 system.
2. Load Overlay 22:
   
   LD 22
   PRT
   CEQU
3. The example below shows the output for a 128 MB configuration:

<table>
<thead>
<tr>
<th>MCFN</th>
<th>S1B0</th>
<th>S1B1</th>
<th>S2B0</th>
<th>S2B1</th>
<th>S3B0</th>
<th>S3B1</th>
<th>FLSH</th>
<th>TOTL</th>
</tr>
</thead>
<tbody>
<tr>
<td>016</td>
<td>000</td>
<td>016</td>
<td>000</td>
<td>016</td>
<td>016</td>
<td>000</td>
<td>000</td>
<td>64</td>
</tr>
</tbody>
</table>

where:

- **MCFN** represents the call processor memory configuration
- **S1** Slot 1 is the DRAM SIMM connector at position X5
- **S2** Slot 2 is the DRAM SIMM connector at position X6
- **S3** Slot 3 is the DRAM SIMM connector at position X7
- **S4** Slot 4 is the DRAM SIMM connector at position X8
- **B0** Bank 0 represents the DRAM memory at logical Bank 0
- **B1** Bank 1 represents the DRAM memory at logical Bank 1
- **FLSH** is the total amount of Flash memory populated on the Call Processor board
- **TOTL** is the total Flash and DRAM memory populated on the Call Processor board

To determine the amount of DRAM memory in a particular slot, add the Bank 0 and Bank 1 values for that slot number.
In the example in Procedure 3 on page 154, the DRAM and Flash configuration is:

- X5 (DRAM memory) = 16 MB - the value 16 in S1B0 plus the value 0 in S1B1
- X6 (DRAM memory) = 16 MB - the value 16 in S2B0 plus the value 0 in S2B1
- X7 (DRAM memory) = 32 MB - the value 16 in S3B0 plus the value 16 in S3B1
- X8 (DRAM memory) = (empty slot) - the value 0 in S4B0 plus the value 0 in S4B1
- Flash Memory is 64 MB - the value 64 in FLSH
- Total Memory on the Call Processor card is 128 MB - the addition of all Flash and DRAM memory

When you determine the Call Processor memory configuration, proceed with the memory upgrade.

**NT5D03, NT5D10, NT9D19 CP cards**

Use the procedures in this section to complete the upgrade, or refer to “Install the DRAM SIMMs” on page 159 and “Install the Flash memory” on page 162 for detailed upgrade instructions.

Table 7 on page 156 defines the memory upgrade paths for the following Motorola-based Call Processor cards:

- 68060E
- 68040
- 68030

To perform a DRAM and/or Flash upgrade:

- Locate your existing processor vintage in Table 7 on page 156.
- Locate the target processor vintage in Table 7 on page 156.
- Compare the existing SIMM configuration with the target configuration.
- Determine what SIMMs must be added or deleted from the existing location.
Add or delete DRAM SIMMs as required to achieve the target memory configuration (see Figure 1 on page 158 for the DRAM and Flash SIMM slot locations).

Install the Flash memory modules in an available Flash connector.

Install the label and label inserts. Discard all unused labels.

The upgrade is complete.

**Table 7**

<table>
<thead>
<tr>
<th>Total Memory</th>
<th>Total FLASH</th>
<th>Total DRAM</th>
<th>Call Processor</th>
<th>Slot 0</th>
<th>Slot 1</th>
<th>Slot 2</th>
<th>Slot 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>48</td>
<td>32</td>
<td>16</td>
<td>NT9D19AA</td>
<td>16</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT9D19AB</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>32</td>
<td>32</td>
<td>NT9D19CA</td>
<td>16</td>
<td>16</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT9D19CB</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT5D10CA</td>
<td>32</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>80</td>
<td>32</td>
<td>48</td>
<td>NT9D19EA</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT9D19EB</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT5D10EA</td>
<td>16</td>
<td>32</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>96</td>
<td>32</td>
<td>64</td>
<td>NT9D19TA</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT9D19TB</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT5D10TA</td>
<td>16</td>
<td>16</td>
<td>32</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT5D03TA</td>
<td>32</td>
<td>32</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>112*</td>
<td>32</td>
<td>80</td>
<td>NT9D19UA</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT9D19UB</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT5D10UA</td>
<td>16</td>
<td>32</td>
<td>32</td>
<td>0</td>
</tr>
<tr>
<td>128*</td>
<td>32</td>
<td>96</td>
<td>NT9D19VA</td>
<td>16</td>
<td>16</td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT9D19VB</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* This configuration requires Release 24 or later.

** The 68040 CP card is available in A and B vintages. When labeling the CP card, use the appropriate vintage suffix.
### Table 7
**Supported memory upgrade configurations**

<table>
<thead>
<tr>
<th>Total Memory</th>
<th>Total FLASH</th>
<th>Total DRAM</th>
<th>Call Processor</th>
<th>Slot 0</th>
<th>Slot 1</th>
<th>Slot 2</th>
<th>Slot 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>68040**</td>
<td>68060</td>
<td>68060E</td>
<td></td>
<td>32</td>
<td>32</td>
<td>32</td>
<td>0</td>
</tr>
<tr>
<td>96</td>
<td>64</td>
<td>32</td>
<td>NT9D19HA</td>
<td>16</td>
<td>16</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT9D19HB</td>
<td>32</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>112</td>
<td>64</td>
<td>48</td>
<td>NT9D19JA</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT9D19JB</td>
<td>16</td>
<td>32</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>128</td>
<td>64</td>
<td>64</td>
<td>N/A</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>128</td>
<td>64</td>
<td>64</td>
<td>NT9D19FA</td>
<td>16</td>
<td>16</td>
<td>32</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT9D19FB</td>
<td>32</td>
<td>32</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>144*</td>
<td>64</td>
<td>80</td>
<td>NT9D19NA</td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT9D19NB</td>
<td>16</td>
<td>32</td>
<td>32</td>
<td>0</td>
</tr>
<tr>
<td>160*</td>
<td>64</td>
<td>96</td>
<td>NT9D19PA</td>
<td>16</td>
<td>16</td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NT9D19PB</td>
<td>32</td>
<td>32</td>
<td>32</td>
<td>0</td>
</tr>
</tbody>
</table>

* This configuration requires Release 24 or later.

** The 68040 CP card is available in A and B vintages. When labeling the CP card, use the appropriate vintage suffix.
Figure 1
NT9D19, NT5D10 or NT5D03 DRAM and Flash location
**Install the DRAM SIMMs**

1. Place the CP card SIMM-side up on the antistatic mat.
2. Locate the DRAM SIMM connectors (see Figure 1 on page 158).
3. Determine if your memory upgrade requires you to remove an existing DRAM SIMM (see.) If removal is required, remove the SIMM from the highest numbered slot available first (X8, X7, X6, etc.) To remove the DRAM SIMM:
   a. Use a nonconducting screw driver to carefully move each latch away first from one end of the SIMM, and then the other end. The SIMM pivots away from the others until it is at approximately a 50- to 70-degree angle to the board (see Figure 1 on page 158).
   b. If the SIMM does not release from the latches, use your thumbnails, one on each latch, to release the latches. If the board has plastic latches, the latches are located on the side facing the card faceplate. If the board has metal latches, the levers protrude from each latch. Carefully move the latches outward simultaneously until the SIMM pivots away from the others and is at approximately a 50- to 70-degree angle to the board (see Figure 1 on page 158).
4. Working from left to right, install the 32 MB SIMM(s) in the SIMM location designated X5, X6, X7 or X8 where appropriate:
   a. Orient the new SIMM so that the notch at one end of the SIMM aligns with the key at one end of the SIMM socket. Hold the SIMM at approximately a 50- to 70-degree angle and gently insert the SIMM into the socket. See Figure 2 on page 161.

---

**CAUTION**

**System Failure**

Do not mix-up the 32 MB DRAM SIMM with the 16 MB DRAM SIMM. The 16 MB DRAM SIMM is labeled A0662646 or A0614334; the 32 MB DRAM SIMM is labeled A0634230. Older 16 MB DRAM SIMMs may not be labeled.
5 Using your thumbs and index fingers only (at the upper corners of the SIMM), carefully lean the SIMM toward the others until it is upright and the latch at each end of the SIMM snaps into place. If necessary, use a nonconducting screwdriver to help open each latch while you move the SIMM into the upright position. Apply the generic label over the existing label.

6 Select the correct labels for your CP card from the sheet provided.

7 Place the CP/memory configuration label at the top of the faceplate.

8 Place the engineering code/release level label on the bottom of the faceplate.

9 Discard unused labels.
Figure 2
NT9D19, NT5D10, NT5D03 card DRAM SIMM installation
Install the Flash memory

CAUTION
System Failure

Do not remove the existing Flash SIMMS from the Call Processor board.

1. Place the CP card SIMM-side up on the antistatic mat.
2. Determine the location of the new Flash SIMM connectors.
3. Install the new 32 MB Flash SIMM module in the appropriate slot:
   a. Orient the new SIMM so that the notches on the bottom of the SIMM align with the notches on the connector.
   b. Gently guide the Flash SIMM toward the connector socket.
   c. When the Flash SIMM makes contact with the connector, apply pressure to one end of the Flash SIMM and close the latch connector.
   d. Apply pressure to the other end of the Flash SIMM and close the latch connector.
4. Apply the generic label over the existing label.
5. Select the correct labels for your CP card from the sheet provided.
6. Place the CP/memory configuration label at the top of the faceplate.
7. Place the engineering code/release level label on the bottom of the faceplate.
8. Discard unused labels.
9. Update the Flash ROM using the Software Install Tool:
   Note: For dual CPU systems, verify that the system is operating in split mode before activating the Software Install Tool.
   a. To activate the Software Install Tool, insert the Install disk into the inactive the IODU/C (or IOP/CMDU). Press the MAN RST button on the Call Processor card in the inactive Core.
   b. From the Main Menu, select <G>, to update the Flash ROMs from the hard disk.
c. Select <Y> to confirm installation.
d. Press <CR> to return to the Install Menu.
e. Upon successful installation of software on the Flash ROMs, select <E> to update the CP-BOOT ROM.
f. Repeat this procedure for the second Core.

The Flash memory upgrade is complete.

Installing new NT9D19, NT5D10 or NT5D03 CP cards on systems

The following procedures describe how to increase the CP card memory by installing a new CP card with higher memory capacity. It can be used to replace and upgrade the following CP cards:

- **80 MB** NT9D19EA card with a new **96 MB** NT9D19CA card
- **80 MB** NT5D10CA card with a new **112 MB** NT5D10DA card
- **80 MB** NT5D03DA card with a new **128 MB** NT5D03EA card

Before starting the procedure, make a backup copy of the customer database using the data dump routine:

1. Log into the system.
2. Load the Equipment Data Dump Program (LD 43). At the prompt, enter LD 43 to load the program
3. When “EDD000” appears on the terminal, enter EDD to begin the data dump
When "DATABASE BACKUP COMPLETE" or "DATADUMP COMPLETE" appears on the terminal, enter

**CAUTION**

Loss of Data

If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.

**** to exit the program

5 Check total memory allocation before the upgrade.

**LD 10** to load the program

When the header for overlay 10 is displayed, note the value associated with Total Memory. After the upgrade, compare Total Memory before and after the upgrade. Total Memory should be greater after the upgrade.

Exit the program:

**** to exit the program

**Split the cores**

1 To access the Core during the replacement procedure, connect a terminal to the system. The CP card you are replacing must be in the inactive Core. Check the status of the NT5D10 or NT5D03 Call Processor card:

**LD 135**

**STAT CPU** determine which CP card is active

If necessary, switch Cores:

**SCPU** switch Cores

**** exit LD 135

2 Set the NORM/MAINT switch on the NT5D10 or NT5D03 Call Processor card to MAINT on the active Core.

3 Set the ENB/DIS switch on all CNI cards on the inactive Core to DIS.
Perform the following three steps on the **inactive** Core in an uninterrupted sequence:

- Press and hold down the MAN RST button on the CP card on the inactive Core.
- Set the NORM/MAINT switch to MAINT.
- Release the MAN RST button.

The system is now in split mode where each Core is functioning independently and the automatic switchover has been disabled.

### Installing equipment

1. Set the NORM/MAINT switch to MAINT on the replacement card.
2. Insert the CP Install Program diskette which corresponds with the NT5D10 or NT5D03 Call Processor (68060 or 68060E).
3. Remove the current CP card and put it in a static bag and box.
4. Insert the CP replacement card into its vacated slot and hook the locking devices.
5. Press the MAN RST button on the replacement CP card.
6. When the NT Logo Screen appears on the terminal, press <CR>.
7. Press <CR> to continue.
8. Log into the system and enter the time and date, when prompted.
9. Initiate the database installation by selecting the following command from the menu:
   
   - `<u>` to Install menu

10. Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.

    - `<a>` to continue with keycode validation
    - `<y>` to confirm that the keycode matches the CD-ROM release

11. When the Install Menu appears, select the following options in sequence:

    - `<g>` to reinstall CP software
    - `<y>` to start installation
When the Install Menu appears, select the following options in sequence

- `<e>` to install CP-BOOTROM
- `<y>` to start installation
- `<a>` to continue with the upgrade

A Status Summary is displayed indicating what was installed. Press `<CR>` to return to the Install Menu.

Remove the diskette from the IODU/C.

Select the following options to quit the Install Tool:

- `<q>` to quit
- `<y>` to confirm quit
- `<a>` to reboot the system.

**Note:** The system will reboot. Wait for the “INI” and “DONE” messages to display before continuing. It will take at least 70 seconds between the “DONE” and “INI” messages.

After the system initialization has finished (INI messages are no longer displayed on the system terminal), check for dial tone on a telephone set.

Following a successful dial tone test, perform the following basic sanity tests:

- Make sure calls can be placed
- Check for error messages, line noise, chatter, or other problems. Track sources and resolve problems as necessary.

To place the system back in the redundant (normal) mode with automatic switchover capability. Perform the following five steps in uninterrupted sequence on the inactive Core (the Core with the replaced CP card):

Press and hold down the MAN RST button on the CP card of the inactive Core.

While holding down the MAN RST button, set the NORM/MAINT switch on the same CP card to NORM.

Enable all CNI switches in the inactive Core.
20 Release the MAN RST button.
21 Set the CP card in the active Core to NORM.

After several minutes, an “HWI533” message is issued by the active Core indicating that the inactive Core memory is being synchronized with the active Core memory.

22 Log into the system through the terminal, then check the status of the replacement CP card from the active side:
   LD 135   load LD 135
   STAT CPU  obtain the CPU status

23 If there are CCED messages generated by the STAT CPU command on the replacement CP card, set the NORM/MAINT switch to MAINT, press the reload (MAN RST) button and set the NORM/MAINT switch back to NORM. (It may take 2 to 4 minutes for memory synchronization to take place.)

After the HWI0533 message is displayed, test the replacement CP card from the active CPU:
   TEST CPU the test causes a cold start on the inactive CPU
If the test results in:
   CCED014 “Test failed because unable to enter SPLIT mode”
On the active CP card set the NORM/MAINT switch to NORM, and from the active side enter:
   TEST CPU to test the CP card

24 Set the NORM/MAINT switch to NORM on the active CP card (if not already set).
25 Check the status of the CPUs:
   STAT CPU
26 Test the CPU.
   TEST CPU
27 Check the status of the CNIs:
   STAT CNI
28 Switch Cores and exit the program:

SCPU

***** exit LD 135

Note: If, using the non-conductive screw driver, the SIMM does not release from the latches, use your thumbnails, one on each latch, to release the latches: for plastic latches, the latches are located on the ends of each SIMM; for metal latches, levers protrude from each latch. Carefully move the latches outward simultaneously until the SIMM pivots away from the others and it is at approximately a 50- to 70-degree angle to the board.
Using the Distributor Keycode Application

Contents

The following are the topics in this section:

- Hardware and Software Requirements ........................................... 170
- Installing DKA ................................................................. 170
  - Creating a Shortcut ....................................................... 174
- Adding the KDS network client in Dial-up Networking .................. 175
  - Configure the Type of Dial-Up Server ................................ 177
- Downloading from KDS .......................................................... 178
  - Establish the PPP connection to the KDS server via
    Dial-up Networking ...................................................... 179
- Reading from a File ............................................................ 185
- Manually entering a keycode .................................................. 186

The Distributor Keycode Application (DKA) is a Windows 95® based utility program which enables distributors to download keycodes from a remote server (known as Keycode Delivery Server (KDS)). DKA makes use of a standard Wizard Windows 95 interface to guide the user’s operation.

Note: Electronic retrieval of keycodes via DKA is not supported in European markets. If you are downloading keycodes from Europe, please refer to “Using the Keycode Retrieval Utility” on page 189.

This section contains the following procedures:

- “Installing DKA” on page 170
“Adding the KDS network client in Dial-up Networking” on page 175
• “Downloading from KDS” on page 178
• “Reading from a File” on page 185
• “Manually entering a keycode” on page 186

Note: The “Installing DKA” and “Adding the KDS connection in Dial-Up Networking ®” procedures must be completed before the “Downloading from KDS” procedure can be performed.

Hardware and Software Requirements

To install and use the DKA program, certain requirements must be met:
• You must have an PC or compatible computer with a Pentium or compatible Intel processor running the Windows 95 or Windows 95B operating system.
• A modem that supports 14.4kbps or less must be installed and configured on your PC. To ensure that a modem is configured correctly under Windows 95, you must configure a modem through the Control Panel (using 8 data bits, Parity None, Stop Bits 1). Additionally, the modem must be configured with the correct Dial Prefix (Access Code) used by your telephone system to access an outside line. This modem must access a standard analog telephone line.
• Approximately 5 MB free hard drive space for installation of the DKA program and, if desired, storage of keycodes.
• Microsoft Dial-up Networking software must be installed on the PC (provided with Windows 95)
• The following procedures must be performed before downloading keycodes: “Installing DKA.” and “Adding the KDS connection in Dial-Up Networking ®.”

Installing DKA

Once you have checked that your PC and modem meet the system requirements listed above, you are ready to install the DKA program onto your PC. Once the program is installed, you will make a Shortcut to the program. This Shortcut will appear on your Windows 95 desktop. Double-clicking this Shortcut will give you easy access to the program.
The DKA program is installed as follows:

1. Locate the DKA Installation diskette.
2. Insert the diskette, label facing upwards, into the floppy drive on your PC.
3. Run the Windows Explorer application by clicking and dragging the Start button on the lower left corner of the screen. Drag the Start button to Program Files then Windows Explorer.
4. In the Windows Explorer application, click the 3.5" Floppy drive (A:) from the left side of the window.
5. In the right side of the window, double-click the Setup.exe file (which has a computer icon to the left of it).

Wait for the Setup program to prepare for installation.

The Identification Screen is displayed.

6. Enter the requested information in the Name and Company fields.
7 Click **Next** or press return.

The Software License screen is displayed. This screen contains a scrollable text box that contains the legal agreement governing the use of the DKA software.

8 If you accept the terms of the license agreement, click the **Next** button. If you do not accept, click **Cancel** and the program installation will be stopped.

The Destination Directory screen appears. This screen indicates that the DKA program will be installed on the hard drive in a folder called DKA.

9 Click **Next** or press return.

The Read Note screen appears. This screen is used to read any Read me files for the DKA program.
10. Read the contents of the Read Me files: Select file, then click **Open**. Click **Next** or press return.
The Install Completed screen appears. This screen indicates that the Distributor Keycode Application has been successfully installed on your PC.

11 Click the **Finish** button to close the setup program.

**Creating a Shortcut**

To make the Distributor Keycode Application easier to access, create a Shortcut by doing the following:

1. Select the dka.exe file located in the DKA folder on the (C:) drive.
2. Click on the File menu and drag down to **Create Shortcut**.
   
   A file called **Shortcut to dka.exe** appears in the DKA folder.
3. Click and drag the **Shortcut to dka.exe** file to a convenient location on your desktop and release.

   Now the Distributor Keycode Application may be accessed easily by double-clicking on the **Shortcut to dka.exe** file on the desktop.
Adding the KDS network client in Dial-up Networking

Before you can download keycodes, you must configure the Dial-up Networking KDS client, as described below. Dial-up Networking stores and manages all communication parameters (phone number, dial prefixes, user name, password, etc.) necessary for connecting to the Keycode Download Server.

1. Click the **Start** button on the lower left corner of the PC desktop and drag to **Programs|Accessories|Dial-up Networking**.

2. Double-click the **Make a New Connection** icon in the Dial-Up Networking window and enter the following:

   **Type a name for the computer you are dialing:**

   Richardson KCD Server 1 (example)

   **Select a modem:**

   The modem must support 14.4kbps or less with the following configuration: **Data Bits 8, Parity None, Stop Bits 1**
3 Click **Next** and enter the following for regions where the 888 Area Code is available:

Enter the Area Code as follows: 888

Telephone Number: 685-3923

Country code: United States of America

**Note 1:** The information entered in the Make New Connection window must match this information. If you using DKA in a market other than the United States of America, ensure that the Area Code, Telephone Number, Dial Prefix, and Country code are configured correctly.

**Note 2:** In regions where the 888 Area Code is not applicable, the number which must be substituted is: **(972) 685-1764**. This number must be configured in Dial-Up Networking.

4 Click **Next**.

You will receive a message that you have successfully created a new Dial-Up Networking connection. Click **Finish** or press return to complete the procedure.
Configure the Type of Dial-Up Server

1. Click the Start button on the lower left corner of the PC desktop and drag to Programs|Accessories|Dial-up Networking.

2. Click on Richardson KCD Server 1.

3. Select the File menu and choose Properties.

4. Click Server Type... to continue.

5. Configure the Server Type window with the following information:
   - Type of Dial-Up Server: PPP Windows 95 Windows NT 3.5 Internet Advanced
   - Advanced’s: Enable software compression
   - Advanced network protocols: TCP/IP
   - TCP/IP Settings....: use the default settings

6. Click OK or press return.

7. Click OK again to return to the Dial-Up Networking window.
Download from KDS

The following procedure is used to request and receive keycodes from a remote server, known as KDS (Keycode Delivery Server). This procedure assumes that you have already installed the DKA program as described in “Installing DKA” on page 170, and have added and configured the Dial-up Networking client as described in “Adding the KDS network client in Dial-up Networking” on page 175.
Establish the PPP connection to the KDS server via Dial-up Networking

1. Double click on the Richardson KCD Server 1 Dial-Up Networking client. Enter user name “nortel-keycode” and password “97enable.” Click the Connect button and verify that the modem dials a call and the Dial-Up Networking client successfully connects to the Richardson KCD Server 1.

   Once the Dial-up Networking PPP connection has been established, continue with the download by starting the DKA application:

2. Double-click on the Shortcut to DKA icon on the PC desktop.

   A gray screen appears that includes four menus and a Toolbar with buttons for essential commands.
3 Click on the **Tools** menu and select **Download Keycodes**.

The KDS Welcome screen appears.

4 Click **Next** or return to download a keycode from KDS.

The Build a Request List screen is displayed. This screen has four information fields which must be completed for each keycode request that is submitted.
5 Enter the information into the four fields as described in Table 8 on page 181.

Table 8 “Build a Request List” fields

<table>
<thead>
<tr>
<th>Name of field</th>
<th>How the information is entered in the field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Name</td>
<td>Select the product family of the system for which you are requesting a keycode.</td>
</tr>
<tr>
<td>System ID</td>
<td>Enter the System ID for the system for which you are requesting a keycode.</td>
</tr>
<tr>
<td>NTI Number</td>
<td>Click in the field and type in the NTI Number for the system for which you are requesting a keycode (the NTI Number is the same as the NT order number).</td>
</tr>
<tr>
<td>File Name</td>
<td>Enter a file name for the keycode you will be downloading. If the keycode will be downloaded to the hard drive ((C:) drive), use the following file naming convention: c:\DKA&lt;System ID&gt;\NTI Number&gt;. When you click Add, a.kcd file extension is added to the file name. If the keycode will be downloaded to a floppy diskette in the 3.5” Floppy drive (A:), the file name must be named “keycode” so the Meridian 1 can recognize the file. When you click Add, a.kcd file extension is added to the file name.</td>
</tr>
</tbody>
</table>

6 Click Add to continue. The request will appear in the Request List scroll box. When a request is added to the list, another request may be added by filling out the fields with information for another keycode, and again clicking the Add button. To remove a request from the list, select the request in the Request List scroll box and click the Delete button.

7 Click the Next or press return.

The KDS Billing Notice screen is displayed.
8  Enter the information in Table 8 on page 181 into the KDS Billing Notice screen.

Table 9
Fields on the KDS Billing Notice screen

<table>
<thead>
<tr>
<th>Name of field</th>
<th>How the information is entered in the field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distributor Name</td>
<td>Enter the name of the Distributor who is requesting the keycode(s).</td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the name of the person requesting the keycode(s).</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>Enter the telephone number that can be used to contact the individual who is requesting the keycode(s).  For example: (408) 555-1212.</td>
</tr>
</tbody>
</table>

9  Click the **Next** button or press return.

10 Click **Next** or press return.

The KDS Download screen is displayed.

**Note:** The Dial-up Networking connection must have been established, as described in “Establish the PPP connection to the KDS server via Dial-up Networking” on page 179.
11 Click **Start** to begin downloading the keycode(s).

**Note:** This starts the keycode download process. A socket connection is established over the existing PPP connection. Next, the provided login information is sent to the Keycode Delivery Server and verified. Then the requested keycodes are downloaded to your PC in the location you specified in the Build a Request List window. Status is displayed in the Download Status box.

![KDS Download](image)
12 Click **Next** to receive the “KDS Download Results” screen, summarizing the results of the download.

13 Double-click the network icon in the lower right corner of the screen.

14 The Dial-up Networking status window appears. Click the **Disconnect** button to end the connection to the network.

The “Download from KDS” procedure is complete. Refer to “Keycode Management, LD 143” in this document for keycode installation instructions.

If there was a problem downloading keycodes, the problem keycodes are listed in the “Unsuccessfully downloaded keycodes” scroll box.

**Note:** If the download was unsuccessful, verify that the correct telephone number and Dial Prefix are configured in Dial-up Networking.
When the requested keycode is downloaded from the Keycode Delivery System to your PC, refer to “Adding features and ISM limits” on page 53 for keycode installation procedures.

Reading from a File

The following procedure is used to learn information about the properties of an existing keycode, or a keycode that was just downloaded from KDS. In this procedure you will specify a keycode file in a location on your hard drive or on a floppy diskette that is inserted in your floppy disk drive.

You will also specify a “Product type” to examine within the keycode file, in case there are multiple keycodes within the keycode file being examined.

This procedure assumes that you have already installed the DKA program as described in “Installing DKA” on page 170.

1. Double-click on the Shortcut to DKA icon on the PC desktop.

2. Select Open from the File menu.

   A navigation dialog box appears. In the navigation dialog box, locate the keycode. For a keycode residing on a floppy drive, this is the 3.5" Floppy drive (A:); for a keycode residing on the hard drive, this is most likely the C: drive.

3. Click OK.
The Keycode file is displayed in a format similar to the hardcopy Keycode Acknowledgment sent to a customer. The Keycode itself is displayed at the bottom of the file, in 21 rows of 16 characters each.

The “Reading from a File” procedure is complete.

Manually entering a keycode

The following procedure is used to manually enter a keycode for the purpose of creating and storing a keycode file.

This procedure assumes that you have already installed the DKA program as described in “Installing DKA” on page 170.

1. Double-click on the Shortcut to DKA icon on the PC desktop.
2. Select Manual Entry from the Tools menu.
The Keycode Entry screen is displayed. This screen consists of rows and four columns (A-D) into which the keycode is entered four characters at a time. When 16 characters (four cells) are entered in a row, the program tries to validate that row. If the row does not validate, a red X appears to the left of that row to indicate invalidity.

The Clear All... button is used to erase all characters in the cells that have been entered on the Keycode Entry screen. A dialog box will prompt “Are you sure you want to clear the Keycode characters?” when this button is selected. Confirming the dialog erases all characters in all cells.
3 When the entire keycode has been entered, click the **Save...** button.

If the keycode is valid, the Save As screen is displayed. This screen allows you to specify the file name your keycode will be saved as and the directory where it will be saved.

4 From the **Save in** pull-down menu, select the drive location where you want to save the keycode.

5 In the **File Name** field, type the name you want your keycode file to be saved as. Note that the .kcd extension will be appended to that filename.

   To save the keycode file nested within folders, double-click on the folder in which the keycode file will ultimately be saved. When you have navigated to the folder where you would like to save the keycode file, click the **Save** button.

6 Click **Save** or press return.

   The keycode file has been saved as specified. The “Manually Entering a Keycode” procedure is complete.
Using the Keycode Retrieval Utility

Contents

The following are the topics in this section:

Applying for access .................................................. 189
Accessing Keycode Retrieval System application ............. 190
Meridian 1 Keycode Retrieval System ............................ 195

The Keycode Retrieval Utility is a Nortel Networks Customer Support service feature available to registered customers. The Keycode Retrieval Utility provides a full suite of online tools, services, resources and interactive capabilities.

The Keycode Retrieval Utility provides a tool for distributors to browse and retrieve keycodes. A distributor is considered to "own" a keycode once it has been manufactured and its associated order invoiced.

If you do not have access to the Keycode Retrieval System (KRS) web site, you must apply (register) for access, and wait one to two business days for your account to be activated, before the "Downloading keycodes" procedure.

Applying for access

If you do not have access to the KRS web site, use the following procedure to register.

1 Start your web browser software.
2 Enter the URL "http://www.nortelnetworks.com" in the Address or Net Site bar and press Return or Enter.
3 Click on the Customer Support menu, then choose Register.
Under the Products and Services banner, click on the “Register for Customer Support Products” bar.

Follow the Registration instructions provided.

Accessing Keycode Retrieval System application

Use the following procedure only after you have completed the Registration procedure and your User Name and Password are activated.

1. Start your web browser software.
2. Enter the URL "http://www.nortelnetworks.com" in the Address or Net Site bar and press Return or Enter.
3. Select Customer Support on the left side of the Nortel Networks home page.

4. Select Keycode Retrieval System.
Figure 4
Customer Support
In Step 1 on the Banner Page you can:

a. register for access to the KRS
b. if you have an account, select the login type

*Note:* See Figure 6 for a Step 1 example.

Proceed to Step 2 and select the product family for the keycode access.

*Note:* See Figure 7 for a Step 2 example.
Figure 6
Step 1 pull-down menu
Figure 7
Step 2 pull-down menu
Meridian 1 Keycode Retrieval System

7 Use this link to access the keycode application for the Meridian product line.

*Note:* A registered user will have access to all keycode applications for the various product lines displayed.

Figure 8
Keycode Retrieval System
Figure 9
View or Download Keycode
The following is an explanation of the Quick Links on left of screen:

- Retrieve by Site. Allows the user to specify a site ID and retrieve all keycodes for products associated with the entered site ID.
- Retrieve by Product. Allows the user to view Site I.D.’s sorted by product type.
- Retrieve by Date. Allows the user to retrieve all historic (previously produced) keycodes for a particular site ID.
- Retrieve by Custom Set. Allows the user to retrieve previously "grouped" keycodes by a custome label created by the user.
- Edit Custom Set. Allows the user to edit (add or delete) the contents of a custom set of keycodes.
- Compare. Allows the user to compare two keycodes of the same product type.
- Terms and Conditions. Legal disclaimers
- Download KMT. Takes the user to a site where the latest version of the KMT can be downloaded to the users desktop to manage keycodes. This client side application is only necessary for viewing downloaded keycodes when not connected to the website.
- Support. Provides the phone numbers or email address for support.
- Related Links. Takes the user to additional Nortel Networks keycode related sites.
- Feedback. Pops up an email reply that will allow the user to provide comments and suggestions back to the business owners of the KRS web site.
- FAQ and What’s New.
Figure 10
Keycode Management Tool

The Keycode Management Tool (KMT) application is used to view and compare keycode files that you have downloaded from the KRS web site.
Creating keycode diskettes

In addition to receiving a keycode diskette from Nortel Networks, a keycode diskette can be created onsite using the following methods:

- downloading a keycode from the Nortel Networks Keycode Distributor Server to a PC and creating a diskette (see “Using the Distributor Keycode Application” in this document for more information)

- entering a keycode manually using the commands in LD 143. Using this method, the keycode is entered as 21 lines of 16 characters. The keycode file is then saved to a 2 MB diskette in the floppy drive.

- entering a keycode manually in the Meridian 1 Software Installation Tool. Using this method, the keycode is entered as 21 lines of 16 characters. The keycode file is then saved to a 2 MB diskette in the floppy drive.

- All keycode files must be named keycode with no extension.

When the keycode diskette is created, the keycode is entered into the system:

- using the KNEW command in LD 143 or,
- using the Software Installation Tool

The keycode is activated on the next system sysload.
Increasing A0810496, and NT4N64 CP PII memory

Contents

The following are the topics in this section:

Reference list ................................................................. 202
Description ................................................................. 202
Operating parameters ...................................................... 202
Upgrading for Release 25.40 or later software ......................... 203
Perform simultaneous software and memory upgrade ............... 203
  Back up current data ................................................... 203
  Test system redundancy ............................................... 205
  Make Core 0 active .................................................... 205
  Split the Cores ......................................................... 206
  Upgrade Core 1 ......................................................... 206
  Memory upgrade ....................................................... 207
  Install the software on Core/Net ................................... 214
  Transfer call processing from Core/Net 0 to Core/Net 1 ........ 226
  Upgrade Core/Net 0 ..................................................... 227
  Enable system redundancy .......................................... 227
  Test Core/Net 1 and Core/Net 0 .................................... 228
  Perform a data dump ................................................... 230
Back out of a system software and hardware upgrade .............. 231
  Make Core 0 active ..................................................... 231
  Split the Cores ......................................................... 231
  Install the software on Core/Net 1 ................................. 232
  Transfer call processing from Core/Net 0 to Core/Net 1 ........ 244
  Test Core/Net 1 ........................................................ 245
Reference list

The following are references for this section:

- Hardware Replacement (553-3001-520)

Description

The latest release of system software is shipped with new Meridian 1 systems. Introduced with Release 25.40 is a Call Processor Pentium (CP PII) card with 256 MB memory and a 256 MB Memory Upgrade Kit (NT4N19AA) for existing CP PII cards with 128 MB memory. Refer to Table 10 on page 202 for Call Processor cards.

Table 10
Call Processor cards

<table>
<thead>
<tr>
<th>Call Processor</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0810496</td>
<td>Call Processor with 128MB</td>
</tr>
<tr>
<td>NT4N64AA Rel 01</td>
<td>Call Processor (A0810496) upgraded from 128MB to 256MB with the CP PII Memory Upgrade Kit (NT4N19AA) and faceplate label.</td>
</tr>
<tr>
<td>NT4N64AA Rel 02 (A0844698)</td>
<td>Call Processor with 256MB</td>
</tr>
</tbody>
</table>

Operating parameters

Option 81C CP PII systems with 6 or more network groups should upgrade their DRAM to 256 MB memory at the same time they upgrade to Release 25.40. Memory upgrades for existing systems consists of replacing the DIMM on the existing CP PII cards, or installing Release 02 CP PII cards with 256MB on board.

Mixed memory configurations are not supported.
Option 81C systems configured with the NT4N64AA Rel 01 or NT4N64AA Rel 02 call processor cards require a minimum of Release 25.40 software.

### Upgrading for Release 25.40 or later software

System upgrades fall into one of the following categories:

- An Option 51C/61C/81C CP2/CP3/CP4 upgrade to an Option 81C CP PII system. This is a major hardware upgrade/replacement. With Release 25.40 software, the 256 MB memory Call Processor card (NT4N64AA Rel 02) is used. Refer to *Hardware Replacement* (553-3001-520)

- An Option 81C CP PII with 128 MB memory upgrade to Release 25.40 software using the existing Call Processor card. This upgrade is not recommended for systems with six or more network groups.

- An Option 81C with 128 MB memory running Release 25.40 software upgrading to six or more network groups requires the NT4N64AA Rel 02 Call Processor card or the NT4N19AA Memory Upgrade Kits.

- An Option 81C CP PII with six or more network groups upgrading to Release 25.40 or later software using the NT4N64AA Rel 02 Call Processor card or the NT4N19AA Memory Upgrade Kits.

Use the tasks in this section to complete a software and memory upgrade.

### Perform simultaneous software and memory upgrade

Install software on both Core hard drives. Follow the tasks below in order to complete the installation.

**Note:** To complete these procedures, the system must be working in redundant mode and connected to a terminal.

### Back up current data

Before starting the upgrade check that:

- The system is operating in redundant mode. When the system is SPLIT, enter LD 135 and synchronize the memory and drives using the JOIN command.
• A backup copy of the customer database made with the data dump routine exists on 2 MB diskettes.

**CAUTION**

*Loss of Data*

Keep a backup copy of the database external to the switch when completing software/hardware upgrades.

---

**Procedure 1**

**Backup current data**

1. Load the Equipment Data Dump Program (LD 43). At the prompt, enter *LD 43* Load the program.

2. When “EDD000” appears on the terminal, enter *EDD* Begin the data dump.

3. When “DATABASE BACKUP COMPLETE” appears on the terminal, enter

**CAUTION**

*Loss of Data*

If the data dump is not successful, do not continue; contact your technical support group. Correct any data dump problem before you continue.

**** Exit the program.

——— **End of Procedure** ————
Test system redundancy

Procedure 2
Test system redundancy

1 Test system redundancy. At the prompt enter:
   - **LD 137**
   - **STAT** Get the status of the hard disks.
   - **TEST RDUN** Test redundancy
   - **DATA RDUN** Perform sector level checking on both hard disks
   - **TEST CMDU** Perform hard and floppy disk test.

2 Load LD 135 and check the status of the CPs, CNIs, and memory.
   - **LD 135**
   - **STAT CPU** Get the status of both CPUs and memory.
   - **STAT CNI** Get the status of all configured CNIs.

End of Procedure

Make Core 0 active

Either Core can be upgraded first. The decision to upgrade Core 1 first is for this example only.

Procedure 3
Make Core 0 active

1 If Core 1 is active, make Core 0 active. At the prompt enter:
   - **LD 135**
   - **STAT CPU** Get the status of the CPUs.
   - **SCPU** Switch to Core 0.

End of Procedure
Split the Cores

Procedure 4
Split the cores

1. From the active side, split the cores. At the prompt enter:
   
   LD 135
   SPLIT
   ****

   Enter Split on the active core.
   Exit program.

   The system is now in SPLIT mode.

-------------------------------- End of Procedure --------------------------------

Upgrade Core 1

Procedure 5
Upgrade Core 1

1. Determine which of the following upgrades the system requires:
   
   a. Upgrade the software to Release 25.40 using the existing hardware. Continue with the "Install the software on Core/Net" on page 214.
   
   b. Upgrade the system with the 256 MB memory Call Processor card and Release 25.40 software. Go to step 2.
   
   c. Upgrade the software to Release 25.40 and replace the DIMM on the existing CP PII card. Go to step 3.

2. Remove the call processor card from Core 1 and replace with the NT4N64AA Rel 02 call processor card. Refer to Hardware Replacement (553-3001-520) for card replacement. Continue with the "Install the software on Core/Net" on page 214.

CAUTION
Damage to Equipment

Nortel Networks recommends that only properly trained distributor personnel perform this memory DIMM upgrade. Upgrading memory on CP cards involves some risk of damage to DIMM and the CP card. Personnel performing this upgrade do so at their own risk.
CAUTION
Service Interruption

Personnel should have spare CP cards on hand or risk installation delay or system down time. Nortel Networks assumes no responsibility for any damage incurred, installation delays due to board damage, or loss due to damage or system down time.

3 Remove the Call Processor card from Core 1 and replace the memory module with the NT4N19AA Memory Upgrade Kit. Follow the steps provided in “Memory upgrade” on page 207.

End of Procedure

Memory upgrade

Procedure 6
Upgrade memory

1 Remove all cables connected to the faceplate of the standby Call Processor card on Core 1.

2 Hot unplug the card and place with the DIMM side-up on a flat, clean surface.

3 Hold the latches of the DIMM socket. See Figure 11 on page 208.
4 Press and rotate the latches from inside to outside carefully. See Figure 12 on page 209.
5  Remove the 128 MB memory module.
6  Keep the latches open and insert the 256MB module into the DIMM socket. Align the two notches on the module with the two keys in the DIMM socket. See Figure 13 on page 210.
Hold the memory module as in Figure 14 on page 211.
Push the module into the DIMM socket until it is locked by the latches. See Figure 15 on page 212.
9  Put the faceplate label on the faceplate of the card. See Figure 16 on page 213.
10 Return the card to its slot and reconnect all original cables.
Continue with the “Install the software on Core/Net” on page 214.

__________________________ End of Procedure ____________________________
Install the software on Core/Net

Procedure 1
Install software on Core/Net 1

1. Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:
   a. Press the button on the CD-ROM drive to open the CD-ROM disk holder.
   b. Place the CD-ROM disk into the holder with the disk label facing up. Use the four tabs to secure the CD-ROM disk.
   c. Press the button to close the CD-ROM disk holder. Do not push the holder in by hand.

   Note: If the CD-ROM is not in the CD-ROM drive, the installation will not continue. Insert the CD-ROM to continue.

2. Place the CP PII Install floppy disk into the cPCI MMDU floppy drive.

3. Press the RESET button on the CP PII. Press <CR> when prompted. Before the install menu runs, the system validates hard disk partitioning.

   Note: If a problem is detected during the system verification, the installation stops, prints an error message, and aborts. If the verification is not successful, do not continue; contact your technical support organization.
The screen displays:

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version 28)

**
**** ** ****
**** ***** **********
*************** Nortel Networks - Meridian 1
**** **** **** Install Tool (Version 28)
**** **** ****
**** *****************
**** ****** ******

Copyright 1992 - 2001 Nortel Networks

Please press <CR> when ready ...

> OBTAIN and CHECK SYSTEM CONFIGURATION
> Validate hard disk partitions
> Do physical checking for hard drive, it will take five to six minutes.

Testing partition 0
100 percent completed!
Testing partition 1
100 percent completed!
Testing partition 2
100 percent completed!
Disk physical checking is completed!
Validate hard drive partition number and size ...

There are 3 partitions in disk 0:
The size of partition 0 of disk 0 is xx MB
The size of partition 1 of disk 0 is xx MB
The size of partition 2 of disk 0 is xx MB
Disk partitions and sectors checking is completed!

dosFsCheck for PART_C OK!
dosFsCheck for PART_D OK!
dosFsCheck for PART_E OK!
dosFsCheck is completed!
> Copy /f0/disk3311.sys to /u/disk3311.sys -

System Date and Time now is:
Friday 01-05-2001, 15:49:16
4  Press <CR> on the terminal to start the software installation from the following menu.

<table>
<thead>
<tr>
<th>Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version 28)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAIN MENU</td>
</tr>
<tr>
<td>The Software Installation Tool will install or upgrade Meridian-1 System Software, Database and the CP-BOOTROM. You will be prompted throughout the installation and given the opportunity to quit at any time.</td>
</tr>
<tr>
<td>Please enter:</td>
</tr>
<tr>
<td>&lt;CR&gt; -&gt; &lt;u&gt; - To Install menu</td>
</tr>
<tr>
<td>&lt;t&gt; - To Tools menu.</td>
</tr>
<tr>
<td>&lt;q&gt; - Quit</td>
</tr>
</tbody>
</table>

Enter Choice>

5  Insert keycode diskette.

<table>
<thead>
<tr>
<th>Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version 28)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please insert the diskette with the keycode file into the floppy drive.</td>
</tr>
<tr>
<td>Please enter:</td>
</tr>
<tr>
<td>&lt;CR&gt; -&gt; &lt;a&gt; - Continue with the keycode validation</td>
</tr>
<tr>
<td>(the keycode diskette is in the floppy drive on Core 1).</td>
</tr>
<tr>
<td>&lt;q&gt; - Quit.</td>
</tr>
</tbody>
</table>

Enter Choice>
6 Confirm that the keycode matches the CD ROM release.

The provided keycode authorizes the install of Release 25xx software (all subissues) for machine type 3311 (CPP processor on Option 81C).

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version 28)

Please confirm that this keycode matches the CDROM Release

Please enter:

<CR> -> <y> - Yes, the keycode matches. Go on to Install Menu.  
<n> - No, the keycode does not match. Try another keycode diskette.

Enter Choice>
If the Keycode matches the CD ROM release, you are prompted to select an option from the following install menu.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version 28)

---

**IN S T A L L M E N U**

The Software Installation Tool will install or upgrade Meridian-1 System Software, Database and the CP-BOOTROM. You will be prompted throughout the installation and given the opportunity to quit at any time.

Please Enter:

- `<a>` To install Software, CP-BOOTROM.
- `<b>` To install Software, Database, CP-BOOTROM
- `<c>` To install Database only.
- `<d>` To install CP-BOOTROM only.
- `<t>` To go to the Tools menu.
- `<k>` To install Keycode only.
  - For feature Expansion, use OVL143.
- `<p>` To install 3900 set Languages.
- `<q>` Quit.

Enter Choice>

*Note:* Press <CR> to select option `<a>`. The default database is not installed; instead, the existing customer database is left on disk, and then converted at the next sysload.
8  Insert the CDROM is in the CDROM drive.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version 28)
======================================================================
Please insert the installation CDROM into the drive on Core 1.

The labeled side of the CDROM should be side up in the CDROM tray.

Please enter:
<CR> ->  <a> - CDROM is now in the drive. Continue with s/w checking.
         <q> - Quit.

Enter Choice>

9  Confirm the software version.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version 28)
======================================================================

The installation CDROM contains version Release 25xx__.

Please enter:
<CR> ->  <y> - Yes, this is the correct version. Continue.
         <n> - No, this is not the correct version. Try another CDROM or keycode disk.

Enter Choice>
10 Review the Installation Status Summary

<table>
<thead>
<tr>
<th>Option</th>
<th>Choice</th>
<th>Status</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW: CD to disk</td>
<td>yes</td>
<td></td>
<td>Install for rel 25xx</td>
</tr>
<tr>
<td>Database</td>
<td>no</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CP-BOOTROM</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Please enter:
<CR> - > <y> - Yes, start Installation.
<n> - No, stop Installation. Return to the Main Menu.

Enter Choice>

11 Confirm the Upgrade.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version 28)

You selected to upgrade the system from release: 25xx to release: 25xx.
This will erase all old system files.
Database files will NOT be erased. You may continue installing the software or quit now and leave your system unchanged.

Please enter:
<CR> - > <y> - Continue with Upgrade.
<q> - Quit.

Enter Choice>

Pre-release 3 language groups

12 Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series
sets.

Select one of the six PSDL files

<1> Global 10 Languages
<2> Western Europe 10 Languages
<3> Eastern Europe 10 Languages
<4> North America 6 Languages
<5> Spare Group A
<6> North America 6 Languages (Duplicate of <4>)

The languages contained in each selection are outlined as follows:

- 1 - English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- * 2 - English, French, German, Spanish, Swedish, Norwegian, Danish, Finnish, Italian, Brazilian Portuguese.
- * 3 - English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- * 4 - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
- * 5 - English, French, German, Spanish, Swedish, Italian, Norwegian, Portuguese, Finnish, Japanese Katakana.
- * 6 - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.

Release 3 language groups

Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series
The languages contained in each selection are outlined as follows:

- **1** – Global 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- **2** – Western Europe 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Danish.
- **3** – Eastern Europe 10 Languages (Release 3) English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- **4** – North America 6 Languages (Release 3) English, French, German, Spanish, Brazilian Portuguese, Japanese Katakana.
- **5** – Spare Group A.
- **6** – Spare Group B.

Continue with the installation.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version 28)

Software release 25xx was installed sucessfully on Core 1.
All files were copied from CDROM to the hard disk.

Please press <CR> when ready ...
15 Perform the CP-BOOTROM installation.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool
(Version 28)

You will now perform the CP-BOOTROM installation.

Note: You will be overriding existing CP-BOOTROM on hard
disk. If you quit, Bootrom will be left unchanged.

Please enter:
<CR> -> <a> - Continue with CP-BOOTROM install.
<q> - Quit.

Enter Choice>

16 Review the Status Summary.

<table>
<thead>
<tr>
<th>Option</th>
<th>Choice</th>
<th>Status</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW: CD to disk</td>
<td>yes</td>
<td>ok</td>
<td>from 2530_ to 2540</td>
</tr>
<tr>
<td>Database</td>
<td>no</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CP-BOOTROM</td>
<td>yes</td>
<td>ok</td>
<td></td>
</tr>
</tbody>
</table>

Please press <CR> when ready ...
17 Enter “q” to leave the installation program.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool
(Version 28)
=====================================================================
<table>
<thead>
<tr>
<th>IN S T A L L M E N U</th>
</tr>
</thead>
</table>
The Software Installation Tool will install or upgrade
Meridian-1 System Software, Database and the CP-BOOTROM.
You will be prompted throughout the installation and given the
opportunity to quit at any time.
Please enter:
<a> To install Software, CP-BOOTROM.
<b> To install Software, Database, CP-BOOTROM
<c> To install Database only.
<d> To install CP-BOOTROM only.
<t> To go to the Tools menu.
<k> To install Keycode only.
For feature Expansion, use OVL143.
<p> To install 3900 set Languages.
<q> Quit.

Enter Choice>

18 Enter “y” to confirm Quit.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool
(Version 28)
=====================================================================
You selected to Quit. Please confirm.
Please enter:
<CR> -> <y> - Yes, Quit.
<n> - No, DO NOT Quit.

Enter Choice>
19  Choose either Reboot or Return to the Main Menu

Note: Remove the Install diskette from the floppy drive(s) before rebooting.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool
(Version 28)

You selected to Quit the Software Installation Tool.
You may reboot the system or return to the Main Menu.
Before rebooting the system, remove Install diskette from the floppy drive(s).

DO NOT REBOOT USING BUTTON!!

Please enter:
<CR> ->  <a> - Reboot the system.
  <m> - Return to the Main menu.

Enter Choice>

20  The system automatically performs a sysload and several messages appear on the system terminal. Wait for “DONE” and then the “INI” message to display before you continue.

Database conversion occurs during sysload.
Verify that the following message appears on the system terminal:

DATA CONVERSION
RELEASE 25.XX TO RELEASE 25.XX

21  Confirm that Release 25.xx software is installed and is working on Core/Net 1:

LD 135     Load the program.
STAT CPU   Display the CPU status.
STAT CNI   Display the cCNI status.
STAT MEM   Display memory status on CPUs.
Check the software version.

Use LD 22 to print the software issue and release. At the prompt enter:

```
LD 22
REQ    ISS
****   Exit the program.
```

--- End of Procedure ---

Transfer call processing from Core/Net 0 to Core/Net 1

**CAUTION**

Service Interruption

The following procedure to transfer call processing causes service interruptions.

Time your procedure to minimize the effect of any breaks in service.

Procedure 2
Transfer call processing

1. From Core/Net 0, the active side, transfer call processing to the upgraded Core/Net 1. At the prompt enter:

```
LD 135
CUTOVR
```

Transfer call processing from active core to standby core. This will cause a service interruption.

Call processing is now switched from Core/Net 0 to Core/Net 1.

2. Test Call Processing. This includes the following:

a. Check for dial tone.

b. Make internal, external, and network calls.

c. Check attendant console activity.

d. Check DID trunks.

e. Check any auxiliary processors.

--- End of Procedure ---
Upgrade Core/Net 0

Start at “Upgrade Core 1” on page 206 and repeat the procedures for Core/Net 0.

Continue with the following procedures after completing “Check the software version.” on page 226.

Enable system redundancy

CAUTION
Service Interruption
The following procedure to transfer call processing causes service interruptions.
Time your procedure to minimize the effect of any breaks in service.

Procedure 3
Transfer call processing

1 Transfer call processing from the active core 1 to the standby core 0.
   At the prompt enter:
   
   LD 135
   CUTOVR Transfer call processing from active core to standby core. This will cause a service interruption.

   Note: The CUTOVR command is necessary to ensure that the second upgraded core is capable of call processing.

2 Test Call Processing. This includes, but is not limited to the following:
   a Check for dial tone.
   b Make internal, external, and network calls.
   c Check attendant console activity.
   d Check DID trunks.
   e Check any auxiliary processors.
Procedure 4
Enable system redundancy

1. From the active CPU, Core/Net 0, enable redundancy. At the prompt enter:
   - LD 135
   - JOIN
     Synchronize the memory and drives.

End of Procedure

Test Core/Net 1 and Core/Net 0

Procedure 5
Test both cores

From the active CPU, Core/Net 0, perform these tests:

1. Perform a redundancy sanity test using the following sequence. At the prompt enter:
   - LD 135
   - STAT CNI
     Get the status of the cCNI cards.
   - STAT CPU
     Get the status of the CPU and memory.
   - TEST CNI
     Test each cCNI card (core, slot).
   - STAT SUTL
     Get the status of the System Utility (main and transition) cards.
   - TEST SUTL
     Test the System Utility (main and transition) cards.
   - TEST IPB
     Test the Interprocessor Bus
   - TEST LCD
     Test the LCDs.
   - TEST LED
     Test the LEDs.

2. Test system redundancy. At the prompt enter:
   - LD 137
   - STAT
     Get the status of the hard disks.
   - TEST RDUN
     Test redundancy
   - DATA RDUN
     Perform sector level checking on both hard disks
   - TEST CMDU
     Perform hard and floppy disk test.

3. Switch to the inactive CPU. At the prompt enter:
   - LD 135
   - SCPU
     Switch to the inactive CPU, Core/Net 1
4  Test Core/Net 1. At the prompt enter:
   LD 135
   STAT CNI  Get the status of cCNI (both main and transition) cards.
   STAT CPU  Get the status of both Cores and redundancy.
   TEST CNI  Test the cCNI (both main and transition) cards.
   STAT SUTL Get the status of the System Utility card.
   TEST SUTL Test System Utility card.
   TEST IPB  Test Interprocessor Bus.
   TEST LCD  Test LCDs.
   TEST LED  Test LEDs

5  Clear the display and minor alarms on both Cores. At the prompt enter:
   CDSP     Clear the displays on the Cores.
   CMAJ     Clear all major alarms.
   CMIN ALL Clear all minor alarms.
   ****     Exit the program.

6  If desired, switch back to Core/Net 0. At the prompt enter:
   LD 135
   SCPU     Switch to the inactive CPU, Core/Net 0

-------------------------------  End of Procedure  -----------------------------
Perform a data dump

Procedure 6
Perform a data dump

1  At the prompt, enter
   LD 43       Load the program

2  Insert a floppy disk into the cPCI MMDU to capture the backup.

3  When "EDD000" appears on the terminal, enter
   EDD       Begin the data dump

4  When "DATABASE BACKUP COMPLETE" appears on the terminal, enter

   CAUTION
   Loss of Data
   If the data dump is not successful, do not continue; contact your technical support group. Correct any data dump problems before you continue.

   ****     Exit the program

   The parallel reload procedure is complete.

------------------------------------------ End of Procedure ------------------------------------------
Back out of a system software and hardware upgrade

To back out of a CP PII system software and hardware upgrade the following tasks must be completed.

- Determine which core is active.
- Split the cores.
- Revert to the old memory configuration, if required.
- Install the original release of software.

Perform the following procedures in order.

Make Core 0 active

Either Core can be downgraded first. The decision to downgrade Core 1 first is for this example only.

Procedure 7
Make Core 0 active

1. If Core 1 is active, make Core 0 active. At the prompt enter:
   - LD 135
   - STAT CPU Get the status of the CPUs.
   - SCPU Switch to Core 0.

Split the Cores

Procedure 8
Split the cores

1. From the active Core 0, split the cores. At the prompt enter:
   - LD 135 Load the program.
   - SPLIT Enter Split on the active core.
   - **** Exit the program.

The system is now in split mode.

-------------------------- End of Procedure --------------------------
Install the software on Core/Net 1

Procedure 9
Install the original release of software

1 Install the CD-ROM into the CD-ROM drive in the cPCI MMDU:
   a. Press the button on the CD-ROM drive to open the CD-ROM disk holder.
   b. Place the CD-ROM disk into the holder with the disk label facing up. Use the four tabs to secure the CD-ROM drive.
   c. Press the button again to close the CD-ROM disk holder. **Do not** push the holder in by hand.

   *Note*: If the CD-ROM is not in the CD-ROM drive, the installation will not continue. Insert the CD-ROM to continue.

2 Place the Install diskette with the original software release into the cPCI MMDU floppy drive.

3 Press the manual RESET button on the CP PII card faceplate. Before the install menu runs, the system validates hard disk partitioning which takes about five minutes.

   *Note*: If a problem is detected during the system verification, the installation stops, prints an error message, and aborts. If the verification is not successful, do not continue; contact your technical support group.

   The screen displays:
>OBTAIN and CHECK SYSTEM CONFIGURATION
>Validate hard disk partitions
>Do physical checking for hard drive, it will take five to six minutes.
>Please wait ... 
>Testing partition 0
>100 percent completed!
>Testing partition 1
>100 percent completed!
>Testing partition 2 
>100 percent completed!
> Disk physical checking is completed!
>Validate hard drive partition number and size ...
>There are 3 partitions in disk 0:
>The size of partition 0 of disk 0 is xx MB
>The size of partition 1 of disk 0 is xx MB
>The size of partition 2 of disk 0 is xx MB
> Disk partitions and sectors checking is completed!
dosFsCheck for PART_C OK!
dosFsCheck for PART_D OK!
dosFsCheck for PART_E OK!
dosFsCheck is completed!
>Copy /f0/disk3311.sys to /u/disk3311.sys -
> System Date and Time now is:
> Friday 01-05-2001, 15:49:16
4 Press <CR> on the terminal to start the software installation from the following menu.

```
Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool
(Version xx)
====================================================================
MAIN MENU
The Software Installation Tool will install or upgrade
Meridian-1 System Software, Database and the CP-BOOTROM.
You will be prompted throughout the installation and given the
opportunity to quit at any time.

Please enter:
<CR> -> <u> - To Install menu
<t> - To Tools menu.
<q> - Quit

Enter Choice>
```

5 Insert keycode diskette.

```
Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool
(Version xx)
====================================================================
Please insert the diskette with the keycode file into the floppy drive.

Please enter:
<CR> -> <a> - Continue with the keycode validation
               (the keycode diskette is in the floppy drive on Core 1).
          <q> - Quit.

Enter Choice
```
6 Confirm that the keycode matches the CD ROM release.

The provided keycode authorizes the install of Release 25xx__ software for generic 3311 (CPP processor on Option 81C).

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version xx)

===================================================================== 
Please confirm that this keycode matches the CDROM Release

Please enter:

<CR> -> <y> - Yes, the keycode matches. Go on to Install Menu.
<y> - No, the keycode does no match. Try another keycode diskette.

Enter Choice>
When the screen displays the Install Menu, enter choice “b” to install the database.

**Note:** The database has to be reinstalled. A database cannot be converted down.

---

**Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool**  
(Version xx)

**INSTALL MENU**

The Software Installation Tool will install or upgrade Meridian-1 System Software, Database and the CP-BOOTROM. You will be prompted throughout the installation and given the opportunity to quit at any time.

Please enter:

- `<a>` To install Software, CP-BOOTROM.
- `<b>` To install Software, Database, CP-BOOTROM
- `<c>` To install Database only.
- `<d>` To install CP-BOOTROM only.
- `<t>` To go to the Tools menu.
- `<k>` To install Keycode only.  
  For feature Expansion, use OVL143.
- `<p>` To install 3900 set Languages.
- `<q>` Quit.

Enter Choice>
8. Insert the CDROM into the CDROM drive.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool
(Version xx)
======================================================================
Install utility will install Release 25xx s/w for software generic 3311 (CPP processor on Option 81C) on your system. Please insert the installation CDROM into the drive on Core 1.

The labeled side of the CDROM should be side up in the CDROM tray.

Please enter:
<CR> -> <a> - CDROM is now in the drive.
              Continue with installation.
<q> - Quit.

Enter Choice>

9. Review the Installation Status Summary.

+=================+========+========+========================+
|    Option       | Choice | Status |     Comment            |
+=================+========+========+========================+
|   SW: CD to disk| yes    |        | Install for rel 25xx   |
|   Database      | yes    |        |                        |
| CP-BOOTROM      | yes    |        |                        |
+-----------------+--------+--------+------------------------+

Please enter:
<CR> -> <Y> - Yes, start Installation.
              <n> - No, stop Installation. Return to the Main Menu.

Enter Choice>
10 Confirm the Upgrade.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool
(Version xx)

You selected to upgrade the system from release: 25xx to release
25xx.
This will erase all old system files.
Database files will not be erased. You may continue installing
the software or quit now and leave your system unchanged.

Please enter:
<CR> -> <a> - Continue with Upgrade
<q> - Quit.

Enter Choice>

Pre-release 3 language groups

11 Select a PSDL file to install. The PSDL file contains the loadware for
all downloadable cards in the system and loadware for M3900 series
sets.

Select one of the six PSDL files
<1> Global 10 Languages
<2> Western Europe 10 Languages
<3> Eastern Europe 10 Languages
<4> North America 6 Languages
<5> Spare Group A
<6> North America 6 Languages (Duplicate of <4>)

The languages contained in each selection are outlined as follows:

- 1 - English, French, German, Spanish, Swedish, Italian,
Norwegian, Brazilian Portuguese, Finnish, Japanese
Katakana.
- * 2 - English, French, German, Spanish, Swedish, Norwegian,
Danish, Finnish, Italian, Brazilian Portuguese.
- * 3 - English, French, German, Dutch, Polish, Czech,
Hungarian, Russian, Latvian, Turkish.

- *4* - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.
- *5* - English, French, German, Spanish, Swedish, Italian, Norwegian, Portuguese, Finnish, Japanese Katakana.
- *6* - English, Spanish, French, Brazilian Portuguese, Japanese Katakana, German.

**Release 3 language groups**

12 Select a PSDL file to install. The PSDL file contains the loadware for all downloadable cards in the system and loadware for M3900 series sets.

**Select one of the six PSDL files**

- **<1>** Global 10 Languages
- **<2>** Western Europe 10 Languages
- **<3>** Eastern Europe 10 Languages
- **<4>** North America 6 Languages
- **<5>** Spare Group A
- **<6>** North America 6 Languages (Duplicate of **<4>**)

The languages contained in each selection are outlined as follows:

- 1 – Global 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Japanese Katakana.
- 2 – Western Europe 10 Languages (Release 3) English, French, German, Spanish, Swedish, Italian, Norwegian, Brazilian Portuguese, Finnish, Danish.
- 3 – Eastern Europe 10 Languages (Release 3) English, French, German, Dutch, Polish, Czech, Hungarian, Russian, Latvian, Turkish.
- 4 – North America six Languages (Release 3) English, French, German, Spanish, Brazilian Portuguese, Japanese Katakana.
- 5 – Spare Group A.
- 6 – Spare Group B.
13 Continue with the installation.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version xx)

===============================================================
Software release 25xx was installed successfully on Core 1.
All files were copied from CDROM to the hard disk.

Please press <CR> when ready ...

14 Install the archived database from the backup diskette.

**Note:** Insert the archived database diskette into the floppy drive.

Select option “a” from the following menu.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool (Version xx)

===============================================================
You will now perform the database installation.
Note: If you are installing the Database from a floppy disk,
please insert the correct disk now.

Please enter:
<CR> -<a> Install CUSTOMER Database
    (the customer database diskette must be in the
    core 1 disk drive)
    <b> Install DEFAULT Database.
    <c> Transfer the previous system Database.
    <e> Check the Database that exists on the hard disk.
    <q> Quit.

Enter Choice>
15 Perform the CP-BOOTROM installation.

Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool
(Version xx)

You will now perform the CP-BOOTROM Installation.
Note: You will be overriding existing CP-BOOTROM on hard disk.
    If you quit, BOOTROM will be left unchanged

Please enter:
<CR> -> <a> Continue with CP-BOOTROM install.
       <q> Quit.

Enter Choice>

16 Review the Installation Status Summary

<table>
<thead>
<tr>
<th>Option</th>
<th>Choice</th>
<th>Status</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW: CD to disk</td>
<td>yes</td>
<td>ok</td>
<td>from 25xx to 25xx</td>
</tr>
<tr>
<td>Database</td>
<td>yes</td>
<td>ok</td>
<td>from 25xx to 25xx</td>
</tr>
<tr>
<td>CP-BOOTROM</td>
<td>yes</td>
<td>ok</td>
<td></td>
</tr>
</tbody>
</table>

Please press <CR> when ready ...
Enter "q" to leave the installation program.

Enter Choice>

Enter "y" to confirm Quit.

Enter Choice>
19  Choose either Reboot or Return to the Main Menu.

*Note:* Remove the database diskette from the disk drive before rebooting.

```
Nortel Meridian-1 Software/Database/BOOTROM CDROM INSTALL Tool
(Version xx)
======================================================================
You selected to Quit the Software Installation Tool.
You may reboot the system or return to the Main Menu.
Before rebooting the system, remove Install diskette from the floppy drive(s).
======================================================================
DO NOT REBOOT USING BUTTON!!
======================================================================
Please enter:
<CR> ->  <a> - Reboot the system.
           <m> - Return to the Main menu.
Enter Choice>
```

20  The system automatically performs a sysload and several messages appear on the system terminal. Wait for “DONE” and then the “INI” message to display before you continue.

Verify that the following message appears on the system terminal:

```
DATA CONVERSION
RELEASE 25.xx TO RELEASE 25.xx
```

21  Confirm that Release 25.xx software is installed and working on Core/Net 1:

- **LD 135**  Load the program.
- **STAT CPU**  Display the CPU status.
- **STAT CNI**  Display the cCNI status.
22 Check the software version.

Use LD 22 to print the software issue and release. At the prompt enter:

**LD 22**

**REQ**  ISS

**** Exit the program.

——— End of Procedure ————

Transfer call processing from Core/Net 0 to Core/Net 1

CAUTION
Service Interruption
The following procedure to transfer call processing causes service interruptions.
Time your procedure to minimize the effect of any breaks in service.

Procedure 10
Transfer call processing

1 From Core/Net 0, the active side, transfer call processing to Core/Net 1. At the prompt enter:

**LD 135** Load the program.

**CUTOVR** The inactive CP become active.

Call processing is now switched from Core/Net 0 to Core/Net 1.

——— End of Procedure ————
Test Core/Net 1

Test Call Processing. This includes, but is not limited to the following:

1. Check for dial tone.
2. Make internal, external, and network calls.
3. Check attendant console activity.
4. Check DID trunks.
5. Check any auxiliary processors.

Install the software on Core/Net 0

Start at “Install the software on Core/Net 1” on page 232 and repeat the procedures for Core/Net 0.

Continue with the following after completing “Check the software version.” on page 244.

Enable system redundancy

CAUTION
Service Interruption
The following procedure to transfer call processing causes service interruptions.
Time your procedure to minimize the effect of any breaks in service.

Procedure 11
Transfer call processing

1. Transfer call processing from the active core 1 to the standby core 0.
   At the prompt enter:

   LD 135
   CUTOVR
   Transfer call processing from active core to standby core. This will cause a service interruption.

   Note: The CUTOVR command is necessary to ensure that the second upgraded core is capable of call processing.
2 Test Call Processing. This includes, but is not limited to the following:

a Check for dial tone.
b Make internal, external, and network calls.
c Check attendant console activity.
d Check DID trunks.
e Check any auxiliary processors.

Procedure 12
Enable system redundancy

1 From the active CPU, Core/Net 0, enable redundancy. At the prompt enter:

LD 135
JOIN Synchronize the memory and drives.

End of Procedure
Test Core/Net 1 and Core/Net 0

Procedure 13
Test both cores

From the active CPU, Core/Net 0, perform these tests:

1. Perform a redundancy sanity test using the following sequence. At the prompt enter:
   - LD 135
   - STAT CNI Get the status of the cCNI cards.
   - STAT CPU Get the status of the CPU and memory.
   - TEST CNI Test each cCNI card (core, slot).
   - STAT SUTL Get the status of the System Utility (main and transition) cards.
   - TEST SUTL Test the System Utility (main and transition) cards.
   - TEST IPB Test the Interprocessor Bus
   - TEST LCD Test the LCDs.
   - TEST LED Test the LEDs.

2. Test system redundancy. At the prompt enter:
   - LD 137
   - STAT Get the status of the hard disks.
   - TEST RDUN Test redundancy
   - DATA RDUN Perform sector level checking on both hard disks
   - TEST CMDU Perform hard and floppy disk test.

3. Switch to the inactive CPU. At the prompt enter:
   - LD 135
   - SCPU Switch to the inactive CPU, Core/Net 1

4. Test Core/Net 1. At the prompt enter:
   - LD 135
   - STAT CNI Get the status of cCNI (both main and transition) cards.
   - STAT CPU Get the status of both Cores and redundancy.
   - TEST CNI Test the cCNI (both main and transition) cards.
   - STAT SUTL Get the status of the System Utility card.
   - TEST SUTL Test System Utility card.
Clear the display and minor alarms on both Cores. At the prompt enter:

- **CDSP** Clear the displays on the Cores.
- **CMAJ** Clear all major alarms.
- **CMIN ALL** Clear all minor alarms.
- ******** Exit the program.

If desired, switch back to Core/Net 0. At the prompt enter:

- **LD 135** Switch to the inactive CPU, Core/Net 0

---

End of Procedure ---
Perform a data dump

Procedure 14
Perform a data dump

1. At the prompt, enter
   LD 43   Load the program

2. Insert a floppy disk into the cPCI MMDU to capture the backup.

3. When “EDD000” appears on the terminal, enter
   EDD   Begin the data dump

4. When “DATABASE BACKUP COMPLETE” appears on the terminal, enter

   CAUTION
   Loss of Data
   If the data dump is not successful, do not continue; contact your technical support group. Correct any data dump problems before you continue.

   ****   Exit the program

   The software backout procedure is complete.

   ____________________________  End of Procedure  ____________________________
Postconversion procedure

Contents

The following are the topics in this section:

Postconversion steps .................................................. 252

This procedure verifies that the conversion process was successful, and system data converted completely. This is the last part of the total conversion procedure. Perform these steps after you have completed all other procedures for your system.

The site data should be printed before and after conversion (see Table 11 on page 255). If the data has changed, make the necessary updates on the Target release, and datadump to the new system media. You must print out the items marked with an asterisk (*) to be sure everything converted properly. All other items on Table 11 on page 255 are provided if you want to print them.

Check the General Release Bulletin (GRB), and the Conversion notes (earlier in this document) to verify any database updates that need to be made as a result of conversion. Be sure to verify all SYSxxx messages that may appear during the conversion process. These messages may indicate some database updates are required.

CAUTION

Service Interruption

Test call processing thoroughly. This can include more testing than is described in this procedure, depending on system configuration. This procedure is intended to show some of the basic tests performed to complete the conversion process.
Note: When parallel reload is complete, the attendant consoles will be in Night mode. If you are performing these procedures during the day, contact the attendant. If these procedures are taking place during the evening, you may not want to perform these call processing steps.

Postconversion steps

1. Print system data listed in Table 11, "Print site data," on page 255. Verify that all information matches the printouts created before conversions. Make changes if necessary.

2. From any unrestricted telephone, dial the access code for an outside line (usually 9), and dial the listed Directory Number (DN) for the customer. Verify that the correct Incoming Call Indicator (ICI) lights at the attendant console.

3. If the customer is equipped with more than one console, transfer the call to another console.

4. Extend the call to a telephone, and release the call from the console.

5. From the called telephone, transfer the call back to the attendant.

6. Answer and release the call.

7. From any telephone dial the DN for the attendant. Verify that the correct ICI lights at the console, then release the call.

8. Busy-out one trunk group using a Trunk Group Busy (TGB) key on the console.

9. From any telephone with TGAR 0-7, dial the access code of the busied-out trunk group, to verify that the call is intercepted to the console and receives either overflow tone or a recorded announcement.

10. Restore the trunk group to the in-service state using the Trunk Group Busy (TGB) key on the console.

11. During the conversion procedure the Central Office may have busied-out the DID trunks. If DID trunks are equipped, from any unrestricted telephone, dial the access code for an outside line, and dial a DID number into the system.

12. If a private network is used, from any unrestricted telephone, dial the network access code and place a CDP, ESN, BARS/NARS, or ISDN call as applicable to your system.
13 If not done previously, set the time and date. Note that if Call Detail Recording (CDR) is used, system message ERR225 will appear. This is normal.

LD 02
STAD dd mm yyyy hh mm ss

dd = day (for example, 05 for the fifth)
mm = month (for example, 09 for September)
yyyy = year (last 2 or all four digits, for example, 92 or 1992)
hh = hour (in 24-hour time, for example, 13:00 for 1:00 pm)
mm = minute (for example, 25)
ss = seconds (for example, 00)

14 If you have auxiliary processors working with your system, be sure they are powered up. Be sure the Application Module Links (AML) are up. DCH and AML messages may indicate problems during the conversion. Investigate any of these messages.

15 Keep one copy of the Source software, as it was backed up in the pre-conversion procedure, in case it becomes necessary to reconvert. After the Target software has been running well for a few weeks, return your original software to Nortel Networks through your distribution channel.

16 Load LD 135 to test and switch CPUs. (Omit this step for Option 51C.)

LD 135
TEST CPU Test CPU.
SCPU Switch CPUs.
**** To abort overlay.

17 Load LD 137 to get the status of the CMDUs and IOPs.

LD 137
STAT Get the status of both CMDUs and IOPs.
**** To abort overlay.

18 Load LD 43 to back up the other set of B1 disks. Insert the B1 disk in the active CMDU.

LD 43
BKO Back up to the backup disks and the active CMDU.
If not done previously, set the time and date. Note that if Call Detail Recording (CDR) is used, system message ERR225 will appear. This is normal.

19

LD 02

STAD dd mm yyy hh mm ss

dd = day (for example, 05 for the fifth)
mm = month (for example, 09 for September)
yyyy = year (last 2 or all four digits, for example, 92 or 1992)
hh = hour (in 24-hour time, for example, 13:00 for 1:00 pm)
mm = minute (for example, 25)
ss = seconds (for example, 00)

If you have auxiliary processors working with your system, be sure they are powered up. Be sure the Application Module Links (AML) are up. DCH and AML messages may indicate problems during the conversion. Investigate any of these messages.
Keep one copy of the Source software, as it was backed up in the pre-conversion procedure, in case it becomes necessary to reconvert. After the Target software has been running well for a few weeks, return your original software to Nortel Networks through your distribution channel.

Items marked with asterisks (*) are required printout for conversion. Other items are recommended for a total system status.

Table 11
Print site data (Part 1 of 3)

<table>
<thead>
<tr>
<th>Site data</th>
<th>Print command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal blocks for all TNs</td>
<td>LD 20</td>
</tr>
<tr>
<td></td>
<td>REQ  PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE  TNB</td>
</tr>
<tr>
<td></td>
<td>CUST  &lt;cr&gt;</td>
</tr>
<tr>
<td>Directory Numbers</td>
<td>LD 20 (LD 22 prior to Release 16)</td>
</tr>
<tr>
<td></td>
<td>REQ  PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE  DNB</td>
</tr>
<tr>
<td></td>
<td>CUST  &lt;cr&gt;</td>
</tr>
<tr>
<td>Attendant Console data block for all customers</td>
<td>LD 20</td>
</tr>
<tr>
<td></td>
<td>REQ  PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE  ATT, 2250</td>
</tr>
<tr>
<td></td>
<td>CUST  &lt;cr&gt;</td>
</tr>
<tr>
<td>*Customer data block for all customers</td>
<td>LD 21</td>
</tr>
<tr>
<td></td>
<td>REQ  PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE  CDB</td>
</tr>
<tr>
<td></td>
<td>CUST  &lt;cr&gt;</td>
</tr>
</tbody>
</table>
### Table 11
Print site data (Part 2 of 3)

<table>
<thead>
<tr>
<th>Site data</th>
<th>Print command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route data block for all customers</td>
<td>LD 21</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE RDB</td>
</tr>
<tr>
<td></td>
<td>CUST Customer number</td>
</tr>
<tr>
<td></td>
<td>ROUT &lt;cr&gt;</td>
</tr>
<tr>
<td></td>
<td>ACOD &lt;cr&gt;</td>
</tr>
<tr>
<td>*Configuration Record</td>
<td>LD 22</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE CFN</td>
</tr>
<tr>
<td>*Software Packages</td>
<td>LD 22</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE PKG</td>
</tr>
<tr>
<td>* Software Issue, ROM and tape ID</td>
<td>LD 22</td>
</tr>
<tr>
<td></td>
<td>REQ ISS</td>
</tr>
<tr>
<td></td>
<td>REQ ROM</td>
</tr>
<tr>
<td></td>
<td>REQ TID</td>
</tr>
<tr>
<td>* Peripheral software versions</td>
<td>LD 22</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE PSWV</td>
</tr>
</tbody>
</table>
Table 11
Print site data (Part 3 of 3)

<table>
<thead>
<tr>
<th>Site data</th>
<th>Print command</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACD data block for all customers</td>
<td>LD 23</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE ACD</td>
</tr>
<tr>
<td></td>
<td>CUST Customer Number</td>
</tr>
<tr>
<td></td>
<td>ACDN ACD DN (or &lt;CR&gt;)</td>
</tr>
<tr>
<td>Superloop card IDs and software version</td>
<td>LD 32</td>
</tr>
<tr>
<td>(peripheral controller, superloop network and controller cards)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>. IDC loop</td>
</tr>
<tr>
<td>Multi-purpose ISDN Signaling Processor (MISP) card</td>
<td>LD 27</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE MISP</td>
</tr>
<tr>
<td></td>
<td>LOOP loop number (0–158)</td>
</tr>
<tr>
<td></td>
<td>APPL &lt;cr&gt;</td>
</tr>
<tr>
<td></td>
<td>PH &lt;cr&gt;</td>
</tr>
<tr>
<td>DTI/PRI data block for all customers</td>
<td>LD 73</td>
</tr>
<tr>
<td></td>
<td>REQ PRT</td>
</tr>
<tr>
<td></td>
<td>TYPE DDB</td>
</tr>
</tbody>
</table>

*Note:* Items marked with asterisks (*) are required printout for conversion. Other items are recommended for a total system status.
Upgrading to a new Call Processor card

Contents

The following are the topics in this section:

- Upgrading to a new CP card in Options 61C, 81, or 81C . . . . . . . . . . . 260
- Performing a data dump . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261
- Splitting the cores . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261
- Upgrading Core 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 263
- Upgrading Core 0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 267
- Completing the upgrade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270
- Upgrading to a new CP card in an Option 51C . . . . . . . . . . . . . . . 271
- Performing a data dump . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 271
- Installing the new CP card and system software . . . . . . . . . . . . . . 272
- Completing the upgrade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275

Reference list

The following are the references in this section:

- Capacity Engineering (553-3001-149)
Upgrading to a new Call Processor card

This section contains procedures for performing CP card upgrades on Options 51C, 61C, 81, or 81C systems running Release 25 or later software.

Note: The procedures in the section can be used for NT9D19, NT5D10, and NT5D03 CP card memory configurations.

Note: There should be an SDI TTY connection at J30, which should remain connected at all times to monitor system status.

Upgrading to a new CP card in Options 61C, 81, or 81C

Use the following instructions if you are converting a system to release 24 and are installing NT9D19, NT5D10 or NT5D03 CP cards.

Installing a new CP card in an Option 61C, 81, or 81C consists of:

- splitting the CPUs
- installing a new CP card in Core 1
- upgrading the system software and CP ROMs on Core 1
- swapping CPUs
- installing a new CP card in Core 0
- upgrading the system software and CP ROMs on Core 0
- synchronizing the hard disks

CAUTION
Damage to Equipment

Personnel performing this upgrade do so at their own risk. Personnel should have spare CP cards on hand or risk installation delay and/or system down time. Nortel Networks assumes no responsibility for any damage incurred, system down time, or loss due to damage or down time.
Performing a data dump

Before starting the upgrade, make a backup copy of the customer database on 2MB diskettes using the data dump routine:

1. Log into the system.
2. Load the Equipment Data Dump Program (LD 43). At the prompt, enter LD 43 to load the program
3. When “EDD000” appears on the terminal, enter EDD to begin the data dump
4. When “DATADUMP COMPLETE” and “DATABASE BACKUP COMPLETE” appear on the terminal, enter

| CAUTION |
| Loss of Data |
| If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding. |

**** to exit the program

Splitting the cores

1. Verify that the disk drives are synchronized:
   LD 137 to load the program
   STAT to get the status of the disk drives

   If the disks are synchronized, proceed with step 2. If they are not synchronized, execute the SYNC command:
   SYNC to synchronize the drives
   **** to exit the program
2 Verify that clock controller 0 is active. If it is not, switch to clock controller 0:

LD 60 to load the program
SSCK 0 to get the status of clock controller 0
SWCK to switch to clock controller 0 (if necessary)
**** to exit the program

3 Verify that Core 0 is the active Core:

LD 135 to load the program
STAT CPU to check CPU status
TEST CPU to test the CPU

If Core 0 is active, proceed with step 5. If Core 0 is not the active CPU, swap Cores and verify again:

SCPU to swap CPUs
STAT CPU to check CPU status

4 Verify that CMDU 0 is active. You may need to switch CMDUs.

LD 137
STAT Get the status of IODU/C
SWAP Switch IODU/Cs (if necessary).

5 Set the MAINT/NORM switch on the CP card in Core 0 to MAINT.

6 Set the ENB/DIS switch on all CNI cards in Core 1 to DIS.

7 Perform the following three steps in uninterrupted sequence:
   • press and hold the MAN RST button on the CP card in Core 1
   • set the MAINT/NORM switch on the CP card in Core 1 to MAINT
   • release the MAN RST button
Upgrading Core 1

At this time you will install the new CP card and system software on Core 1 if it is not already installed on the hard drive.

1 Connect a terminal to the CPSI port in Core 1 to J25 of the I/O panel at the back of the core. Be sure it is configured as follows. The recommended baud rate is 9600, to be the same as the CPSI port.
   - 7 data bits
   - 1 stop bit
   - Space parity
   - Full duplex
   - XON protocol

2 Disengage the lock latches and remove the CP card from Core 1.

3 Insert the CP Install Program diskette which corresponds to the CP card to which you are upgrading into IODU/C 1 (68030, 68040, 68060 or 68060E).

4 Install the CD-ROM disk into the CD-ROM drive on the IODU/C in Core 1. To install the CD-ROM:
   - press the button on the CD-ROM drive to open the CD-ROM disk holder
   - place the CD-ROM disk into the holder with the disk label showing
   - press the button again to close the CD-ROM disk holder (don’t push the holder in by hand)

5 Verify that the MAINT/NORM switch on the new NT9D19, NT5D10 or NT5D03 CP card is set to MAINT.

6 Insert the new CP card in the same slot in Core 1 and secure the lock latches.
   A sysload will begin (cold start). Wait for the Main Menu to appear on the terminal before proceeding.

7 Press <CR> to continue.

8 Log into the system and enter the time and date, when prompted.
Initiate the database installation by selecting the following command from the menu:

<u> to Install menu

Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.

<a> to continue with keycode validation

<y> to confirm that the keycode matches the CD-ROM release
When the Install Menu is displayed, select the following options in sequence when you are prompted to do so:

- **<a>** to install software, CP-BOOTROM, and IOP-ROM
- **<a>** to verify that the CD-ROM is now in drive

The Installation Status Summary screen appears that lists the options to be installed.

- **<y>** Yes, start the installation
- **<a>** continue with upgrade

When the ROM installation screen appears, select the following prompts in sequence:

- **<a>** to install CP-ROM from hard disk
- **<a>** to continue with ROM upgrade

When all files are copied from the CD-ROM to hard disk, press **<CR>** to continue.

- **<a>** to install the IOP-ROM from hard disk
- **<y>** Yes, start installation
- **<a>** to continue with ROM upgrade

The Installation Status Summary screen appears. Verify that CD to disk, disk to ROM, CP-BOOTROM, and IOP-ROM were installed.

- **<cr>** press return to return to the Install Menu.
- **<q>** to quit (remove any diskettes from the floppy drive)
- **<y>** Yes, to confirm quit
- **<a>** to reboot the system

The system will automatically perform a sysload during which several messages will appear on the system terminal. Wait for “DONE” and then “INI” messages to be displayed before continuing.

**Note:** SYS4695 is not an error message. This message is cleared when you perform a data dump.
12 Set the ENB/DIS switches on all CNI cards in Core 1 to ENB.

**CAUTION**

Service Interruption

Disabling CNI cards in Core 0 will momentarily interrupt call processing. Calls established or in process will be dropped. Call processing will resume after the “SYSTEM INI” messages appear on the system terminal (approximately 1 minute).

13 Perform the following three steps in uninterrupted sequence:

- set the DIS/ENB faceplate switch on the IODU/C card in Core 0 to DIS
- set the ENB/DIS switch on all CNI cards in Core 0 to DIS
- press and release the MAN INT button on the CP card in Core 1

After the system initialization has finished (INI messages are no longer displayed on the system terminal), check for dial tone on a telephone set.

14 Following a successful dial tone test, perform the following basic sanity tests:

- Make sure calls can be placed.
- Check for error messages, line noise, chatter, or other problems. Track sources and resolve problems as necessary.
Upgrading Core 0

Once the CP card in Core 1 is upgraded, upgrade the CP card in Core 0 and install system software:

1. Connect a terminal to the CPSI port in Core 0 to J25 of the I/O panel at the back of the core. Be sure it is configured as follows. The recommended baud rate is 9600, to be the same as the CPSI port.
   - 7 data bits
   - 1 stop bit
   - Space parity
   - Full duplex
   - XON protocol

2. Verify that the MAINT/NORM switch on the CP card in Core 0 is set to MAINT.

3. Verify that the ENB/DIS switches on all CNI cards in Core 0 are set to DIS.

4. Disengage the lock latches and remove the CP card from Core 0.

5. Insert the Install diskette that corresponds with the CP card you will be installing into IODU/C 0.

6. Verify that the MAINT/NORM switch on the new NT9D19, NT5D10 or NT5D03 CP card is set to MAINT.

7. Insert the new CP card in the same slot in Core 0 and secure the lock latches.
   The system will perform a sysload and load the IODU/C Software Installation Tool.

8. When the NT Logo Screen appears on the terminal, the Software Installation Tool has loaded. Press <CR> to go to the Install Main Menu.
9 Set the system date and time. When prompted to enter the time and
date, enter it in the following format. A space or dash can be used to
separate the items.
   dd mm yyyy
   hh mm ss
or
   dd-mm-yyyy
   hh-mm-ss

10 At the Main menu select <u> to go to the Install menu.

11 Insert the Keycode diskette when prompted and select <a> to continue
   with the keycode validation.
   Once the keycode is validated against the Security Device, the Install
   menu is displayed.

12 When the Install menu appears, select the following options in
   sequence when you are prompted to do so:
   <o> to copy system software from Core 1 to Core 0.
   <y> to start installation
   <a> to continue with upgrade

13 At the Install menu, select the following options to install
   CP-BOOTROM:
   <e> to install CP-BOOTROM
   <y> to start the upgrade
   <a> to upgrade CP-BOOTROM from the hard disk drive

14 At the Install menu, select the following options to install IOP-ROM:
   <f> to install IOP-ROM
   <y> to start the upgrade
   <a> to upgrade IOP-ROM from the hard disk drive

15 Remove the diskette from IODU/C 0.
16. Select the following options to quit and reload the system:
   - `<q>` to quit
   - `<y>` to confirm quit
   - `<a>` to reboot the system

   The system will automatically perform a sysload and system initialization during which several messages will appear on the system terminal. Wait until initialization has finished (INI messages are no longer displayed on the system terminal) before continuing.

17. In Core 0, enable the NT6D65 CNI cards by setting the ENB/DIS faceplate switches to ENB.

18. Connect a terminal to the CPSI port in Core 1 to J25 of the I/O panel in the back of the core.

19. In Core 0, perform the following steps in uninterrupted sequence:
   - Press and release the MAN RST button
   - When SYS700 messages appear on CP0 LCD display, set the MAINT/NORM switch to NORM.

   Within 60 seconds, the LCD will display the following messages, confirming the process:

   **RUNNING ROM OS**
   **ENTERING CP VOTE**

   An "HWI534" message from the CPSI or SDI port indicates the start of memory synchronization. Within 10 minutes, an HWI533 message on Core 1 CPSI or SDI TTY indicates the memory synchronization is taking place. Wait until the memory synchronization is complete before continuing.

20. Set the MAINT/NORM switch on the CP card in Core 1 to NORM.

21. Synchronize the disk drives:
   - `LD 137` to load the overlay
   - `STAT` to get the status of both CMDUs, IOPs and redundancy
   - `SYNC` to synchronize the disk drives
   - `TEST CMDU` Performs hard and floppy disk test.
   - `****` to exit the program
Completing the upgrade

To complete the upgrade, verify CPU and CNI status and perform a data dump.

1. Verify CPU redundancy and CNI function:
   - LD 135 to load the overlay
   - STAT CPU to check the status of the CPU
   - STAT CNI to verify function of the CNIs
   - TEST CPU to test the CPU
   - SCPU to switch CPUs
   - STAT CPU to check the status of the CPU
   - STAT CNI to verify function of the CNIs
   - TEST CPU to test the CPU
   - SCPU to switch CPUs

   **** to exit the program

   Backup the customer database on 2MB diskettes.

2. Load the Equipment Data Dump Program (LD 43). At the prompt, enter
   - LD 43 to load the program

3. When “EDD000” appears on the terminal, enter
   - EDD to begin the data dump

4. When “DATADUMP COMPLETE” and “DATABASE BACKUP COMPLETE” appear on the terminal, enter

    CAUTION
    Loss of Data
    If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.

    **** to exit the program
Evaluate the number of call registers and telephone buffers that are configured for the system. Refer to *Capacity Engineering* (553-3001-149).

The CP card upgrade is complete.

**Upgrading to a new CP card in an Option 51C**

**CAUTION**

*Service Interruption*

Installing the NT9D19, NT5D10 or NT5D03 CP card in the Option 51C will require system downtime. Schedule for this when planning the system upgrade.

Power to the entire column must be shut off to perform this upgrade. This will cause loss of service to the whole telephone system. Plan the upgrade for a time when the impact to the telephone users will be minimal.

Installing an NT9D19, NT5D10 or NT5D03 CP card in an Option 51C system consists of:

- installing a new CP card in the Core module
- upgrading the system software and CP ROMs

**Performing a data dump**

Before starting the upgrade procedure, make a backup copy of the customer database using the data dump routine:

1. Log into the system.
2. Load the Equipment Data Dump Program (LD 43). At the prompt, enter LD 43 to load the program
3. When “EDD000” appears on the terminal, enter EDD to begin the data dump
4 When "DATADUMP COMPLETE" and "DATABASE BACKUP COMPLETE" appear on the terminal, enter

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loss of Data</td>
</tr>
<tr>
<td>If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding</td>
</tr>
</tbody>
</table>

**** to exit the program

Installing the new CP card and system software

At this time you will install the new CP card and system software if it is not already installed on the hard drive.

1 Connect a terminal to the CPSI port in the Core module to J25 of the I/O panel at the back of the core. Be sure it is configured as follows. The recommended baud rate is 9600, to be the same as the CPSI port.
   - 7 data bits
   - 1 stop bit
   - Space parity
   - Full duplex
   - XON protocol

2 Set the NORM/MAINT switch to MAINT, disengage the lock latches and remove the CP card from the Core module.

3 Insert the Install diskette that corresponds to the CP card you will be installing into the IODU/C.
4 Install the CD-ROM disk into the CD-ROM drive. To install the CD-ROM:
   - press the button on the CD-ROM drive to open the CD-ROM disk holder
   - place the CD-ROM disk into the holder with the disk label showing
   - press the button again to close the CD-ROM disk holder (don't push the holder in by hand)

5 Verify that the MAINT/NORM switch on the new NT9D19, NT5D10 or NT5D03 CP card is set to NORM.

6 Verify that the ENB/DIS switch on the CNI card is set to ENB.

7 Insert the new CP card in the same slot in the Core module and secure the lock latches.
   The system will automatically load the software install program.

8 When the NT Logo Screen appears on the terminal, the Software Installation Tool has loaded. Press <CR> to go to the Install Main Menu.

9 Set the system date and time. When prompted to enter the time and date, enter it in the following format. A space or dash can be used to separate the items.
   dd mm yyyy
   hh mm ss
   or
   dd-mm-yyyy
   hh-mm-ss

10 At the Main menu select <u> to go to the Install menu.

11 Insert the Keycode diskette when prompted and select <a> to continue with the keycode validation.
   Once the keycode is validated against the Security Device, the Install menu is displayed.

12 When the Install menu appears, select the following options in sequence when you are prompted to do so:
   <a> to install software, CP-BOOT ROM and IOP-ROM
Following the software installation, install the CP-BOOT and IOP-ROMs. From the menu select the following:

- `<a>` to continue with ROM upgrade
- `<a>` to continue with ROM upgrade (CP-BOOT ROM)
- `<y>` to start installation
- `<a>` to continue with ROM upgrade (IOP-ROM)

Remove the diskette from the IODU/C.

Select the following options to quit and reload the system:

- `<q>` to quit
- `<yes>` to confirm quit
- `<a>` to reboot the system

The system will automatically perform a sysload and system initialization during which several messages will appear on the system terminal. Wait until initialization has finished (INI messages are no longer displayed on the system terminal) before continuing.

**Note 1:** SYS4695 is not an error message. This message is cleared when you perform a data dump.

**Note 2:** If you are converting from a software release prior to release 24, the following message appears on the system terminal:

**DATA CONVERSION**

**RELEASE XX.xx TO RELEASE YY.yy**

Verify that the “DONE” message appears on the system terminal.

**Note:** The SYSTEM INI message may take 70 seconds or more to appear.
Completing the upgrade

To complete the CP card upgrade, verify CPU and CNI status.

1. Verify CPU and CNI functionality:
   - **LD 135**: to load the overlay
   - **STAT CPU**: to check the CPU status
   - **STAT CNI**: to verify CNI functionality
   - ****: to exit the program

   Backup the customer database to 2MB diskettes:

2. Load the Equipment Data Dump Program (LD 43). At the prompt, enter
   - **LD 43**: to load the program

3. When “EDD000” appears on the terminal, enter
   - **EDD**: to begin the data dump

4. When “DATADUMP COMPLETE” and “DATABASE BACKUP COMPLETE” appear on the terminal, enter

   ![CAUTION]
   **Loss of Data**
   If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.

   ****: to exit the program

5. Evaluate the number of call registers and telephone buffers that are configured for the system. Refer to *Capacity Engineering* (553-3001-149).

The CP card upgrade is complete.
CD-ROM Software Installation Tool

Contents

The following are the topics in this section:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Summary Charts</td>
<td>280</td>
</tr>
<tr>
<td>Messages</td>
<td>282</td>
</tr>
<tr>
<td>Introductory Screen</td>
<td>283</td>
</tr>
<tr>
<td>Install Menu</td>
<td>284</td>
</tr>
<tr>
<td>Installing Software, CP-BOOTROM, and IOP-ROM</td>
<td>286</td>
</tr>
<tr>
<td>Installing Software, Database, CP-BOOTROM, and IOP-ROM</td>
<td>286</td>
</tr>
<tr>
<td>Installing Software only</td>
<td>286</td>
</tr>
<tr>
<td>Installing Database only</td>
<td>287</td>
</tr>
<tr>
<td>Install CP-BOOTROM</td>
<td>288</td>
</tr>
<tr>
<td>Install CP-ROM (NT6D66 CP cards only)</td>
<td>288</td>
</tr>
<tr>
<td>Install IOP-ROM</td>
<td>289</td>
</tr>
<tr>
<td>Reinstalling CP-Software</td>
<td>289</td>
</tr>
<tr>
<td>To copy system software from the other Core</td>
<td>290</td>
</tr>
<tr>
<td>To go to the Tools Menu</td>
<td>290</td>
</tr>
<tr>
<td>To Install Keycode only</td>
<td>290</td>
</tr>
<tr>
<td>To quit</td>
<td>290</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>292</td>
</tr>
<tr>
<td>Setting the system date and time</td>
<td>294</td>
</tr>
<tr>
<td>Partitioning the hard disk</td>
<td>295</td>
</tr>
<tr>
<td>Displaying the hard disk partition size</td>
<td>295</td>
</tr>
<tr>
<td>Regenerate the PDT password</td>
<td>295</td>
</tr>
<tr>
<td>To install CP-software at a specified slot</td>
<td>295</td>
</tr>
<tr>
<td>To print the CD-ROM content</td>
<td>295</td>
</tr>
<tr>
<td>To print the Keycode content</td>
<td>297</td>
</tr>
</tbody>
</table>
Reference list

The following are the references in this section:

- Administration (553-3001-311)
- Hardware Replacement (553-3001-520)

This chapter details the screen displays and options of the CD-ROM Software Installation Tool (hereafter referred to as “Software Installation Tool”) that is compatible on Option 51C, 61C, 81, and 81C systems equipped with the NT5D61 Input/Output Disk Unit with CD-ROM (IODU/C).

This tool is based on the existing Software Installation Tool, but has notable differences in menus as well as new functionality to support installation of software from CD-ROM, copying of system software from Core to Core, copying of database from Core to Core, and Keycode installation.

The IODU/C card no longer uses a Security Cartridge, but instead uses both a Security Device and an electronic keycode file. This keycode file is stored on a 2MB diskette and must be inserted into the IODU/C floppy drive and authenticated each time the Software Installation Tool is loaded and the Install Menu is accessed.

On systems equipped with an IODU/C, the database is stored on 2MB diskettes, not 4MB diskettes. A Database Transfer Utility diskette, specific to Call Processor type, is available to convert a 4MB database to a 2MB database. Refer to NT5D61 IODU/C Reference Guide or Hardware Replacement (553-3001-520) for procedures on replacing CMDU or IOP/CMDU cards with IODU/C.
The Tools Menu has new options for finding the CD-ROM status (option <g>), printing the Keycode (option <h>), printing information about the Security Device (option <i>), checking the customer-specific CD-ROM data (<j>), manually creating a Keycode diskette (<k>), and archiving the database (<s>).

Do not turn off the system during the installation process. If you need to quit the installation process, do so from within the Software Installation Tool before powering off the system.

Read the entire procedure before attempting to perform an installation.

Before the Software Installation Tool is activated, verify that the system is in split mode (not applicable for Option 51C) and that a terminal is connected to CPSI port J25 on the I/O panel (in the inactive Core for dual CPU systems). Option 51C systems will be taken out of service.

To activate the Software Installation Tool, insert the Install diskette specific to your Call Processor type and the CD-ROM containing system software (if you will be installing that component). Press the MAN RST button on the CP card in the same Core.

The IODU/C Software Installation Tool requires the following items:

- 2MB diskettes (used to store, backup, and restore the database)
- an Install diskette specific to the system’s Call Processor card
- a Keycode diskette
- a CD-ROM containing system software
Note: If you will be installing system software from CD-ROM (options <a>, <b>, or <c> from the Install Menu), then insert the CD into the CD-ROM drive before loading the Software Installation Tool.

![CAUTION](Image)

**Loss of Data**

The screens shown in this procedure are examples. They are not intended to exactly represent the displays that will appear for your system, nor do the choices entered represent those you should necessarily choose. Be sure to watch the terminal display, and follow the on-screen instructions.

Pay close attention to the menus when they appear; they display the options available at any given stage.

**Status Summary Charts**

Status Summary Charts are displayed for the purpose of informing the user about what items will be installed or have been installed. This example is shown when option <b> (all components) is chosen from the Install Menu.

Note: Your screen may differ from the below example.
### INSTALLATION STATUS SUMMARY

<table>
<thead>
<tr>
<th>Option</th>
<th>Choice</th>
<th>Status</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW: CD to disk</td>
<td>yes</td>
<td></td>
<td>from xxxx to xxxx</td>
</tr>
<tr>
<td>SW: disk to ROM</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Database</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CP-BOOTROM</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IOP-ROM</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Please enter:

<CR> ->

<y> - Yes, start Installation.
<n> - No, stop Installation. Return to the Main Menu.

Enter Choice> y
The possible values and meanings for each column are defined below.

— Choice
  • yes indicates the item will be installed
  • no indicates the item was not selected, and will not be updated.

— Status
  • quit indicates the quit option was used, and the process was exited.
  • ok indicates the choice was installed successfully.
  • error indicates the installation was not successful. A system message is given when the Software Installation Tool encounters a problem. Follow the actions required by the message.
  • ignore applies to the CP ROM and IOP-ROM upgrade only. This appears when the process was exited when asked to replace a release and issue with the same release and issue.
  • blank indicates the status is not yet determined if Choice = Yes. If Choice = No, the field remains blank.

— Comment
  • from rel <number> to rel <number> gives the Source and Target release and issue numbers.

Messages

When the Software Installation Tool encounters a problem, a system message appears on the terminal display. These messages fall into two categories: warning and non-warning.

Warning messages are not critical errors. The Software Installation Tool proceeds with the installation following the appearance of this message. Refer to Administration (553-3001-311) for details regarding these messages.

Non-warning messages appear when a critical problem is encountered. The Software Installation Tool stops the process, and an action is recommended. When the action is complete, the Software Installation Tool can be restarted. In some cases, the tool allows you to restart by pressing the carriage return <CR>. 

553-2001-320 Standard 23.00 January 2002
Installation messages (INST) are defined fully in Administration (553-3001-311). Refer to that document for more details.

**Introductory Screen**

The first screen that appears after loading the NT5D61 Software Installation Tool is the NT Logo Screen.

This screen is displayed after the user presses <CR> from the NT Logo Screen. From this screen, the user may select option <u> to go to the Install Menu, or <t> to go to the Tools Menu. Alternately, option <q> to quit is available at this screen.

```
Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)

M A I N   M E N U

The Software Installation Tool will install or upgrade Meridian-1 System Software, Database and the PE-ROM (both CP and IOP ROM). You will be prompted throughout the installation and given the opportunity to quit at any time.

Please enter:

<CR>-->

<u> - To Install menu.
<t> - To Tools menu.
<q> - Quit.

Enter choice > u
```

553-7780
Install Menu

*Note:* A Keycode diskette is required before accessing the Install Menu.

Before the Install Menu screen is displayed, an intermediary screen shown below prompts the user to insert their Keycode diskette for validation against the Security Device.

```
Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)

test test test test test test test test test test test test test test test test test

Please insert the diskette with the keycode file into the floppy drive.

Please enter:
<CR>-> <a> - Continue with the keycode validation
(the keycode diskette is in the floppy drive).
<q> - Quit.

Enter Choice > a
```
Following successful Keycode validation, the Install Menu screen is displayed, as shown below.

**Note:** If the Software Installation Tool is loaded on a Core equipped with an NT5D61BA IODU/C (which lacks a CD-ROM drive), options <a>, <b>, and <c> will not appear.

<table>
<thead>
<tr>
<th>Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSTALL MENU</td>
</tr>
<tr>
<td>The Software Installation Tool will install or upgrade Meridian-1</td>
</tr>
<tr>
<td>System Software, Database and the PE-ROM (both CP and IOP ROM).</td>
</tr>
<tr>
<td>You will be prompted throughout the installation and given the</td>
</tr>
<tr>
<td>opportunity to quit at any time.</td>
</tr>
<tr>
<td>Please enter:</td>
</tr>
<tr>
<td>&lt;CR&gt;</td>
</tr>
<tr>
<td>&lt;a&gt; - To install Software, CP-BOOTROM, IOP-ROM.</td>
</tr>
<tr>
<td>&lt;b&gt; - To install Software, Database, CP-BOOTROM, IOP-ROM.</td>
</tr>
<tr>
<td>&lt;c&gt; - To install Software only.</td>
</tr>
<tr>
<td>&lt;d&gt; - To install Database only.</td>
</tr>
<tr>
<td>&lt;e&gt; - To install CP-BOOTROM only.</td>
</tr>
<tr>
<td>&lt;f&gt; - To install IOP-ROM only.</td>
</tr>
<tr>
<td>&lt;g&gt; - To reinstall CP-Software.</td>
</tr>
<tr>
<td>&lt;o&gt; - To copy System Software from the other Core.</td>
</tr>
<tr>
<td>&lt;t&gt; - To go to the Tools menu.</td>
</tr>
<tr>
<td>&lt;k&gt; - To install Keycode only.</td>
</tr>
<tr>
<td>For Feature Expansion, use OVL143.</td>
</tr>
<tr>
<td>&lt;q&gt; - Quit.</td>
</tr>
</tbody>
</table>

Enter Choice >

Each option from the Install Menu is described in the following pages.
Installing Software, CP-BOOTROM, and IOP-ROM

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is selected for the sequential installation of software, CP-BOOTROM, and IOP-ROM. This option differs from option <b> in that the database is not installed. Use option <a> when going to a later software release or for a software upissue.

Installing Software, Database, CP-BOOTROM, and IOP-ROM

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is selected when you wish to sequentially install all components - software, database, CP-BOOTROM, and IOP-ROM.

Option <b> is used during the upgrade procedures from NT5D20 IOP/CMDU, NT6D63 IOP and NT6D64 CMDU, NT9D33 SMDU, NTND16 FDU, NT8D69 MDU, and NTND16 MDU cards to NT5D61 IODU/C cards.

Installing Software only

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is selected when you wish to install system software from the CD-ROM to the hard drive. When selecting option <c>, IOP-ROM and CP-BOOTROM are not installed.
Installing Database only

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

The Database Menu of the Software Installation Tool is accessed by the <d> option on the Install Menu. The following options are available for installing a database:

Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)

You will now perform the database installation.

Note: If you are installing the Database from a floppy disk, please insert the correct disk now.

Please enter:
<CR>-->

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>Install CUSTOMER Database&lt;br&gt;(the customer database diskette must be in the Core 1 disk drive).</td>
</tr>
<tr>
<td>b</td>
<td>Install DEFAULT Database&lt;br&gt;(the installation CDROM must be in the Core 1 disk drive).</td>
</tr>
<tr>
<td>d</td>
<td>Copy Database from the redundant disk.</td>
</tr>
<tr>
<td>e</td>
<td>Check the Database that exists on the hard disk.</td>
</tr>
<tr>
<td>q</td>
<td>Quit.</td>
</tr>
</tbody>
</table>

Enter Choice > a

- Option <a> is to install the backup customer database from one or more 2MB diskettes.
- Option <b> allows installation from the CD-ROM containing the default database. This option is used on new systems which have no existing database.
- Option <d> copies the existing database from the redundant Core. This option is used when the database has already been installed on one Core. This option is used when upgrading from IOP/CMDU to IODU/C cards.
Option <e> displays the version and issue of the current database residing on the Core. If database files are missing, error messages will be printed.

CAUTION
Loss of Data
Before upgrading the system database, be sure a backup of the previous (source) database is on hand. Should any problems arise, it may be necessary to return to the previous database.

Install CP-BOOTROM

Note: Installation of CP-BOOTROM is available on systems with NT9D19, NT5D10 or NT5D03 Call Processor cards only. For systems with the NT6D66 Call Processor card, CP-ROM is installed instead of CP-BOOTROM. See page 288 for installing CP-ROM on a system equipped with an NT6D66.

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option <e> is for installing new CP-BOOTROM. This option is used to install CP-BOOTROM while on Core 0 in a software upgrade, when software has already been installed using options <a> or <b> on Core 1, and software has already been copied onto Core 0 using option <o>.

The next screen displayed after selecting option <e> will show the version of CP-BOOTROM being replaced and version being installed, and the card slot where the CP-BOOTROM is being installed. The user is prompted to select <a> to continue with the CP-BOOTROM upgrade.

Install CP-ROM (NT6D66 CP cards only)

Note: Installation of CP-ROM is available on systems with NT6D66 Call Processor cards only. For systems with the NT9D19, NT5D10 or NT5D03 Call Processor cards, CP-BOOTROM is installed instead of CP-ROM. See page 288 for installing CP-ROM on a system equipped with an NT6D66.
Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option <e> is for installing new CP-ROM. This option is used to install CP-ROM while on Core 0 in a software upgrade, when software has already been installed using options <a> or <b> on Core 1, and software has already been copied onto Core 0 using option <o>.

The next screen displayed after selecting option <e> will prompt the user to choose whether to install the CP-ROM from the hard disk (option <a>), or from CD-ROM (option <b>). If software has just been installed successfully, then option <a> should be used. However, if software was not installed, select option <b> to install from CD-ROM.

Install IOP-ROM

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option <f> is for installing new IOP-ROM. This option is used to install IOP-ROM while on Core 0 in a software upgrade, when software has already been installed using options <a> or <b> on Core 1, and software has already been copied onto Core 0 using option <o>, and CP-BOOTROM has been installed using option <e>.

The next screen displayed after selecting option <f> will show the version of IOP-ROM being replaced and version being installed, and the card slot where the IOP-ROM is being installed. The user is prompted to select <a> to continue with the IOP-ROM upgrade.

Reinstalling CP-Software

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is used if a flash programming error occurs during software installation through options <a>, <b>, or <c>. Option <g>, which assumes that software files have already been installed on the hard disk, copies these files from the hard disk to the Flash EEPROM.
To copy system software from the other Core

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option <o> is used during a software upgrade when software has already been installed on Core 1, and the Software Installation Tool has been loaded on Core 0.

*Note:* This option does not perform the installation of CP-BOOTROM (option <e>) or IOP-ROM (option <f>).

To go to the Tools Menu

Option <t> displays the Tools Menu and its options, which are described beginning on page 292.

To Install Keycode only

Option <k> is used when you wish to replace an existing Keycode.

To quit

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Throughout the installation process, the option to quit is always available. Quitting with the Software Installation Tool quit commands is preferable to pressing the MAN RST button on the CP card, since quitting from the tool will erase unneeded temporary files.
When you are done using the NT5D61 Software Install Tool remove the diskette from the IODU/C and select option <q> to quit from the Main Menu. The terminal displays a confirmation to quit. Pressing <y> confirms the quit.

The final screen displayed before quitting reminds the user that the Install diskette should be removed from the IODU/C floppy drive before pressing <a> to reboot the system.

---

You selected to Quit. Please confirm.

Please enter:

<y> - Yes, Quit.
<n> - No, DO NOT Quit.

Enter choice > y  

---

You have selected to Quit the Software Installation Tool
You may reboot the system or return to the Main Menu.
Before rebooting the system, remove Install diskette from the floppy drive.

---

DO NOT REBOOT USING BUTTON!!

Please enter:

<a> - Reboot the system.
<m> - Return to the Main menu.

Enter Choice > a  

Tools Menu

To load the Software Installation Tool which contains the Tools Menu, insert the Install diskette which is compatible with your Call Processor card. Press the MAN RST button on the CP card to load the tool.

The first screen that appears after loading the NT5D61 Software Installation Tool is the NT Logo Screen.

This screen is displayed after the user presses <CR> from the NT Logo Screen. From this screen, selecting option <t> brings the user to the Tools Menu.

Note: Insertion of the Keycode diskette is not required for accessing the Tools Menu.
The Tools Menu has new options for finding the CD-ROM status (option \(<g>\)), printing the Keycode (option \(<h>\)), printing information about the Security Device (option \(<i>\)), checking the customer-specific CD-ROM data (\(<j>\)), manually creating a Keycode diskette (\(<k>\)), and archiving the database (\(<s>\)).

The Tools Menu is displayed below.

<table>
<thead>
<tr>
<th>Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TOOLS MENU</strong></td>
</tr>
<tr>
<td>This is the Tools Menu for Install. You can select the tool that</td>
</tr>
<tr>
<td>is appropriate. Please select one of the options below.</td>
</tr>
<tr>
<td>Please enter:</td>
</tr>
<tr>
<td>(&lt;a&gt;) - To set the system date and time.</td>
</tr>
<tr>
<td>(&lt;b&gt;) - To partition the hard disk.</td>
</tr>
<tr>
<td>(&lt;c&gt;) - To display the partition size of hard disk.</td>
</tr>
<tr>
<td>(&lt;d&gt;) - To regenerate PDT Password.</td>
</tr>
<tr>
<td>(&lt;g&gt;) - To print CDROM content.</td>
</tr>
<tr>
<td>(&lt;h&gt;) - To print Keycode content.</td>
</tr>
<tr>
<td>(&lt;i&gt;) - To print Security Device content.</td>
</tr>
<tr>
<td>(&lt;j&gt;) - To Check the customer specific part of CDROM.</td>
</tr>
<tr>
<td>(&lt;k&gt;) - To manually create Keycode floppy diskette.</td>
</tr>
<tr>
<td>(&lt;r&gt;) - To install Keycode only.</td>
</tr>
<tr>
<td>(&lt;s&gt;) - To archive existing database.</td>
</tr>
<tr>
<td>(&lt;z&gt;) - To check MDU connection.</td>
</tr>
<tr>
<td>(&lt;m&gt;) - To return to the Main Menu</td>
</tr>
</tbody>
</table>

Enter choice >

Each option from the Tools Menu is described in the following pages.
### Setting the system date and time

This option is used to change the system date and time for the system’s internal clock. The correct date and time will ensure that files are time-stamped accurately.

---

**Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)**

You have selected the option to set the system date and time. This will change the internal clock of your system to a new date and time.

The system date and time are also used by Install to time-stamp the new files created.

Pressing the carriage return at the prompt below will leave the system date or time unchanged.

Please enter the new date or time.

Current date is: Tuesday 04-29-1997
Enter new date (dd mm yyyy) ? 30 4 1997
Date is set to: Wednesday 04-30-1997

Current time is: 15:52:00
Enter new time (hh mm ss) ? 15 05 45
Time is set to: 15 05 45

System Date and Time now is:
Wednesday 04-30-1997, 15:05:46

---
Partitioning the hard disk

Note: Option <b> requires a password, and should only be performed by Nortel Networks support personnel.

![CAUTION Loss of Data]

Partitioning a disk erases all files from it.

Displaying the hard disk partition size

Option <c> displays the partition sizes of the hard disk. The manufacturer and model number of the hard disk are also displayed.

<table>
<thead>
<tr>
<th>IODU 0</th>
<th>Hard Disk from: MAXTOR:7120SCS, Size:124MB, Sectors:248502</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unprotected</td>
<td>Part Size:30MB, Sectors: 60000</td>
</tr>
<tr>
<td>Spare</td>
<td>Part Size:30MB, Sectors: 60000</td>
</tr>
<tr>
<td>CardId</td>
<td>Part Size:1MB, Sectors: 2000</td>
</tr>
<tr>
<td>Protected</td>
<td>Part Size:60MB, Sectors: 120000</td>
</tr>
</tbody>
</table>

Regenerate the PDT password

Note: Option <d> requires a password, and should only be performed by Nortel Networks support personnel.

To install CP-software at a specified slot

Note: Option <e> requires a password, and should only be performed by Nortel Networks support personnel.

To print the CD-ROM content

Option <g> is used to find whether a CD-ROM exists on each IODU/C, and whether its sectors are readable. After selecting <g>, three options are available:

- Fast readability test, which takes about 17 seconds for each CD-ROM and reads 1/30th of the CD-ROM sectors.
• **Extensive** readability test, which takes about 3 minutes for each CD-ROM and reads 1/4th of the CD-ROM sectors.

• **Total** readability test, which takes about 6 minutes for each CD-ROM and reads all sectors of the CD-ROMs.

*Note:* The failure of a CD-ROM drive to read a known good CD-ROM may indicate a problem with the CD-ROM drive.
To print the Keycode content

Option <h> is used when you wish to display the information contained in the current Keycode. The information displayed includes machine type, software version, ISM limits, and which feature packages are enabled.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Serial Number</td>
<td>46379</td>
</tr>
<tr>
<td>Software Version</td>
<td>1811</td>
</tr>
<tr>
<td>System Type</td>
<td>Option 61C</td>
</tr>
<tr>
<td>Call Processor</td>
<td>CP68030</td>
</tr>
<tr>
<td>Release</td>
<td>23</td>
</tr>
<tr>
<td>Issue</td>
<td>30G</td>
</tr>
<tr>
<td>NTI Order Number</td>
<td>00000000000000</td>
</tr>
<tr>
<td>NT SDID - 1</td>
<td>00000000</td>
</tr>
<tr>
<td>NT SDID - 2</td>
<td>00000000</td>
</tr>
<tr>
<td>Date and Time of Manufacture</td>
<td>06/03/1998 - 14:53:38</td>
</tr>
</tbody>
</table>

Note: ( ) indicates that information is not available

ISM Limits:
- Loop Limit : 32
- Sys TNs Limit : 32767
- ACD Agt Limit : 32767
- ACD DNs Limit : 24000
- AST Limit : 32767
- DSL Limit : 100
- LTID Limit : 100
- DCH Limit : 64
- AML Limit : 16
- MPH DSL Limit : 100
- RAN CON Limit : 32767
- RAN RTE Limit : 512
- MUS CON Limit : 1000
- Brand Index : 1

Options Packages:
- 0-2 4-5 7-25 28-29 232-55 57-65
- 67 70-77 79-81 84 86 88-93
- 95 98-105 107-109 111 113-121 125
- 127 129 132-134 136 139-140 145-151
- 153-155 157-160 162 164 170 172-175
- 178-181 186 191-192 196 202-212 214-216
- 218-219 222-225 227-229 231 233-235 240
- 242-243 245-248 250-251 253-256 258-259 262-263
- 286 290-293 296-297 301-303 305-310 313-316
- 321 323-324 327-335

553-7745
To print the Security Device content

Option <i> shows specific information about the Security Device, such as Serial Number. This enables the user to find information about the Security Device without removing the NT5D61 IODU/C card.

<table>
<thead>
<tr>
<th>Engineering Code (Side x)</th>
<th>:NT5D61AA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Serial Number</td>
<td>:06NNTM1831RRC3 IOP</td>
</tr>
<tr>
<td>NT SDID</td>
<td>:20000080</td>
</tr>
<tr>
<td>Security Device Type</td>
<td>:NT_TCH</td>
</tr>
<tr>
<td>System Serial Number</td>
<td>:46379</td>
</tr>
</tbody>
</table>

To check the customer-specific part of the CD-ROM

Option <j> is used to check the readability of the Keycode-specified system software on the CD-ROM drive. Once all files have been checked successfully, the message “Checking directory /cdx/xxxx_DMR.Nxx ended successfully” is displayed to indicate completion.

To manually create a Keycode diskette

Option <k> is used to manually type in a keycode and save it to a 2MB diskette. Upon selecting this option, you may enter the characters into 21 Keycode entry lines of 16 characters each, which will compose the Keycode file to be saved on a 2MB diskette in the floppy drive.

Characters may be entered on the Keycode entry lines in one of two ways:

- manually entering each 16-character line followed by a <CR> or
- “pasting” each individual 16-character line, then pressing <CR> (available on a PC running Windows 95®, using the Copy command (Control-C) to copy a line of characters from a keycode file, positioning the cursor on the current Keycode entry line, and using the Paste command (Control-V) to paste the line).

If a line is entered which does not have 16 characters, a message will be displayed informing the user to reenter the line correctly.
To archive the existing database

This option is one of the methods (the ABKO and BKO commands from overlay 143 are other methods) that is available to backup the customer database to 2MB diskettes. The size of the backup files and the estimated number of 2MB diskettes required to store the database will be displayed.

To go back to the Main Menu

Option <m> is selected to return the user from the Tools Menu to the Main Menu, where the user may select to quit (<q>) or go to the Install Menu (<u>).
Index

A
AST sets
  Incremental Software Management, 18
Automatic Inline Conversion
  X11 releases supporting, 12
Auxiliary Processors, post-conversion power up of, 15

C
call processing, effect of software upgrades on, 10
CCED system messages
  CP Card replacement, 167
CDR Expansion, 15
CD-ROM, upgrading disk drives to, 15
conversion media
  defined, 10
converting software
  Automatic Inline Conversion, 12
  ISDN systems, 16
  post-conversion procedure, 251
  pre-conversion procedure, 25
  systems supported in documentation, 14
country code, 176
CP (Call Processor) Cards
  installing, 165
CP card upgrade, 260, 271
CPU (central processor unit), 14
creating keycode diskettes, 199
creating shortcuts, 174

data cartridges
  installing new, 107

data dumps
  between software versions, upissues, release, 15
  pre-conversion procedure, 27
data, preventing corruption of, 15, 26
databases
  verifying required updates, 251
D-channel monitors, 18
D-channel parameters, 17
DCHI ports configured as TTY ports, 18
Dial-Up Networking®, 175
Dial-Up Server, 177
Distributor Keycode Application, 169, 189
DKA, 169, 189
  Dial-Up Networking®, 175
  hardware and software requirements, 170
  installation, 170
  Manual entry, 186
  modem requirements, 170
  Reading from a File, 185
DN Expansion, 15
downloading keycodes, 178

E
error messages, 86

F
file names, 181

H
hardware requirements
  converting software, 25
HWI0533 messages in CP Card replacement, 167
INI messages, truncated, 18
initialization, system, 14
installation of DKA, 170
installing
data cartridges, 107
ISDN (Integrated Services Digital Network)
systems
converting, 16
ISM (Incremental Software Management), 18

Keycode Delivery System (KDS), 178
keycode download, 178
keycodes, 14
creating keycode diskettes, 199
downloading, 178
file name, 181
manual entry, 186
troubleshooting, 184

LD 135 program
CP Card replacement, 164
LD 17 program, 26
LD 43 program, 13
LD 66 conversion program, 13

machine types
X11 releases supported by, 22
manually entering a keycode, 186
memory
increasing
X11 release 18 and later, 153
X11 release 21, 153
X11 release 24 and earlier, 153
pre-conversion procedure, 26
required for conversions, 14
modem configuration, 175
modem requirements (DKA), 170

network protocols, 177
NT order number, 181
NT systems
parallel reboots
procedure, 32
X11 releases supported, 22
NT5D03 CP cards, 19
NT5D10 CP cards, 19, 20
NT5D61 IODU/C card, 13
CD-ROM, 13, 15
Database Transfer Utility, 14
Install diskette, 13
Keycode diskette, 13
security device, 13
NT6D11 International ISDN D-Channel cards, 16
NT8D04 Superloop Network cards, 14
NT9D10/03 Call Processor Cards
installing, 165
NT9D19, 260
NT9D19 CP cards, 19, 20
NTI number, 181

option 21E systems
X11 releases supported, 22
option 51 systems
X11 releases supported, 22
option 51C systems
X11 releases supported, 22
option 61 systems
parallel reboots
procedure, 32
X11 releases supported, 22
option 61C systems
ISDN site upgrades, 16
parallel reboots
backing out of, 46
option 71 systems
X11 releases
supported, 24
option 81 systems
  ISDN site upgrades, 16
  parallel reloads
    backing out of, 46
  X11 releases
    supported, 23
option 81C systems
  parallel reloads
    backing out of, 46
  X11 releases
    supported, 24
P
  parallel reloads
    backing out of
      options 61C/81/81C, 46
    IODU/C systems, 32
    monitoring CPU during, 14
    pre-conversion procedure and, 27
    procedure
      NT/RT/61 systems, 32
  patches
    pre-conversion procedure and, 26
    removal prior to conversion, 18
  post-conversion procedure
    overview, 251
    steps, 252
  pre-conversion procedure
    overview, 25
    steps, 26
  printouts
    site data, 29, 255
  PSDL (Peripheral Software Download), system
    initialization and, 14
Q
  QPC742D FDI Cards, 15
  QPC757 DCHI cards (vintage C), 16
R
  read from a file, 185
  release 23 memory requirements, 21, 152
RT systems
  parallel reloads
    procedure, 32
    X11 releases supported, 22
S
  SDI (Serial Data Interface) cards
    monitoring CPUs during parallel reloads, 14
  security device, 13
  server type, 177
  server types, 177
  single CPU systems
    call processing disruptions on, 10
    site data printouts
      post-conversion procedure, 255
      pre-conversion procedure, 29
  Software Installation Tool
    description of menus, 81
  source software
    defined, 10
  STE systems
    X11 releases supported, 22
    system ID, 181
T
  target software, 10
  TCP/IP, 177
  template audits, 26
  troubleshooting, 184
  TTY ports, DCHI ports configured as, 18
U
  Upgrading to a new Call Processor card, 259
V
  verifying software conversion process, 251
X
  X11 release
    supporting Automatic Inline Conversion, 12
    X11 release 15.55 (Incremental Software Management), 18
X11 release 18 (and later)
  increasing memory, 153
  ISDN site upgrades, 16
X11 release 19
  ISM tracking, 18
X11 release 21
  increasing memory, 153
X11 release 23, 19
X11 release 24 (and earlier), increasing memory in,
  153
X11 releases
  supported by machine types, 22
XT systems
  X11 releases
  supported, 22
Meridian 1

Software Conversion

Procedures

Copyright ©1989–2002 Nortel Networks
All Rights Reserved

Information is subject to change without notice. Nortel Networks reserves the right to make changes in design or components as progress in engineering and manufacturing may warrant. This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to Part 15 of the FCC rules, and the radio interference regulations of Industry Canada. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses and can radiate radio frequency energy, and if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at their own expense.

SL-1 and Meridian 1 are trademarks of Nortel Networks. Intel and Pentium are trademarks of Intel Corporation. cPCI is a trademark of PCI Industrial Computer Manufacturers Group.

Publication number: 553-2001-320
Document release: Standard 23.00
Date: January 2002
Printed in Canada

Nortel Networks™